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Overview of this guide 
The Installation and Configuration Guide describes how to install the software and configure the 
environment for the InForm application and Cognos software. 

After installing the software and configuring the environment, use the Setting Up a Trial with InForm 
Architect and MedML Guide for information about how to set up a trial and the Reporting and Analysis 
module. 
 

Audience 
This guide is for database and system administrators who are responsible for installing and 
configuring the InForm software and the Cognos 10 Business Intelligence software. 
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Documentation 
The product documentation is available from the following locations: 

• Oracle Software Delivery Cloud (https://edelivery.oracle.com)—The complete 
documentation set. 

• My Oracle Support (https://support.oracle.com)—Release Notes and Known Issues. 

• Oracle Technology Network (http://www.oracle.com/technetwork/documentation)—The 
most current documentation set, excluding the Release Notes and Known Issues. 

All documents may not be updated for every InForm release. Therefore, the version numbers for the 
documents in a release may differ. 

 

Document Description 
Release Notes The Release Notes document describes enhancements introduced and 

problems fixed in the current release, upgrade instructions, and other 
late-breaking information. 

Known Issues The Known Issues document provides detailed information about the 
known issues in this release, along with workarounds, if available. 

Secure Configuration Guide The Secure Configuration Guide provides an overview of the security 
features provided with the Oracle® Health Sciences InForm application, 
including details about the general principles of application security, and 
how to install, configure, and use the InForm application securely. 

Installation Guide The Installation Guide describes how to install the software and configure 
the environment for the InForm application and Cognos software. 

Setting Up a Trial with 
InForm Architect and 
MedML Guide 

The Setting Up a Trial with InForm Architect and MedML Guide describes 
how to design and implement trials in the InForm application using the 
InForm Architect application. 

InForm Architect 
online Help 

The InForm Architect online Help describes how to design and 
implement trials in the InForm application using the InForm Architect 
application. 

This information is available from the InForm Architect user interface. 

Step by Step for CRCs and 
CRAs Guide 

The Step by Step for CRCs and CRAs Guide describes how to use the 
InForm application to: 

• Screen and enroll patients. 

• Enter, update, and monitor clinical data. 

• Enter and respond to queries. 

• Run trial management reports and clinical data listings. 

Online Help The online Help describes how to use and administer the InForm 
application. 

This information is available from the InForm user interface. 
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Document Description 
Reporting and Analysis 
Guide 

The Reporting and Analysis Guide provides an overview of the Reporting 
and Analysis module. It includes a brief overview of the Reporting and 
Analysis interface, illustrates how to access the Ad Hoc Reporting 
feature, and describes the trial management and clinical data packages 
available for Reporting and Analysis. It also provides detailed 
descriptions of each standard report that is included with your 
installation. 

Reporting Database Schema 
Guide 

The Reporting Database Schema Guide describes the Reporting and Analysis 
database schema. 

Portal Administration Guide The Portal Administration Guide provides step-by-step instructions for 
configuring and managing the InForm Portal application. 

Utilities Guide The Utilities Guide provides information about and step-by-step 
instructions for using the following utilities: 

• PFConsole utility 

• MedML Installer utility 

• InForm Data Import utility 

• InForm Data Export 

• InForm Performance Monitor utility 

• InForm Report Folder Maintenance utility 

MedML Installer 
utility online Help 

The MedML Installer utility online Help provides information about, 
and step-by-step instructions for using, the MedML Installer utility, 
which is used to load XML that defines trial components into the 
InForm database. 

This guide also provides reference information for the MedML elements 
and scripting objects that are used to import and export data to and 
from the InForm application, as well as sample data import XML. 

This information is available from the utility user interface. 

InForm Data Import 
utility online Help 

The InForm Data Import utility online Help provides information 
about, and step-by-step instructions for using the InForm Data Import 
utility, which is used to import data into the InForm application. 

This information is available from the utility user interface. 
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Document Description 
InForm Data Export 
online Help 

The InForm Data Export online Help provides information about, and 
step-by-step instructions for using the InForm Data Export, which is 
used to export data from the InForm application to the following 
output formats: 

• AutoCode. 

• Customer-defined database (CDD). 

• Name value pairs. 

• Oracle Clinical. 

This information is available from the utility user interface. 

Third Party Licenses and 
Notices 

The Third Party Licenses and Notices document includes third party 
technology that may be included in or distributed with this product. 

 
 

Documentation accessibility 
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program 
website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc. 
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If you need assistance 

Access to Oracle Support 
Oracle customers that have purchased support have access to electronic support through My Oracle 
Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired. 
 

Finding InForm information and patches on My Oracle Support 
The latest information about the InForm application is on the Oracle Support self-service website, 
My Oracle Support. Before you install and use the InForm application, check My Oracle Support for 
the latest information, including Release Notes and Known Issues, alerts, white papers, bulletins, and 
patches. 
 

Creating a My Oracle Support account 
You must register at My Oracle Support to obtain a user name and password before you can enter 
the site. 

1 Open a browser to https://support.oracle.com. 

2 Click the Register link. 

3 Follow the instructions on the registration page. 
 

Finding information and articles 
1 Sign in to My Oracle Support at https://support.oracle.com. 

2 If you know the ID number of the article you need, enter the number in the text box at the top 
right of any page, and then click the magnifying glass icon or press Enter. 

3 To search the knowledge base, click the Knowledge tab, and then use the options on the page to 
search by: 

• Product name or family. 

• Keywords or exact terms. 
 

Finding patches 
You can search for patches by patch ID or number, product, or family. 

1 Sign in to My Oracle Support at https://support.oracle.com. 

2 Click the Patches & Updates tab.  

3 Enter your search criteria and click Search. 

4 Click the patch ID number. 

The system displays details about the patch. You can view the Read Me file before downloading 
the patch. 

5 Click Download, and then follow the instructions on the screen to download, save, and install the 
patch files. 
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Finding Oracle documentation 
The Oracle website contains links to Oracle user and reference documentation. You can view or 
download a single document or an entire product library. 
 

Finding Oracle Health Sciences documentation 
For Oracle Health Sciences applications, go to the Oracle Health Sciences Documentation page at 
http://www.oracle.com/technetwork/documentation/hsgbu-clinical-407519.html.  

Note: Always check the Oracle Health Sciences Documentation page to ensure you have the most 
up-to-date documentation. 

 

Finding other Oracle documentation 
1 Do one of the following: 

• Go to http://www.oracle.com/technology/documentation/index.html. 

• Go to http://www.oracle.com, point to the Support tab, and then click Product 
Documentation. 

2 Scroll to the product you need, and click the link. 
 

Finding prerequisite software for Oracle Health Sciences applications 
Prerequisite software for Oracle Health Sciences applications is available from the following 
locations: 

• Download the latest major or minor release from the Oracle Software Delivery Cloud 
(https://edelivery.oracle.com/). 

For information on the credentials that are required for authorized downloads, click FAQs on the 
main page of the Oracle Software Delivery Cloud portal. 

• Download subsequent patch sets and patches from My Oracle Support 
(https://support.oracle.com).  

To find patch sets or patches, select the Patches & Updates tab. 

If a previous version of prerequisite software is no longer available on the Oracle Software Delivery 
Cloud, log a software media request Service Request (SR). Previous versions of prerequisite software 
are archived and can usually be downloaded. After you open an SR, you can check its status: 

• US customers: Call 1-800-223-1711. 

• Outside the US: Check www.oracle.com/us/support/contact/index.html for your local Oracle 
Support phone number. 

For more information on logging a media request SR, go to My Oracle Support for Document 
1071023.1: Requesting Physical Shipment or Download URL for Software Media 
(https://support.oracle.com/epmos/faces/DocumentDisplay?id=1071023.1). 
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InForm software components 

Overview of the InForm system architecture 
The InForm software is a four-tiered software design. 

 

 

Tier Software component 
hosted on the tier 

Description 

Client Web browser Displays the pages of a trial and receives user input. 

Web 

 

Web server and gateway 
software (MS-IIS) 

Services requests to and from the web browser. 

Cognos 10 BI Gateway 
services 

Provides secure access to the Cognos 10 Business 
Intelligence (Cognos 10 BI) Server. 

Application 

 

InForm Service Handles trial-related requests for operating system 
services. There is one InForm Service per physical server 
machine. 

InForm trial application 
server 

Logical server that acts as a transaction manager for 
InForm studies under the InForm Service. The InForm 
Server handles caching and Microsoft Transaction Server 
(MTS) packages. Each trial is associated with an InForm 
trial application server. 
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Tier Software component 
hosted on the tier 

Description 

Cognos 10 BI Report 
server 

Handles reporting-related requests for operating system 
services. There is one Cognos 10 BI Service per physical 
server machine. 

Cognos 10 BI Content 
Manager 

Logical server that acts as a transaction manager for the 
Reporting and Analysis module under the Cognos 10 BI 
Service. There is one Cognos 10 BI Server per physical 
server machine. 

Oracle Directory Server Provides secure access to the Cognos system 
administration user. 

Data 

 

Oracle database 
instances for: 

 

InForm trial 
database 

Stores the trial components and the clinical data. Studies 
typically share an instance of Oracle with the InForm 
Admin database. 

InForm Admin 
database 

Used by the InForm Service to manage all the studies on 
a physical machine. There is one InForm Admin 
database per InForm Service. 

InForm Reporting 
database 

Stores views for Cognos Reporting through the 
Reporting and Analysis module. The InForm Reporting 
database can share an instance of Oracle with the 
InForm Admin and trial databases or can reside in a 
separate Oracle instance. In an installation in which 
Cognos Reporting is enabled, each InForm trial database 
has a corresponding InForm Reporting database. 

Cognos 10 BI 
Content Store 

Stores user-created reporting objects such as folders, 
saved reports, and saved views. The Content Store 
usually occurs in a separate Oracle instance. 

 
 

About the Cognos Private Gateway 
If you install the Reporting and Analysis module, you must also install a Private Gateway. The Private 
Gateway provides secure access to certain Cognos 10 Business Intelligence software administrative 
tasks that are not available through the InForm user interface.  

The Private Gateway must be located on a secure, dedicated server (the Cognos Private Gateway 
Server) that is accessible to a limited number of users with administrative privileges for the Cognos 
10 Business Intelligence software. For more information, see Running the Cognos 10 BI Gateway 
Customization for InForm wizard (on page 106). 
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Application server options 
You can distribute the software components across multiple application servers to best fit your 
environment. You can use one of the following deployment options: 

• Minimal server deployment—Install the InForm software and the Reporting and Analysis 
module on the fewest possible number of servers. 

• Multiple server deployment—Install the InForm software and the Reporting and Analysis 
module on multiple servers. 

• Distributed deployment—Install the InForm software and the Reporting and Analysis module 
on separate servers. 

 

Minimal server deployment 
A minimal-server deployment requires four servers: 

• InForm Application Server 

Note: In a development environment, the InForm software and the InForm Architect 
software would be installed on the InForm application server. 

• A server that hosts the Cognos components and the Oracle Directory Server: 

• Report application 

• Content Manager 

• Gateway 

• Oracle Directory Server 

• Private Gateway 

• A server for all the database instances. 
 

Multiple server deployment 
In a multiple server deployment, the InForm Server, the Cognos 10 Business Intelligence Server, and 
the trial and reporting databases are on at least six separate server machines that conform to InForm 
hardware and software requirements. 

For example, a multiple server deployment might include eight server machines configured as 
follows: 

• One Cognos Gateway Server machine. 

• One Cognos Private Gateway Server machine. 

• One Cognos server machine containing the: 

• Cognos Report server. 

• Cognos Content Manager server. 
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• One InForm Application server machine. 

• One Oracle Directory Server machine. 

• Three dedicated Oracle database server machines: 

• InForm trial. 

• InForm Reporting. 

• Cognos 10 BI Content Store. 

Note: The InForm application server(s) and the Cognos 10 BI application server(s) must be in the 
same domain.  

 

Distributed server deployment 
In a distributed server deployment, the InForm Application Server, the Cognos Report Server, the 
Cognos Content Manager Server, the Cognos Gateway Server, the Oracle Directory Server, and the 
trial and reporting databases are on separate server machines that conform to InForm hardware and 
software requirements.  

For example, a distributed server deployment might include at least nine server machines configured 
as follows: 

• One InForm Application server machine. 

• One Cognos Gateway Server. 

• One Cognos Private Gateway Server 

• One Cognos Report Application Server. 

• One Cognos Content Manager Server. 

• One Oracle Directory Server machine. 

• Three dedicated Oracle database server machines: 

• InForm database instance. 

• InForm reporting database instance. 

• Cognos 10 BI Content Store database instance. 
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Database configuration options 
You can use different configurations for your database instances when you install the InForm 
software. You can: 

• Install the InForm database and the InForm reporting database are installed on a single database 
instance. 

• Install the InForm database and the InForm reporting database are installed on separate database 
instances. 

• Configure the database instances to distribute tablespaces across multiple database servers. For 
more information, see Multiple trial tablespaces (on page 34). 

 

Single database instance for InForm and Cognos reporting software 
In a development environment, you can install the InForm software and the Reporting and Analysis 
module in the same database instance.  

Observe the following architecture rules when setting up a single database instance for the InForm 
software and the Reporting and Analysis module: 

• Only one reporting environment is allowed per trial schema. 

• A single database can hold multiple reporting schemas. 

• The trial and reporting schema cannot be installed in the same database as the Content Store 
database for Cognos 10 Business Intelligence. No other Oracle products, such as the CIS 
software or the Clintrial software, should already reside in or be added to the trial and reporting 
database. 

• The InForm trial and reporting database is not required to run in archive log mode. 
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Separate database instances for InForm and Cognos reporting software 
In a production environment, you should install the InForm and Cognos reporting software in 
separate database instances for performance reasons. You could use separate database instances for 
each of the following: 

• Each InForm server, which contains one InForm Admin schema and multiple InForm trial 
schemas. 

• InForm Reporting schema. 

• Cognos 10 BI Content Store schema. 

• Custom Authentication Provider schema 

Note: The Custom Authentication Provider schema can reside in a separate instance or the 
same instance as the Cognos 10 BI Content Store schema. 

Observe the following architecture rules: 

• You must install the Reporting and Analysis environment (InForm Reporting database) in a 
different database instance than the instance for the trial. 

• The InForm application server(s) and the Cognos 10 BI application server(s) must be in the 
same domain.  

• The Oracle user name for the reporting schema in the reporting database instance must be the 
same as the Oracle user name for the trial schema in the trial database instance. Because the 
users are in different database instances, the user names may have different passwords. 

• Only one reporting environment is allowed per trial schema. 

• A single reporting database can hold multiple reporting schemas. The trial schemas that are 
associated with these reporting schemas might exist in one or in multiple trial databases. 

• The trial and reporting schemas cannot be installed in the same database as the Content Store 
database for Cognos 10 Business Intelligence. No other Oracle products, such as the CIS 
software or the Clintrial software, should already reside in or be added to the trial and reporting 
database. 

• The trial schema must be created with archive log mode enabled. 

For more information, see Verifying Archivelog mode in the trial database in a multiple 
database environment (on page 141). 

 

Distributed deployment options 
You can distribute your trial and reporting databases across multiple disk partitions on the same 
server or multiple database servers. For more information, see Multiple trial tablespaces (on page 
34). 
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Externally hosted trials 
Externally hosted studies must conform to the following requirements, or authentication issues will 
result. 

• The InForm application server(s) and the Cognos 10 BI application server(s) must be in the 
same domain. 

• You must use the fully qualified domain name to access the site. 
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Determining resources for multiple trials 
You can install one or more studies on an InForm application server or on a physical server. Because 
all trials are different and have their own combinations of sites, users, patients, and forms, specifics 
for setting up trials on servers cannot be given in documentation. 

The Administrator (System Administrator and Database Administrator) should monitor the server 
usage and resources (metrics) to determine the demands that are placed on it, and use that 
information to decide how much a specific server can handle. 

When deciding the load that you will place on a server, consider the: 

• Number of InForm application servers on each physical server. 

• Number of trials on each InForm application server. 

Note: It is recommended that you install only one trial per InForm application server in a 
production environment. 

• Size of the intended InForm application server (each server needs 40 to 50 megabytes of 
memory). 

• Number of trials you intend to run on the server computer. 

• System availability requirements. 

• Geographic proximity of sites to the server. 
 

Guidelines for determining resources 
Follow these basic guidelines for determining resources: 

• Use separate server computers for production trials and trials that are used for testing and 
training. 

• Consider using one server computer for multiple smaller trials (especially Phase 1 trials) that are 
in separate InForm application servers. 

• Use a separate server computer for each large trial (especially Phase 3 trials). Although multiple 
servers may require additional resources and additional cost, they also provide increased 
dependability and stability. 

Separate server computers can reduce risk. If you have more than one trial on a server computer 
and make an error in setup or configuration, all the trials on that server are affected. 
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Sizing the server 
When sizing an InForm application server, be aware of the resources that are already being used. 
Make sure that you monitor the server(s) during the trials. 

When sizing your server, consider the average number of: 

• Sites. 

• Patients per site. 

• CRFs. 

• Data items. 

• Users. 

For each trial, consider the: 

• GCP status of the trial (GCP or non-GCP). 

• Phase that the trial is in (1, 2, 3). 

• Duration of the trial. 

• Enrollment rate. 

• Geographic proximity of server(s) to sites. 

• System availability requirements. 

• Number of sites. 

• Number of users. 

• Number of patients. 

• Number of unique forms. 

• Maximum number of items per form. 

• Average number of items per form. 

• Maximum number of rules per form. 

• Average number of rules per form. 

• Total number of forms per patient. 
 



 Installation and Configuration Guide  

InForm 4.6.5 11 

Configuring client computers 

Browser settings for Internet Explorer 
Configure the following Internet Explorer settings to access the InForm application and the 
Reporting and Analysis module. 

• Specify the preferred browser language. 

• To view reports in Microsoft Excel format: 

• Set the InForm web site domain and the Reporting and Analysis web site domain as trusted 
sites. 

• Enable automatic prompting for file downloads. 

• Enable notifications when downloads complete. 

• Configure pop-up blocking to allow pop-ups for the InForm web site domain and the Reporting 
and Analysis web site domain. 

• Prevent automatic password completion. 

• Specify that you want to save encrypted files to disk. 

• Automatically check for newer versions of stored pages. 

• Set the amount of disk space to use to 6 MB. 

• Set the HTTP settings to use HTTP 1.1. 

• Set the Security options to use TLS 1.1 and higher.. 

• Enable printing background colors and images for graphics. 

• Modifying security settings: 

• Allow META REFRESH. 

• Enable active scripting. 

• Set up tabbed browsing to launch links in a new tab. 

For more information, see the Internet Explorer online Help. 
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Browser settings for Firefox 
Configure the following Firefox settings to access the InForm application and the Reporting and 
Analysis module. 

• Specify the preferred browser language. 

• Configure pop-up blocking to allow pop-ups for the InForm web site domain and the Reporting 
and Analysis web site domain. 

• Prevent Firefox from using stored passwords. 

• Set the Security option to use TLS 1.1 and higher. 

• Modify security settings to accept cookies. 

• Set up tabbed browsing to launch links in a new tab. 

For more information, see the Firefox online Help. 
 

Browser settings for Google Chrome 
Configure the following Google Chrome settings to access the InForm application. 

Google Chrome is not supported for Ad Hoc reporting and Cognos administration. 

• Specify the preferred browser language. 

• Configure pop-up blocking to allow pop-ups for the InForm web site domain and the Reporting 
and Analysis web site domain. 

• Prevent Chrome from using stored passwords. 

• Set the Security option to use TLS 1.1 and higher. 

• Modify security settings to accept cookies. 

• Set up tabbed browsing to launch links in a new tab. 

For more information, see the Chrome online Help. 
 

Windows Explorer settings 
Configure the following Windows Explorer settings to access the InForm application and the 
Reporting and Analysis module. 

• Make sure the files with the XLS and XLSX extensions are not set to Browse in the same 
window. 

• Associate files with the XLS and XLSX extensions with the Microsoft Excel spreadsheet 
software. 
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Performance Options setting in System Properties 
If the InForm application server is also the database server for the trial database instance, you might 
receive errors that are related to cache initialization time when installing a trial if the system setting 
for Processor scheduling is not set to Adjust for best performance of Programs. 

1 On the InForm application and database server, open the System Properties dialog box, and 
select Advanced. 

2 In the Performance section, click Settings. 

The Performance Options dialog box appears. 

3 Click Advanced. 

4 In the Processor scheduling section, click Programs. 

5 Click OK in both dialog boxes. 

Note: When the InForm application server and database server are different machines, the 
system setting for Processor scheduling in the System Properties > Performance Options dialog 
box should be the default value, Background services. 

 





 

InForm 4.6.5 15 

In this chapter 
About installing the Oracle database software ................................................................................. 16 

 
 

C H A P T E R  2  
Installing the Oracle database software 



Chapter 2  Installing the Oracle database software  
 

16 InForm 4.6.5 

About installing the Oracle database software 
To install the Oracle database software, refer to your Oracle database documentation.  

To ensure a successful installation, make sure your environment is set up correctly. For hardware and 
software requirements, see the Release Notes.  
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About configuring Oracle database software 
You can install the InForm software on a production server or on development servers. Database 
configurations can vary depending on your environment. 

Note: You must select the WE8MSWIN1252 character set. 

The following sections describe the different Oracle configurations. Because every installation has 
different needs, you must monitor and make changes as necessary to improve your installation 
performance and workflow. 

To create an InForm database: 

1 Read the Setup parameters (on page 21). 

2 Create the necessary Oracle instances for the InForm software. 

Note: You can create up to three instances (trial, reporting, and Cognos). Each instance is 
self-contained, with its own setup and requirements. 

For more information, see Initialization parameters for database instances (on page 21). 

3 Create the InForm tablespaces. 

For more information, see Multiple trial tablespaces (on page 34). 

4 Create the InForm administrator database account. 

For more information, see Creating InForm software database accounts (on page 19). 

5 Follow any additional steps recommended for production environments. 

6 Configure the Oracle software. 

7 Create and configure a reporting content store database for the InForm software. 
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Creating InForm database and accounts 
A PFDBADMIN user must be created to install the InForm software and to set up trials on the 
servers. Oracle provides the InFormPrepORA.vbs script for this purpose. If you select the Prep 
Oracle checkbox in the InForm installation wizard, this script runs automatically during installation. 
This is the recommended way to create the PFDBADMIN user. 

If you do not select the Prep Oracle checkbox in the InForm installation wizard, you must run the 
script manually. 

Note: Creating the PFDBADMIN user needs to be performed only once per installation. 

To run InFormPrepORA.vbs manually to create the PFDBADMIN user: 

1 Open a Windows command prompt, and navigate to the folder where the script is located. 

The script is located in the InForm\InstallSupport folder on the product CD-ROM or at the 
Oracle Download Site. 

Note: If you are installing from a CD-ROM, copy the InFormPrepORA.vbs and 
InFormPrepORA.sql files to a folder on your hard drive. 

2 To suppress popup messages, set scripting to cscript. 

The default, wscript, shows wscript.echo as a popup, whereas cscript shows wscript.echo as a 
console message. 

3 To suppress the popup messages, type: 

cscript //H:cscript 

4 To run the InFormPrepORA.vbs script, type: 
InFormPrepORA.vbs <oracle_connection_string> <PFDBADMIN_UserID> 
 

When prompted, enter: 

• Password for the Oracle SYS user. 

• Password for the pfdbadmin user. 

The password for the Oracle SYS user 

If you do not know the Oracle SYS user password, consult your DBA for assistance. 
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About the InForm Admin DB in a multi-tier environment 
You can only have one InForm service per computer. When you install the InForm service on a new 
computer, you must create a unique InForm administrator database. There must be a one-to-one 
relationship between each InForm service and each InForm Admin database.  

During the installation of the InForm software, you are prompted to create the InForm Admin 
database. Type a unique name for the InForm AdminDB user ID and password. 

Note: Oracle recommends that you use the application server name appended to admindb for the 
InForm Admin UID for a multi-tier installation. 

If you choose not to create the admindb at the time of installation, you must create the AdminDB 
schema manually. 

For more information, Installing or re-installing the InForm Admin database after the initial 
installation of InForm (on page 79). 
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Setup parameters 
You must verify the parameters and set up the appropriate instances. 
 

Initialization parameters for database instances 
Depending on your environment, you may need one, two, or three database instances (the trial, the 
Reporting and Analysis module, and Cognos 10 BI each need one). 

When creating an InForm Oracle Instance, use the following initialization parameters in the Init.ora 
file.  

For more information, see the Oracle Database documentation. 

Note: Additional parameter settings are required if your installation includes Cognos 10 BI and 
the Reporting and Analysis module and your trial and reporting databases are in separate 
database instances. 

For more information, see Adding and modifying trial database parameters in a single database 
environment (on page 23) or Adding and modifying trial database parameters in a multiple 
database environment (on page 26). 

 

Parameter Value Notes 
db_block_size 8192 If the database will be used for 

reporting set this to 16384. 

db_files 250 Controls the number of operating 
system files the database will manage.  

In large installations this parameter 
may need to be set higher. 

Changes to this parameter requires 
cycling the database forcing 
application down time. 

deferred_segment_creation FALSE Required due to limitations of 
import/export. 

processes 500  

open_cursors 300 Monitor this parameter to make sure 
the value is appropriate to the number 
of users. A parameter setting that is 
too low might impact database 
performance. 

session_cached_cursors 300 Monitor this parameter to make sure 
the value is appropriate to the number 
of users. A parameter setting that is 
too low might impact database 
performance. 

global_names TRUE  
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Parameter Value Notes 
streams_pool_size N/A Set if streaming is in use to a separate 

reporting database. 200M is the 
minimum value required. 

memory_target Set to maximum of memory 
available to Oracle. 
Available memory on a 
dedicated server is all 
memory except the amount 
needed for the Operating 
System. 

Setting this parameter instructs Oracle 
to use automatic memory 
management. This is the 
recommended best practice.  

For mega trials, manually allocating 
memory may provide better 
performance. 

sga_target Only use this parameter for 
mega trials. 

Set to a portion of 
memory_target to ensure a 
minimum allocation for sga. 

Note: Do not allocate more 
than 80% of memory_target 
to sga_target. 

sga_target is only recommended to be 
used on mega trials as a minimum 
memory setting in combination with 
memory_target. 

In general it is recommended to use 
memory_target alone. 

workarea_size_policy auto  

_job_queue_interval N/A Set if streaming is in use for a separate 
reporting database. 

log_archive_dest Defaults to 
$ORACLE_HOME/dbs 
InForm recommends this be 
changed to 
$ORADATA/ARCHIVE 

The placement of archive logs is 
determined by available disk space on 
the server.  

It is recommended the default value 
for this parameter not be used to 
facilitate database maintenance. 
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Adding and modifying trial database parameters in a single database environment 

The Reporting and Analysis module requires some trial database parameter adjustments. 
 

Parameter Value Notes 
db_block_size 16384 If the database will be used for 

reporting set this to 16384. 

db_files 250 Controls the number of operating 
system files the database will manage.  

In large installations this parameter 
may need to be set higher. 

Changes to this parameter requires 
cycling the database forcing 
application down time. 

deferred_segment_creation FALSE Required due to limitations of 
import/export. 

processes 500  

open_cursors 300 Monitor this parameter to make sure 
the value is appropriate to the 
number of users. A parameter setting 
that is too low might impact database 
performance. 

session_cached_cursors 300 Monitor this parameter to make sure 
the value is appropriate to the 
number of users. A parameter setting 
that is too low might impact database 
performance. 

global_names TRUE  

streams_pool_size N/A Set if streaming is in use to a separate 
reporting database. 200M is the 
minimum value required. 

memory_target Set to maximum of memory 
available to Oracle. Available 
memory on a dedicated 
server is all memory except 
the amount needed for the 
Operating System. 

Setting this parameter instructs 
Oracle to use automatic memory 
management. This is the 
recommended best practice.  

For mega trials, manually allocating 
memory may provide better 
performance. 
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Parameter Value Notes 
sga_target Only use this parameter for 

mega trials. 

Set to a portion of 
memory_target to ensure a 
minimum allocation for sga.  

Note: Do not allocate more 
than 80% of memory_target 
to sga_target. 

sga_target is only recommended for 
use on mega trials as a minimum 
memory setting in combination with 
memory_target. 

In general it is recommended to use 
memory_target alone. 

workarea_size_policy auto  

_job_queue_interval N/A Set if streaming is in use for a 
separate reporting database. 

log_archive_dest Defaults to 
$ORACLE_HOME/dbs 
InForm recommends this be 
changed to 
$ORADATA/ARCHIVE 

The placement of archive logs is 
determined by available disk space on 
the server.  

It is recommended the default value 
for this parameter not be used to 
facilitate database maintenance. 

 
 

Adding tablespaces to the trial database in a single database environment 

You can create up to five optional tablespaces in the trial database in a single database environment. 
If you do not create optional tablespaces, use an existing tablespace to store trial objects that are 
needed for reporting.  

The default installation puts all reporting objects into the same tablespace. To do this, expand the 
size of the trial tablespace by four times the trial size (or create a new one at four times the trial size) 
and set the trial_default_ts variable in configsamedb.sql to this tablespace name.  

The optional tablespaces below allow for the separation of trial objects that are needed for reporting 
from the rest of the InForm trial objects.  

 

Tablespace 
name 

Initial size/ Autoextend 
size needed 

File extent size/ 
file maximum size 

 
Required 

 
Comments 

Chosen by 
customer 

Example: 
trial_table_ts 

Calculate initial size 
needed at: (2 * 
pf_comment table size) 
+ (2 * pf_controldata 
table size) + (1 * 
pf_resourcedata table 
size) + (1 * pf_rules 
table size).  

Chosen by 
customer. The size 
of these tables grow 
as the trial size 
grows. 

Optional Holds trial tables that 
are used for reporting. 
Corresponds to the 
variable trial_table_ts 
variable in the 
Configsamedb.sql file. 
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Tablespace 
name 

Initial size/ Autoextend 
size needed 

File extent size/ 
file maximum size 

 
Required 

 
Comments 

Chosen by 
customer 

Example: 
trial_index_ts 

Calculate initial size 
needed at: (2 * 
pf_comment primary 
key index size) + (2 * 
pf_controldata primary 
key index size) + (1 * 
pf_resourcedata primary 
key index size) + (1 * 
pf_rules primary key 
index size). 

Chosen by 
customer. The size 
of these tables grow 
as the trial size 
grows. 

Optional Holds trial table 
indexes that are used 
for reporting. 
Corresponds to the 
variable trial_index_ts 
variable in the 
Configsamedb.sql file. 

Chosen by 
customer 

Example: 
rep_mv_ts 

Three times the size of 
the trial. 

Chosen by 
customer. The size 
of the materialized 
views grows as the 
data in the trial 
grows. 

Optional Stores the materialized 
views. Also holds 
materialized view logs 
and indexes that are 
created on the 
materialized views. 
Corresponds to the 
variable rep_mv_ts in 
the Configsamedb.sql 
file. 

Chosen by 
customer 

Example: 
rep_index_ts 

One-half the size of the 
trial. 

Chosen by 
customer. The size 
of the indexes grow 
as the trial indexes 
grow. 

Optional Stores indexes created 
on reporting tables. 
Corresponds to the 
variable rep_index_ts 
in the 
Configsamedb.sql file. 

Chosen by 
customer 

Example: 
rep_mvlog_ts 

25M. Chosen by 
customer. 

Optional Stores materialized 
view logs that are 
created on reporting 
tables. Corresponds to 
the variable 
rep_mvlog_ts in the 
Configdiffdb.sql file. 
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Adding and modifying trial database parameters in a multiple database 
environment 

The Reporting and Analysis module requires you to add or modify some trial database parameters. 
Below is a list of adjustments that must be made to these parameters. All settings are necessary for 
both production and development servers. Oracle recommendations are taken from the Oracle Note: 
418755.1 - Streams Recommendations.  

The database character set chosen must be a single-byte character set. Double-byte and Multi-byte 
character sets are not supported. The database character set for the reporting database must be the 
same as the trial database.  

The trial database needs to be created with archive log mode enabled. If you create the database with 
scripts, specify ARCHIVELOG as a part of the CREATE DATABASE statement (see the Oracle 
Database SQL Reference for more information about the CREATE DATABASE statement). If you 
create the database with the Oracle Database Configuration Assistant, on the Archive tab, select the 
Archive Log Mode checkbox during the Initialization Parameters step. 

Note: For more information about the Oracle Database Configuration Assistance tool, see the 
Oracle Database Administrator's Guide for your platform. For more information on archive logging 
and other archive log parameters, see the information on Managing Archived Redo Logs in the 
Oracle Database Administrator's Guide. 

 

Parameter Value Comments 
compatible 11.2.0  

deferred_segment_creat
ion 

false Oracle 11g only. 

global_names true  

job_queue_processes See Comments. 1 job for each trial (the job to update 
PF_HEARTBEAT table every minute in each trial 
schema) and 1 job for propagation, plus streams’ 
minimum requirement of 2 and Oracle MTS’s 
requirement of 1) 

log_archive_dest Defaults to 
$ORACLE_HOM
E/dbs InForm 
recommends this 
be changed to 
$ORADATA/AR
CHIVE 

The placement of archive logs is determined by 
available disk space on the server.  

It is recommended the default value for this 
parameter not be used to facilitate database 
maintenance. 

open_links Four minimum. Four minimum is recommended by Oracle for 
Streams. Add one for each reporting schema. 

parallel_max_servers 10 Minimum: 3, dependent on the number of parallel 
apply and/or capture processes. 

streams_pool_size 200M Minimum value. 

undo_retention 900 (minimum 
value) 

See the Oracle Streams Recommended Configuration 
document on Metalink (reference below). 
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Parameter Value Comments 
_job_queue_interval 1 Not required, but recommended by Oracle for 

Streams. 
 

Oracle recommends that you review the parameters below, which are not mandatory for the 
reporting installation. 

 

Parameter Review recommendation 
processes See the Oracle Streams Recommended Configuration document on Metalink 

(reference below). 

sessions For more information, see the Oracle Streams Recommended Configuration 
document on Metalink (reference below). 

 

See the Oracle Streams Recommendations document - Note:418755.1. 
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Adding tablespaces to the trial database in a multiple database environment 

The only tablespace below that is required for InForm Reporting and Analysis installation is the 
STRMADMIN_TS tablespace. The other three tablespaces are not required, but are highly 
recommended. If these tablespaces are not created, existing tablespaces must be used to store these 
objects. 

The SYSAUX tablespace is used to store LOGMNR objects by default in the Oracle database. No 
tablespace needs to be created for Logminer objects. 

The SYSAUX tablespace size and growth is influenced by a number of Oracle tools. The Streams 
capture process writes checkpoint information, among other things, to this tablespace. The 
checkpoint information can grow quickly depending on the settings which affect checkpoint 
retention and frequency. These can be adjusted as necessary. 

The checkpoint retention time is an attribute of the capture process and can be changed with the 
DBMS_CAPTURE_ADM.ALTER_CAPTURE Oracle-supplied procedure. If the checkpoint retention time is 
changed, then the capture_ckpnt_ret_time variable setting in the configaddsdiffdb.sql file should also be 
changed. The default value for the “capture_ckpnt_ret_time” variable is 60 days, which is Oracle’s 
default. The checkpoint frequency is a capture process parameter and is called 
_CHECKPOINT_FREQUENCY. This can be changed with the DBMS_CAPTURE_ADM.SET_PARAMETER 
procedure. See the Oracle PLSQL Packages and Types Reference and Oracle Concepts and Administration 
manuals for more information. Also see Oracle Metalink Note: 418755.1 for Streams 
recommendations.  

The UNDO tablespace size and growth are influenced by the UNDO_RETENTION database parameter 
setting (For more information, see the Oracle 10.2 Streams Recommendations document - Note: 
418755.1.) and Streams needs in addition to normal InForm reporting operations. For information 
about the UNDO_RETENTION parameter and UNDO tablespace, see the Oracle Database Administrator's 
Guide. 

 

Parameter Value Notes 
db_block_size 16384 If the database will be used for 

reporting set this to 16384. 

db_files 250 Controls the number of operating 
system files the database will manage.  

In large installations this parameter 
may need to be set higher. 

Changes to this parameter requires 
cycling the database forcing 
application down time. 

deferred_segment_creation FALSE Required due to limitations of 
import/export. 

processes 500  

open_cursors 300 Monitor this parameter to make sure 
the value is appropriate to the number 
of users. A parameter setting that is 
too low might impact database 
performance. 
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Parameter Value Notes 
session_cached_cursors 300 Monitor this parameter to make sure 

the value is appropriate to the number 
of users. A parameter setting that is 
too low might impact database 
performance. 

global_names TRUE  

streams_pool_size 200M Set if streaming is in use to a separate 
reporting database. 200M is the 
minimum value required. 

memory_target Set to maximum of memory 
available to Oracle. 
Available memory on a 
dedicated server is all 
memory except the amount 
needed for the Operating 
System. 

Setting this parameter instructs Oracle 
to use automatic memory 
management. This is the 
recommended best practice.  

For mega trials, manually allocating 
memory may provide better 
performance. 

sga_target Only use this parameter for 
mega trials. 

Set to a portion of 
memory_target to ensure a 
minimum allocation for sga. 

Note: Do not allocate more 
than 80% of memory_target 
to sga_target. 

sga_target is only recommended to be 
used on mega trials as a minimum 
memory setting in combination with 
memory_target. 

In general it is recommended to use 
memory_target alone. 

workarea_size_policy auto  

_job_queue_interval 1 Set if streaming is in use for a separate 
reporting database. 

log_archive_dest Defaults to 
$ORACLE_HOME/dbs 
InForm recommends this be 
changed to 
$ORADATA/ARCHIVE 

The placement of archive logs is 
determined by available disk space on 
the server.  

It is recommended the default value 
for this parameter not be used to 
facilitate database maintenance. 
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Disk space allocation guidelines 
Setting up the database requires knowledge of resource and storage needs for each specific trial.  

Disk space allocation depends on many factors, such as the: 

• Number of sites. 

• Number of patients. 

• Number of forms. 

• Timeline for trial milestones, such as enrollment, and visits, etc. 

Note: Oracle strongly recommends using multiple disks for production servers. The more disks 
used, the better Oracle performance will be. Each trial should have its own set of tablespaces. 
This improves the maintenance and scalability of the trial. Database objects are strategically 
placed onto separate tablespaces to improve the performance of particular operations. 

 

Calculation for db_files and maxdatafiles 
The InForm tablespace alone is sufficient for development servers. For production servers, each 
InForm trial requires 12 tablespaces for tables and indexes, as determined by the following 
calculation: 

N * 12 + INFORM + TEMPBIG + # of Non-InForm Tablespaces (System, RBS, etc.) = 
number of tablespaces needed 
 
where 

• N—Number of trials. 

• INFORM—Required InForm tablespace. 

• TEMPBIG—Required temporary tablespace. 

Note: You must set maxdatafiles during Oracle instance creation to a large enough value to 
accept the db_files parameter. 

The catalog.sql and catproc.sql scripts must be run during instance creation, or you can use the 
Oracle Database Configuration Assistant. These scripts create all the necessary stored procedures and 
views for the InForm software. Remember to run these scripts for both the production and 
development environments. 

These scripts can be found in: 

%ORACLE_HOME%\RDBMS\ADMIN 
 

Note: Oracle recommends running the UTLRP.SQL script after creating an Oracle instance. 
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Setting up Oracle XA transaction support 
1 Select the Prep Oracle checkbox, during the installation,. 

For more information, see Running the InForm software installation (on page 45). 

Or 

Run the mtsora102.vbs script during or after the Oracle installation, using the following syntax: 
MTSORA102.vbs <OracleConnectionString> [OracleClientHomeKey] 
 

For example, MTSORA102.vbs dev1 KEY_OraClient11g_CLIENT1. 

When prompted, enter the password for the Oracle database SYS user. 

You must run the mtsora102.vbs script only if you are manually setting up XA Transaction 
Support. 

Note: In a multi-tier environment, select the Prep Oracle checkbox during the InForm 
installation on each InForm application server, and run mtsora102.vbs script on each 
InForm database server. Restart the server if the script changes any of the MSDTC\Security 
or MSDTC\XADLL registry keys. 

The MTSORA112.vbs file does the following: 

a Runs the XAVIEW.sql script as SYS to create the V$XATRANS$ view: 
%ORACLE_HOME%\RDBMS\ADMIN\XAVIEW.SQL 

 
b Grants SELECT access to the public on these views: 

Grant Select on V$XATRANS$ to public. 
Grant Select on sys.dba_pending_transactions to public. 

 
c Modifies the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\MTxOCI 

registry keys: 
"OracleXaLib"= "oraclient11.dll" 
"OracleSqlLib" = "orasql11.dll" 
"OracleOciLib" = "oci.dll" 
 

d Modifies the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\Security for 
registry keys: 
"NetworkDtcAccess"=dword:00000001 
"NetworkDtcAccessAdmin"=dword:00000001 
"NetworkDtcAccessTransactions"=dword:00000001 
"XaTransactions"=dword:00000001 
"NetworkDtcAccessOutbound"=dword:00000001 
"NetworkDtcAccessInbound"=dword:00000001 
 

e Modifies the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\XADLL 
registry key: 
"mtxoci.dll"="C:\\WINDOWS\\system32\\mtxoci.dll" 
 

2 Run the oramtsadmin.sql command from the ...\oramts\admin folder of the Oracle Client 
home (where Oracle Services for Microsoft Transaction Server was installed).  

You must run it as the SYS user with the SYSDBA role. Run the script against all Oracle 
instances connected to the InForm Application Server. 
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Creating Cognos 10 BI database and accounts 
1 Make sure that an Oracle database instance is set up. 

2 Verify the connection string in the tnsnames.ora file. 

3 Create a database to store the content for Cognos 10 Business Intelligence. 

For more information, see your Cognos documentation. 

Note: Pay special attention to the Unicode character set Cognos recommends as this 
cannot be changed after the database is created. 

After creating the database: 

1 Create a tablespace called CONTENT with 100M initial size, autoextend on and 50M increment 
extension. 

2 Create a user called CBI and grant the user the following privileges: 

• Roles 

• CONNECT 

• RESOURCE 

• Privileges 

• CREATE ANY TABLE 

• CREATE TABLE 

• CREATE ANY VIEW 

• UNLIMITED TABLESPACE 

3 Make sure that the instance can be seen by the Cognos server. (Aliases for database instances and 
their connection information are in tnsnames.ora.) 

4 Make sure that the Content Store database is Unicode. 

Note: Make sure that the ojdbc6.jar file has been copied from the ORACLE_HOME\jdbc\lib folder 
to the <Cognos_location>\webapps\p2pd\WEB-INF\lib folder: 
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Creating a database schema for the Cognos Authentication Provider (CAP) 
If you plan to install Cognos Reporting, you must create a database schema for the Cognos 
Authentication Provider (CAP). The purpose of this database schema is to store trial-to-
authentication URL information. This schema can reside in the content store database instance or a 
separate database instance. 

1 Set up an Oracle database schema. 

2 Create a table to store the URL information for CAP. 

3 Ensure that the database schema will be available from the trial server and the Cognos 10 BI 
server. 

4 Update the tnsnames.ora file located on the application server to contain an alias establishing a 
connection to the database server. 

 

Configuring the database for the Cognos Authentication Provider 
1 Create the user PFCapAdmin and grant the user these roles: 

• Roles 

• CONNECT 

• RESOURCE 

• Privileges 

• ALTER SESSION 

• CREATE DATABASE LINK 

• CREATE SEQUENCE 

• CREATE SESSION 

• CREATE SYNONYM 

• CREATE TABLE 

• CREATE VIEW 

• UNLIMITED TABLESPACE 

2 Run the create_cap_table.sql script (located in the <Installation_Directory>\InForm\bin\DBOra 
folder) to create a table called TRIAL_URLS within this user/schema. 

For more information, see Scripts (on page 186). 

Note: The CAP schema can reside in the content store database instance or a separate 
database instance. 
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3 Validate the database connection from the Cognos 10 BI server by typing: 
sqlplus <contentuser_userid>@<tnsnames_alias> 

 
When prompted, enter the password for the content user. 

If the test is successful, a SQL prompt appears, showing that you have logged on to the database 
server as the PFCapAdmin user. An unsuccessful test generates an ORA- error. Consult your 
database administrator for help in troubleshooting errors. 

 
 

Multiple trial tablespaces 
By default, all trial objects are created in the INFORM tablespace. In production, you should 
distribute each trial across multiple tablespaces for improved performance and for maintenance and 
monitoring. Before you install your trial on a production server, set up the trial-specific tablespaces. 

The following table lists the Oracle table and index tablespaces to create, along with the required 
parameters. All tablespaces should be locally managed. 

 

Table tablespace Index tablespace Size (MB) 
%TRIAL_NAME%_REF %TRIAL_NAME%_REF_IDX 120 

%TRIAL_NAME%_HIGH_TXN1 %TRIAL_NAME%_HIGH_TXN1_IDX 300 

%TRIAL_NAME%_HIGH_TXN2 %TRIAL_NAME%_HIGH_TXN2_IDX 500 

%TRIAL_NAME%_HIGH_TXN3 %TRIAL_NAME%_HIGH_TXN3_DX 600 

%TRIAL_NAME%_HIGH_TXN4 %TRIAL_NAME%_HIGH_TXN4_IDX 500 

%TRIAL_NAME%_TXN %TRIAL_NAME%_TXN_IDX 250 
 

The remaining syntax for each of these tablespaces is: 

AUTOEXTEND ON NEXT 50M 
EXTENT MANAGEMENT LOCAL AUTOALLOCATE; 
 

Note: The TRIAL_NAME portion of the tablespace name must conform to Oracle name standards. 
It cannot start with a numeric character and cannot contain special characters. Additionally, 
because the Oracle software has an internal limitation of 30 characters for a tablespace name, 
the trial name must be 16 characters or fewer. 

Oracle provides sample configurations for distributing your tablespaces using one disk to five disks. 
 



 Installation and Configuration Guide  

InForm 4.6.5 35 

Distributed InForm trial tablespaces 
In a production environment, Oracle recommends distributing tablespaces across multiple disks. 
This table presents a suggested model. In each configuration, it is recommended that you use the C: 
partition for the operating system and distribute the database and application components across the 
remaining partitions. Monitor your system to determine the optimal configuration. 

Note: For production systems, Oracle does not recommend using a single server for both the 
InForm core software and the trial database. 

• C: and D: are partitions on one disk. 

• INFORM, SYSTEM, TEMPBIG are tablespaces. 
 

Physical disks 0 1 2 3 4 

Logical disks C: D: E: F: G: H: 
1 disk Windows 

2008 or 
2003 

Oracle 
INFORM 
SYSTEM 
Trial Tables 
Trial Indexes 
TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

    

2 disks Windows 
2008 or 
2003 

Oracle 
INFORM 
SYSTEM 
Trial Tables 
Redo logs 

Trial Indexes 
TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

   

3 disks Windows 
2008 or 
2003 

Oracle 
INFORM 
SYSTEM 
Redo logs 

Trial Indexes 
TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

Trial Tables 

 

  

4 disks Windows 
2008 or 
2003 

Oracle 
INFORM 
SYSTEM 
Redo logs 

TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

Trial Tables 

 

Trial 
Indexes 

 

 

5 disks Windows 
2008 or 
2003 

Oracle 
SYSTEM 
Redo logs 

INFORM 
Redo logs 
UNDOTBS 

 

Trial Tables 

 

Trial 
Indexes 

 

TEMPBIG 
Archive logs 
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Creating the INFORM_LOB tablespace 
The INFORM_LOB tablespace is optional for InForm installation. To create the INFORM_LOB 
tablespace, use the following syntax: 

CREATE TABLESPACE INFORM_LOB 
DATAFILE ‘<path_to_reporting_data_file>’ SIZE <initial_size> 
AUTOEXTEND ON NEXT <file_increment> 
EXTENT MANAGEMENT LOCAL AUTOALLOCATE; 
 

 

Tablespace name Initial size/ 
autoextend size 
needed 

File extent size/file 
maximum size 

Comments 

INFORM_LOB 200M Make the initial size 
200 megabytes, set 
AUTOEXTEND on 
and set MAXSIZE to 
UNLIMITED. 

Use of this tablespace is optional, 
but, if used, the name 
INFORM_LOB is required for 
this tablespace. This tablespace 
can be used to hold large objects. 

 
 

InForm servers and trials 
For production servers, it is better to associate each trial with its own InForm server. This setup is 
helpful because if you ever have to stop an InForm server, you will be affecting only one trial. 

 



 

InForm 4.6.5 37 

In this chapter 
Steps to install and configure the Oracle database client ............................................................... 38 

Update the National Language Support registry settings on the Oracle database client........... 39 

Configure a database connection ....................................................................................................... 40 

Validate the database connection ....................................................................................................... 41 

 
 

C H A P T E R  4  
Installing and configuring the Oracle 
database client 



Chapter 4  Installing and configuring the Oracle database client  
 

38 InForm 4.6.5 

Steps to install and configure the Oracle database client 
1 Install the Oracle database client on the: 

• InForm Application Server 

• Cognos Content Manager Server 

• Cognos Report Server 

For more information, see your Oracle database documentation. 

2 Update the registry settings on each server where you installed the Oracle database client. 

For more information, see Update the National Language Support registry settings on the 
Oracle database client (on page 39). 

3 Configure the database connection. 

For more information, see Configure a database connection (on page 40). 

4 Validate the database connection. 

For more information, see Validate the database connection (on page 41). 
 



 Installation and Configuration Guide  

InForm 4.6.5 39 

Update the National Language Support registry settings on 
the Oracle database client 

The NLS_LANG registry setting is required for the Oracle client home on the InForm Application 
Server, the Cognos Report Server, and the Cognos Content Manager Server.  

The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\<Oracle_client_home_key> 
NLS_LANG registry setting must be set to AMERICAN_AMERICA.WE8MSWIN1252. 
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Configure a database connection 
To configure the Oracle Client on the application server to connect with the database server, update 
the tnsnames.ora file located on the application server to contain an alias establishing a connection 
to the database server. 

Note: When installing the InForm software, you enter the alias specified in the tnsnames.ora file 
as the database connect string. 

For more information, see Validating the database connection (see "Validate the database 
connection" on page 41). 
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Validate the database connection 
To validate the database connection from the application server:  

• Type the following statement at the Windows command prompt: 
sqlplus <pfdbadmin_user>@tnsnames_alias 
 
When prompted, enter the password for the pfdbadmin user. 
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About the InForm core software installation 
The InForm core software installation process installs: 

• The InForm Service. 

• The InForm trial and Admin databases. 
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Running the InForm software installation 

Installing the InForm software 
1 Download and extract the InForm software from the Oracle Download Center. 

2 Navigate to the location of the installation files on the downloaded image, and double-click 
setup.exe.  

The Preparing Setup window appears, followed by the welcome screen. 

3 Click Next. 

The Customer Information window appears. 

4 Type your User Name and Company Name in the appropriate fields and click Next. 

The Choose Destination Location window appears. 

5 Accept the default location, or click Change and browse to the new location.  

6 Click Next. 

The Select Features window appears. 

7 To see the list of products available for installation, expand the InForm node.  

The core InForm software installation includes sample trials. 

To install the InForm Architect software, select the Architect checkbox. 

The Documentation checkbox is automatically selected. 

Note: Typically, you should not install the InForm Architect software in a production 
environment. In a development environment, you can install the InForm Architect software 
on the same server as the InForm software.  

8 Click Next. 

The Select the Oracle Home for InForm window appears. 

The Oracle Home that you configured during your Oracle client installation appear in the 
window with the prefix KEY_ to indicate the Windows registry key. 

9 Select the entry for the Client Oracle Home registry key. 

10 Click Next. 

The Database Configuration window appears. 

Note: The defaults on this window were set when you configured the Oracle software. The 
values for your installation may be different. 
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11 Enter values for the following configuration fields: 
 

Field Description 
Local Machine User The name of the local machine user. The default is 

pfUSR_<machinename>. 

Local Machine User 
Password 

The password for the local machine user. 

Note: The password for the local machine user must comply with the 
password requirements defined in your domain password policy. 

Database Connection 
String 

String that the InForm server uses to connect to the Oracle instance 
for the trial. 

Oracle SYS DBA User The name of the Oracle SYS account. This value is only used if you 
select the Prep Oracle checkbox to create the pfdbadmin account. 

Oracle SYS DBA 
Password 

Password of the Oracle SYS account. This value is used only if you 
select the Prep Oracle checkbox to create the pfdbadmin account. 

Admin Database 
Username 

User name that is required to access the Admin database. 

Admin Database 
Password 

Password that is required to access the Admin database. The password 
is case-sensitive. Do not include a hyphen (-) character in the 
password. 
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Field Description 
InForm System 
Username 

User name for the trial database. If this is a new InForm installation or 
if you change the user name from the default during the installation, 
select the Prep Oracle checkbox. This instructs the InForm software 
installation to create the InForm account using the user name and 
password you specify. 

InForm System 
Password 

Password for the trial database. The password is case-sensitive. Do not 
include a hyphen (-) character in the password. 

Note: Oracle recommends that you change the InForm system 
password after installing the InForm software. For more information, 
see the Secure Configuration Guide. 

Install Admin DB If selected, creates the: 

• informadmin user, using the Admin Database Username and 
Admin Database Password. 

• InForm Admin database for non-clinical data, such as users, sites, 
and configuration information.  

Note: You must select this checkbox for both installation and 
upgrades. 

Prep Oracle If selected: 

• Runs the informprepora.vbs script, which creates the trial 
database user, using the InForm System Username and InForm 
System Password. 

• Runs the mtsora102.vbs script, which sets up Oracle XA 
Transaction Support and sets the MTS Timeout to a minimum of 
300 seconds. 

If not selected: 

• Verifies the trial database user and password. 

Note: You need to select the Prep Oracle checkbox only the first 
time you install the InForm software on an instance. 

 

12 Click Next. 

The Ready to Install the Program window appears. 

13 Click Install. 

The Setup Status window appears, and the progress of the installation is indicated on the screen. 

The Oracle InForm 4.6 Reboot window appears. You must reboot the system if any of the 
following are true: 

• ODAC was upgraded during the installation process. 

• The PATH environment variable was modified. 

• The installation tried to access a locked file. 
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14 Select Yes or No to indicate whether you want to reboot. 

15 Click Finish. 

After rebooting, the final configuration process begins.  

When the system is finished, the InstallShield Wizard Complete window appears. 

16 To exit the wizard, click Finish. 
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Installing InForm trials 
1 Create an InForm application server, or decide which existing application server to associate with 

the trial. 

2 Create the trial. 

3 Install the base trial components that are provided with the InForm software. 

4 Components specific to the trial. 
 

About installing trials 
Before you install any trial, you need to create the InForm application server. After the InForm 
service is started, you can create an application server for a trial manually or by using a script. 
 

InForm service 
The InForm service must be started to create the application servers and load trials. To start or stop 
the InForm service, you must be a local administrator for the computer on which you are installing 
the trial. 
 

InForm application servers 
Every InForm trial must be associated with an InForm application server. Each application server 
can house one or more trials. For production servers, Oracle recommends associating each trial with 
its own application server in a one-to-one relationship.  

Before creating a trial, you must do the following: 

1 Start the InForm service. 

2 Create an InForm application server. 

Note: During the installation of a trial, the InForm software creates a virtual Web directory with 
the same name as the trial name. When choosing a trial name, make sure that you do not 
already have a virtual Web directory with the same name. 

 

InForm trial installation tools 
Install InForm trials through the command prompt using the following commands: 

• pfadmin setup trial—Sets up an InForm server and a trial in a production or development 
environment. 

• dbsetup—Installs the Base trial components into the new trial that you set up with the pfadmin 
setup trial command. 

The MedML Installer tool installs trial-specific components into the new trial that you set up with the 
pfadmin setup trial command. 
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Base components 
The InForm sample trial and any trials you might create and install using the InForm Architect 
application, need the following Base component elements: 

• System resources, including images and HTML files used throughout the InForm application. 

• System configuration settings. 

• Predefined rights and default rights groups. 

• Default query group. 

• Predefined administrative users with rights to perform user administration tasks. 

• Default numeric sequences for screening, enrollment, and randomization numbers. 

• System form definitions (for example, definitions of Comment, Data Value(s), Query, Audit 
Trail, and administrative windows). 

The Base components are the foundation on which the rest of the trials are built.  

Before you install any trial, you need to create the InForm application server. After the InForm 
service is started, you can create a server for a trial manually, or by using a script. Instructions for 
both methods are included. 

Note: During the installation of a trial, the InForm software creates a virtual web directory with 
the same name as the trial. When you choose a trial name, make sure that you do not already 
have a virtual web directory with the same name. 

 

Sample trials 
The InForm software includes the components of sample trials that you can install to familiarize 
yourself with the software and the types of trial components that are available. During the InForm 
software installation you can select the sample trials to install.  

The PFST sample trial, which comes with the InForm software, includes only trial metadata. You can 
install this version by using an installation script to obtain a complete set of trial components, 
including sample users that enable you to log on and add patients and patient data. 

The PFST45 sample trial, which comes with the InForm software, includes components that 
illustrate the features of this release. PFST45 comes in the following forms: 

• Trial metadata in XML format. You can install this version by using an installation script to 
obtain a complete set of trial components, including sample users that enable you to login and 
add patients and patient data. For more information, see Installing PFST45 trial using 
metadata in XML format (no sample data) (on page 52). 

• An Oracle dump consisting of Base and PFST45-specific trial components and a collection of 
patients and sample clinical data. This version, which is also fully functional with sample users, 
enables you to learn about InForm features and to run reports without having to add patients 
and patient data. You can install this version by using a set of Oracle and InForm commands. 
For more information, see Installing PFST45 Trial using Oracle dump file (has sample 
data) (on page 53). 

The installation procedure for PFST45 trial metadata and PFST trial metadata is the same. 
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Installing PFST45 trial using metadata in XML format (no sample data) 
To install either the PFST45 or PFST46 trial metadata, use the instructions below, and insert the 
release number of the trial you want to use. 

For example, to install PFST45: 

• Select Start > Programs > Oracle Health Sciences > InForm 4.6.5 > Install Sample Trial 4.5 for Oracle. 

The sample trial setup program: 

• Starts the InForm service, if it is not already started. 

• Creates an InForm application server. 

• Creates the PFST45 trial, ODBC data source, and virtual web directory. 

• Loads Base components. 

• Loads PFST45-specific components. 

To access PFST45 user information after the installation is complete: 

1 Start the server and trial from a command prompt. Type: 
pfadmin start server <servername> 
pfadmin start trial pfst45 
 

2 Activate the system user using the following command: 
pfadmin setserver systempw pfst45 
 
When prompted, enter the new password for the system user. 

3 Log on with the user name system. 

4 Click Admin. 

The Users tab appears and displays a list of users.  

The PFST45 sample trial includes the following users: 
 

PI CRC CRA CDM 
• rrush 

• awarren 

• jsilverman 

• mcarlson 

• mdisilvio 

• mmeyer 

• pparker 

• dobrien 

• creilly 

• aortega 

• mlynch 

• awalsh 

• lhill 

• swilson 
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Installing PFST45 Trial using Oracle dump file (has sample data) 
The PFST45 sample trial includes an Oracle dump file containing Base and PFST45-specific trial 
components, and a collection of patients and sample clinical data. The procedure described in this 
section: 

• Creates an Oracle user (trial database). 

• Imports the dump file to the trial database. 

• Sets up the InForm software application server and trial. 

To import data into your PFST45 trial:  

1 Open a command window. 

2 Go to the <install_directory>\InForm\bin\DBOra folder. 

3 Run DropDB.cmd (located in the <Installation_Directory>\InForm\Bin\DBOra folder) to create 
the database user to own the trial schema, using following syntax: 

DropDB.cmd <TNS_Service_Name>  
 

where: 

• TNS_Service_Name—TNS name for the database instance. 

You are prompted for the following values: 

• trial_user—Owner of the trial schema created by the import. 

• trial_user_pass—Password for the owner of the trial schema created by the import. 

• pfdbauid—InForm database admin user. 

• pfdbapid—InForm database admin password. 

The Oracle user is dropped and recreated. 

4 To import the data into the sample trial, go to the <install_directory>\InForm\Sample_PFST45\ 
DUMP folder and type: 
imp system@oracle_connection_string file=pfst45.DMP fromuser=pfst45uid 
touser=pfst45uid buffer=999999 
 

When prompted, enter the password for the database system user. 

5 Run updatec.sql for each trial, using the following command and syntax: 
SQLPLUS <pfdbadmin_username>@<trial_instance> @updatec.sql <trialuserid> 
 

When prompted, enter the password for the InForm database administrator. 

6 To set up the application server and the trial, type the following commands: 
pfadmin setup server servername 
pfadmin setup trial trialname servername /db oracle_connection_string 
 

When prompted, enter the: 

• Trial user ID. 

• Password for the trial user. 
pfadmin setserver site trialname computername 
pfadmin setserver medmlinstaller trialname computername 
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7 To start the application server and trial, type: 
pfadmin start server servername 
pfadmin start trial trialname 
 

8 Log on to the InForm trial. 
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Installing a trial designed with InForm Architect 
When you have finished designing and developing the XML components for a trial, you can install 
the trial in a trial database. 
 

Installing and setting up a trial 
1 To install and set up the trial, at the Windows command prompt, type one of the following 

commands: 

• If a trial DSN does not exist: 
pfadmin setup trial trialname servername /DB oracle_connect_string 
 

• If a trial DSN already exists: 
pfadmin setup trial trialname servername /DSN trialDSN 
 

When prompted, enter the: 

• Trial user ID. 

• Password for the trial user ID. 

2 To check the configuration, type: 
pfadmin view service 
 

The InForm application server and the trial appear. 

3 Go to the <install_directory>\\InForm\bin\dbora folder and use one of the following 
commands: 

• If your trial development team has created an RSP file that contains references to each XML 
component definition file to install, execute the following command, referencing the RSP file 
and the folder in which it is located: 
dbsetup trialname trial_folder\trialsetup_rsp_file 
 

• If all trial components are not fully developed, you can use the following command to install 
the base components now, and then install the remaining components later. 
dbsetup trialname base 
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Starting the InForm service and trial 
1 To start the InForm service from the command prompt, type: 

net start pfservice 
 

2 To verify that the service is running, type: 
pfadmin view service 
 

3 Select Control Panel > Administrative Tools > Services. 

4 Verify that the following services are started: 

• IIS Admin service 

• InForm service 

• World Wide Web Publishing service 

5 To start the InForm Server, type: 
pfadmin start server <servername> 
 

6 To start the InForm trial, type: 
pfadmin start trial <trialname> 
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Configuring the InForm authentication web service 
If your trial includes the Reporting and Analysis module, you must configure the InForm 
authentication web service (AuthService). 

Set the port number for the AuthService web service, using the following syntax for the pfadmin 
command: 

pfadmin config webservice <trialname> AuthService ADD HTTP:<portnumber> 
 

The InForm application uses this port to communicate with the Reporting and Analysis module to 
authorize InForm and reporting users. For example, to configure trial pfst113 to use port 14041 for 
the AuthService web service, use the following command: 

pfadmin config webservice pfst113 AuthService ADD HTTP:14041 
 

You can also use this command to configure an HTTPS port or an HTTPS port and an HTTP port: 

pfadmin config webservice <trialname> AuthService ADD HTTPS:<portnumber> 
cert:<certificateThumbprint> 
 
pfadmin config webservice <trialname> AuthService ADD HTTP:<portnumber1> 
HTTPS:<portnumber2> cert:<certificateThumbprint>  
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Verifying site time zone settings 
• Run the checksitetimezones.exe (located in the <installation_directory>\inform\bin\DBora folder) 

on the InForm application server using the following syntax: 
checksitetimezones.exe <connection_string> <trialdb_user> <output_filename> 
 
When prompted, enter the password for the trial database user. 

For example: 
checksitetimezones.exe trial1 pfst45uid sitetimes.txt 
 
The script reports on site time zone status in the file that you specify and also in a CSV file called 
Allsites.csv. 

Note: If the script finds any bad time zones, it changes the output file name you specified to 
bad_<output_filename>, for example, bad_sitetimes.txt. 
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Restricting access to a trial 
1 Select Start > Programs > Administrative Tools > Internet Services Manager. 

The Internet Information Services window appears. 

2 Under the computer name listed, select the Default Website folder. 

3 In that folder, right-click the name of the InForm trial. 

4 Select Properties. 

The Properties dialog box appears. 

5 Select the Directory Security tab. 

6 Change the settings for IP addresses and Domain name restrictions as appropriate. 
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Stopping an InForm trial 
• At a command prompt, type: 

pfadmin stop trial <trialname> 
 

 



 Installation and Configuration Guide  

InForm 4.6.5 61 

Qualifying the installation 
Qualifying the installation verifies that the trial was installed successfully. Qualifying does not test 
every aspect of the trial, but it does run through key administrative functions to make sure that the 
trial behaves as expected. 
 

Qualification prerequisites 
Before you begin the qualification process, you should: 

1 Install the PFST45 sample trial.  

For more information, see Installing PFST45 trial using metadata in XML format (no 
sample data) (on page 52). 

2 Make sure that the trial is started, and that the server and trial are up and running.  

For more information, see Starting the InForm service and trial (on page 56). 

3 Use the following command to activate and set the password for the system user. 
pfadmin setserver systempw 
 
When prompted, enter the password for the system user. 

4 Change the passwords for, dobrien and lhill: 

a Login to PFST45 as system. 

b Click Admin. 

c For each user: 

1 Click the user Account Name. 

2 On the Users page, deselect the User Active checkbox. 

3 Click Submit, and in the message box, click OK. 

4 Click Change Password. 

5 On the Password Settings for User page, type InForm in the New password and 
Confirm new password fields. 

6 Click Submit, and in the message box, click OK. 

7 Click Return. 

8 On the Users page, select the User Active checkbox. 

9 Click Submit, and in the message box, click OK. 

5 Log off. 
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Qualification process tests 
The qualification process consists of a set of tests that exercise the basic functionality of the InForm 
software. The tests are divided into Admin and CRC/CRA tests. 
 

Admin - Users test 
 

Pass/Fail Step Description 

 1 Click the Admin button. 

 2 Select each of the following tabs: Users, Rights, Groups, Sites, Configuration, 
Events, Rules, System, and Synchronization. 

 3 Click the Users tab, and verify that the following users are active: 

• lhill 

• dobrien 

• mcarlson 

 4 In the Users tab, click Add User. 

 5 Type X in the User Name field, and fill in additional user information.  

Click Submit, and in the message box, click OK. 

 6 Click Return. 

Verify that user X is shown in the list. 

 7 Click Properties for user X.  

Assign a rights group and two user site associations.  

Click Submit, and in the message box, click OK. 

 8 Click Return.  

Click any links for user X except Properties. 

 9 Click Change Password. 

Give user X a password with six characters or more. 

Click Submit, and in the message box, click OK. 

 10 Click Return.  

Select Activate User. 

Click Submit, and in the message box, click OK. 

Log off. 

 11 Log on as user X, using the password assigned in Step 9. 

Click Patients. 

Verify that the Sites drop-down list contains only All Sites and the sites 
chosen in Step 7. 
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Admin - Rights test 
 

Pass/Fail Step Description 

 1 Select the Rights tab. 

Click Add Rights Group. 

 2 Fill in new rights group information. 

Click Submit, and in the message box, click OK. 

 3 Click Return.  

Verify that the rights group that you just created is in the list. 
 

 

Admin - Sites test 
 

Pass/Fail Step Description 

 1 Select the Sites tab. 

Click Add Site.  

Type the new site information.  

Click Submit, and in the message box, click OK. 

 2 Click Return. 

Verify that the site that you just created is in the list. 
 

 

Admin - Groups test 
 

Pass/Fail Step Description 

 1 Select the Groups tab. 

Click Add Group.  

Select Signature from the Group Type drop-down list, and type the group 
information.  

Click Submit, and in the message box, click OK. 

 2 Click Return. 

Verify that the signature group that you just created is in the list. 

 3 Select the Groups tab. 

Click Add Group. 

Choose Query from the Group Type drop-down list, and enter group 
information. 

Click Submit, and in the message box, click OK. 
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Pass/Fail Step Description 

 4 Click Return. 

Verify that the query group just created is in the list. 
 

 

Admin - Users and Groups test 
 

Pass/Fail Step Description 

 1 Select the Groups tab. 

Click Change for the signature group that was created in the previous 
section. 

 2 Select user X in the list on the right.  

Click Add. 

 3 Verify that user X is in the list on the left. 

Click Submit, and in the message box, click OK. 

 4 Click Return. 

Verify that the Member count column shows 1 (not 0) for the signature 
group. 

 5 Select the Groups tab. 

Click Change for the query group that was created in the previous 
section. 

 6 Click user X in the right-hand list. 

Click Add. 

 7 Verify that user X is in the left-hand list. 

Click Submit, and in the message box, click OK. 

 8 Click Return. 

Verify that the Member Count column shows 1 (and not 0) for the 
query group. 
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CRC / CRA tests 
To perform the tests in this section, you need to have two browser sessions open, one as a CRC 
(dobrien) and the other as a CRA (lhill). 

To run the CRC/CRA tests: 

1 Open two browser windows, using the following URL: 
http://computer_name/pfst45 
 

2 Log on to one as dobrien (a CRC) and the other as lhill (a CRA). 
 

As dobrien (CRC) 
 

Pass/Fail Step Description 

 1 Click Enroll. 

Click Add Candidate. A question window appears. 

 2 Enter patient information. 

Click Submit. 

 3 Click the Screening Number for the patient that was just entered. 

Edit one of the fields.  

Click Submit, and in the message box, click OK. 

 4 Click Return. 

Verify that the field you edited is changed. 

 5 Click Enroll. 

 6 Enter the patient number (site ID followed by a hyphen and a 3-digit 
number).  

Click Submit. The System Enrollment page displays the heading 
Patient Meets All Criteria for Enrollment in Study. 

 7 Click Enroll. 

Verify that a Patient Schedule page appears for the patient with a 
default baseline date of the current date. 

 8 Change the start date in the Visit calculator. 

Verify that the associated dates are updated correctly. 

 9 Click Go To First Visit. 

 10 Complete the DOV form. 

Click Submit, and in the message box, click OK. The tabs for the first 
visit's forms appear.  

Click each of the forms in the first visit. 

 11 View the Time and Events Schedule to check all visits for the new 
patient (click the up arrow where the timeline is shown). 
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Pass/Fail Step Description 

 12 Click one of the traffic lights for the baseline visit (for example DEM). 

Enter data in the form. 

Click Submit, and in the message box, click OK. 

 13 Click Return. 

Click the traffic light for the VS form. 

Enter a value of 200.5 degrees Fahrenheit in the Temperature item. 

Click Submit, and in the message box, click OK. 

Verify that an auto-query is generated. (The background for the 
question becomes pink and an error message is shown in red.) 

 14 Add a comment to an item (by clicking the dialog bubble to the right). 

Click Submit, and in the message box, click OK. 

 15 Change the Temperature value to 98.6. 

Click the cell that contains the item value and fill out the Data Value(s) 
form. 

Click Submit, and in the message box, click OK. 

 16 Verify that the auto-query is answered. The background for the 
question changes from pink to gray. 

 17 Click any tab for the patient. 

Select Mark SV Ready from the Select Action list and click Do. 

 18 Click the DEM tab for the patient.  

Select Mark SV Ready from the Select Action list and click Do. Verify that 
the report shows. 

Click Print. 

 19 Verify that the report prints with the correct information. 

 20 Click Help> InForm and Trial Reporting. 

Verify that InForm Help is installed and functioning. 
 

Note: Keep both browsers open to make the following steps easier to perform. 
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As dobrien (CRC) and lhill (CRA) 
 

Pass/Fail Step Description 

 1 As lhill: 

Click Patients. 

Click the Patient link for dobrien, which was created in the CRC test. 

Click the traffic light for the DEM form. 

Create an open query on an item entered by dobrien: 

Click the query flag for the item, click Create Query, select Create Query in 
Opened State in the Action list, and select a reason. 

Click Submit, and in the message box, click OK. 

Verify that the query appears with red text in a pink box under the item. 

 2 As dobrien: 

Click Patients. 

Click the Patient link for dobrien, which was created in the CRC test. 

Click the traffic light for the DEM form. 

Answer the query:  

Click the yellow flag or the red query text and select a reason. 

Click Submit, and in the message box, click OK. 

Verify that the query disappears from the form. 

 3 As lhill: 

Refresh the DEM form by clicking the DEM link in the CRF History. 

Re-issue the answered query:  

Click the yellow flag, select Reissue Query in Open State in the Action list, 
and select a reason. 

Click Submit, and in the message box, click OK. 

Verify that the query reappears. 

 4 As dobrien: 

Refresh the DEM form by clicking the DEM link in the CRF History. 

Re-answer the query. 

Click Submit, and in the message box, click OK. 

Verify that the query disappears from the form. 
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Pass/Fail Step Description 

 5 As lhill: 

Refresh the DEM form by clicking the DEM link in the CRF History. 

Close the query:  

Click the yellow flag, select Close Query in the Action list, and select a 
reason. 

Click Submit, and in the message box, click OK. 

Verify that the query disappears from the form. 
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Removing a trial 
When you remove a trial, you remove the trial definition and data from the InForm database.  

If the Reporting and Analysis module is installed, you must first: 

1 Deinstall the reporting schema. 

2 Delete information about the trial from the Cognos 10 BI environment. 
 

Removing the reporting database 
Reporting can be removed in the following ways: 

• Remove a single Reporting and Analysis trial/reporting schema combination when the reporting 
schema is installed in a different database. 

This leaves Streams and other existing trial/reporting schemas installed. 

For more information, see Removing a single trial/reporting schema—separate databases 
for trial and reporting. (on page 70) 

• Remove the Reporting and Analysis module when the reporting objects have been installed in 
the same database as the trial. 

All reporting objects exist in the trial schema. 

Use this to completely remove Reporting and Analysis from one database. 

For more information, see Removing reporting—single database for trial and reporting (on 
page 71). 

Note: Streams components are not installed when using the single database configuration. 

• Completely remove the Reporting and Analysis module when the reporting schema is installed in 
a different database. 

Use this to completely remove all InForm software trial/reporting schemas and Streams. 

For more information, Completely removing InForm software reporting—separate 
databases for trial and reporting (on page 72) 
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Removing a single trial and reporting schema—separate databases for trial 
and reporting 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm application server. You can also run the scripts from the InForm reporting Oracle 
database home on a Windows Server. Running them from a different Windows Oracle client or 
from a non-Windows Oracle client or database home might work, but is not supported. 

1 Run the deinstall_reporting_diffdb.sql script. 

Note: This script uses the configdiffdb.sql file, so make sure the correct one is in place. 

The uninstall script does not remove tablespaces. 

a To check for any errors, search for the word Error. 

If any are found, correct the problem and run the script again. 

b Rerun the script until it does not find anything to remove and does not have any errors. 

In the log, all steps appear with the message No object… was found. 

2 To make sure everything has been removed, run the configandcheckdiffdb.sql script. 

If this completes successfully, the uninstall succeeded. 

Note: This script checks for the existence of a tablespace. If the script fails because it 
cannot find a tablespace, adjust the tablespace variables in configdiffdb.sql to an existing 
tablespace in the database and run the script again. 

3 Run the following command in both the trial database and the reporting database. 

Note: Do not run this command until you are sure you have completely removed the 
trial/reporting schemas. 

a From a Windows command prompt, log on to SQL*Plus with /nolog. 

b Connect to the reporting database as STRMADMIN. 
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c At the SQL*Plus prompt, type: 
Delete from streams_setup_info 
where trial_username = '<trial_schema_owner>' 
and rep_username = '<rep_schema_owner>' 
and trial_db_global_name = '<global name of the trial database>' 
and rep_db_global_name = '<global name of the reporting database>' 
 

Note: Enclose all of the above values in single quotes. 

where: 

• <trial_schema_owner> is the InForm trial owner in the trial database. 

• <rep_schema_owner> is the reporting schema owner in the reporting database that 
corresponds to the InForm trial owner. This username is the same as the InForm trial 
owner. 

• To find the <global name of the trial database> in the trial database, type: 
'Select global_name from global_name;' 
 

• To find <global name of the reporting database> in the reporting database, type: 
'Select global_name from global_name;' 
 

 

Removing reporting—single database for trial and reporting 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm application server. You can also run the scripts from the InForm reporting Oracle 
database home on a Windows Server. Running them from a different Windows Oracle client or 
from a non-Windows Oracle client or database home might work, but is not supported. 

Oracle provides a script called deinstall_reporting_samedb to uninstall a single reporting schema. 
This script removes all components associated with the Reporting and Analysis module for a single 
trial schema/reporting schema combination. 

Note: The uninstall script does not remove tablespaces. 

This script relies on the configsamedb file to perform the uninstall. Use the same configsamedb.sql 
file for the installation and the uninstallation. If this file is not available, set parameters in the 
configsamedb.sql file to uninstall the reporting schema. 

1 From a Windows command prompt, set your default to the folder where the reporting software 
is located. 

2 Log in to SQL*Plus with /nolog. 

3 At the SQL*Plus prompt, type: 
@deinstall_reporting_samedb 
 

Note: This script uninstalls the reporting environment for a single trial/reporting schema. It 
does not uninstall multiple reporting schemas and it does not remove underlying reporting 
infrastructure. You can run this script as many times as necessary. 

If the script aborts with the message Reporting deinstallation aborted, nothing has been 
removed. This usually indicates a problem with the configsamedb.sql file settings. 
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4 To make sure everything has been removed, run the configandchecksamedb.sql script. 

If this script completes successfully, the uninstall has succeeded. 

Note: This script checks for the existence of a tablespace. If the script fails because it cannot find 
a tablespace, adjust the tablespace variables in configdiffdb.sql to an existing tablespace in the 
database and run the script again. 

 

Completely removing InForm software reporting—separate databases for 
trial and reporting 

Use this procedure to completely remove the Reporting and Analysis module and Streams in any 
database where they were installed. 

Note: Be sure to execute this procedure on only the databases from which you are completely 
removing the Reporting and Analysis module. 

Before proceeding, Oracle recommends that you shut down any trials and Streams processes, and 
make sure that there are no other users on the system. 

1 Uninstall any existing Reporting and Analysis installations in the database first. 

For more information, see Removing a single trial/reporting schema—separate databases 
for trial and reporting (on page 70). 

Repeat that procedure as many times as necessary to remove all affected reporting schemas 
before proceeding. 

2 Run the Oracle Streams remove procedure. 

Connect to each database where Streams is to be completely removed as STRMADMIN and run the 
DBMS_STREAMS_ADM.REMOVE_STREAMS_CONFIGURATION procedure. 

For more information, on this procedure, see the Oracle PL/SQL Packages and Types Reference. 

The removal procedure leaves invalid SYS objects in the database. 

3 To recompile them, under the ORACLE_HOME\rdbms\admin folder, run the utlrp.sql script. 

4 Connect to the database as STRMADMIN and run the following command: 
Execute dbms_aqadm.drop_aq_agent(‘STRMADMIN’); 
 

5 Remove the reporting infrastructure components from the reporting database: 

a Open Enterprise Manager. 

b Log on to the affected databases as RPTINSTALL. 

c Run the appropriate set of steps (reporting database without other reporting schemas, or 
trial database without other reporting components required for other trials). 

Note: Run these steps only for a reporting database that does not have other reporting 
schemas installed. 
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6 In the reporting database: 

a Drop the public database link to the trial database. 

b Drop the STRMADMIN user with the CASCADE option. 

c Drop the PFREPORTING role. 

Note: Run these steps only for a trial database that does not have reporting components 
required for other trials. Skip this step if other trial schemas will need the reporting 
components after uninstalling. 

7 In the trial database: 

a Drop the public database link to the reporting database. 

b Drop the STRMADMIN user with the CASCADE option. 

c Drop the PFREPORTING role. 

d Drop the RPSTRMADMIN user with the CASCADE option. 

You might need to completely remove the Reporting and Analysis module from only one 
trial/reporting database. Consider the following scenario, where the goal is to completely remove the 
Reporting and Analysis module from RPTDB2, while leaving it installed on RPTDB1. 

Two trial/reporting schemas are installed: 

• One trial schema resides in TRIALDB1, and its reporting schema resides in RPTDB1. 

• One trial schema resides in TRIALDB1, and its reporting schema resides in RPTDB2. 

In this scenario, run the first four steps to remove the second trial, leaving the first trial/reporting 
schema as is. Run the remaining steps on RPTDB2 only. Streams must remain installed on 
TRIALDB1 to support the first trial/reporting schema combination. 
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Deleting trial information from the Cognos 10 BI environment 
• Run the DecomTrial command (located in the <Installation_Directory>\InForm\bin folder on 

the InForm application server) to securely remove InForm trial components (trial folders, clinical 
package, operational package, DSN entries, and InForm trial user accounts) from the Reporting 
and Analysis module using the following syntax: 

DecomTrial [SysAdminNamespace SysAdminUsername TrialNamespace TrialUsername 
CognosDispatcherURI TrialName ] | ["path_to_parameter_file"] 
 
Depending on the syntax used with the DecomTrial command, you are prompted for the following 
parameters: 

• System Administrator namespace—Oracle Directory Server admin namespace.  

• System Administrator username—User name for the Cognos system administrator. 

• Trial namespace name—Custom Authentication Provider (CAP) namespace. 

• Trial user username—InForm trial user who is a member of the following Reporting groups: 

• Publishers. 

• Either Sponsor Users or Site Users. 

• Cognos dispatcher URL—Internal URI that the InForm server uses to communicate with the 
Cognos 10 BI server. 

• Trial name—Trial name. 

• System Administrator password—Password for the Cognos system administrator. 

• Trial user password—Password for the InForm trial user. 

For example: 

DecomTrial OHSI crnsysadmin informcap mmartin 
http://server.example.com:9300/p2pd/servlet/dispatch pfstcardio blank 

With the exception of the System Administration password and Trial user password parameters, you 
can pass parameters by using the "path_to_parameter_file" command option. 

When specified, this option includes the path to a text file that contains the values required to run the 
command. The format of the parameter file is parameter=value. There is a new line for each 
parameter, and there are no spaces on a line. 
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Removing a trial definition and data 
1 Stop the trial, using the following command: 

pfadmin stop trial <trialname> 
 

2 Remove the trial, using the following command: 
pfadmin remove trial <trialname> 
 

To remove the DSNs from ODBC data source administration at the same time, use the 
following command: 

pfadmin remove trial <trialname> /DSN 
 

3 Remove the user from the database. As the PFDBAdmin user, issue the following command: 

Caution: When you execute this step, all trial data will be lost. In production, make sure you 
back up the trial database before removing the user. 

drop user <trial_uid> cascade; 
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Changing the PFDBAdmin password 
Note: When you install the InForm software on a production server, Oracle strongly suggests that 
you change the default InForm passwords. You can change this password on this window during the 
installation, or manually either before or after installing.  

To run the InFormPrepORA.vbs script manually and register the new password: 

1 Open a command prompt window. 

2 Execute the following command from the InForm\Bin\DBOra folder of the InForm software 
installation: 

cscript InFormPrepORA.vbs oracle_connection_string PFDBAdmin_userid 
 

When prompted, enter: 

• Password for the Oracle SYS user. 

• New password for the pfdbadmin user. 

3 Enter the following command to put the new password in the Registry: 
pfadmin config service /sysdba PFDBAdmin_userid 
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Installing or re-installing the InForm Admin database after 
the initial installation of InForm 

If you did not set up the InForm Admin database during the initial installation of the InForm 
software, or if the installation failed, you must run the following commands at a command prompt: 

• admindb—Creates the InForm Admin database 

• pfmqadmin—Creates and configures the PFMQ tables. 

Use these commands if you want to do either of the following:  

• Relocate the InForm Admin database from its original location to a new one using the 
ADMINDB.CMD 

or 

• Locate the PFMQ tables in a separate database schema than InForm Admin.  
 

admindb command 
The admindb command installs the InForm Admin database. The command is located at 

<installation_directory>\inform\bin\dbORA\admindb.cmd 
 

Syntax 

admindb [flag] [connection string] [informadmin UID] [pfadmin UID] 
 

When you run the admindb command, you are prompted to enter the password for the pfdbadmin 
user and the informadmin user. 

Flags 
 

Flag Description 
–PFMQCFG  Use this flag if you chose not to create the AdminDB at the time of 

installation, or if the installation of the InForm Admin database failed, 

If specified: 

• Configures the Admin database as the PFMQ 
messagestore/infostore 

• Creates the AdminDB schema manually. 

• Puts the PFMQ database in the same database schema as the 
InForm Admin database. 

–NOPFMQ If specified: 

Creates the AdminDB, but does not create PFMQ tables or configure 
PFMQ 

Use the -NOPFMQ flag if the PFMQ data is to be stored in a separate 
schema from the InForm Admin database (for example, for an 
installation of the CIS software). 
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None If no flag is specified: 

• The AdminDB and the PFMQ tables are created in the same 
database schema. 

• The AdminDB is not set as the PFMQ messagestore/infostore. 

Note: This behavior is the same as the behavior of the admindb 
command in the InForm 4.0 and 4.1 software releases. 

 

 
 

pfmqadmin command 
pfmqadmin creates tables for PFMQ and specifies their locations. 

1 Before you create the PFMQ tables, you must do one of the following: 

• Create an Oracle user, using Oracle Enterprise Manager Console, or 

• Drop and recreate the Oracle user, run the pfmqadmin command with the following 
arguments:  
pfmqadmin setup dbuser system [connectstring] [pfmquser]  
 

When prompted, enter the password for the database SYS user and the pfmquser. 

2 Create PFMQ tables and specify locations: 
pfmqadmin setup dbusertable [AdminDBUID] [connectstring] 
pfmqadmin config queueinfostore [AdminDBUID] [connectstring] 
pfmqadmin config defaultmessagestore [AdminDBUID] [connectstring] 
 

When prompted, enter the password for the pfmq database admin. 

Arguments 

• AdminDBUID—Database user name 

• connectstring—Database connection string 
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Enabling a secure data transmission with HTTPS 
To encrypt the transmission of data between the application server and the browser computer, you 
must enable HTTPS. This is required for production server installations only. 

• If you are using the InForm Unplugged software to synchronize data between servers, HTTPS is 
required for synchronization. 

• If you are not using the InForm Unplugged software to synchronize data between servers, 
HTTPS is optional. 

For more information, see Enabling the HTTPS system configuration option (on page 85). 
 

Disable SSL on the InForm application server and Cognos Gateway servers 
If you use HTTPS security in your environment, Oracle recommends that you disable SSL on the 
InForm application server and the Cognos Gateway servers, and enable TLS1.1 and above for 
improved security. For more information, see the Microsoft website 
(http://social.technet.microsoft.com).  
 

Creating, setting up and installing a key certificate 
These procedures are for Windows server 2008, with Internet Information Services (IIS) 
 

Creating and setting up a key certificate for HTTPS in IIS 
1 Open Internet Information Services (IIS) Manager. 

2 Open the <machine_name> node. 

3 Go to the IIS Group > Feature View and select Server Certificate. 

4 From the Actions view, click Open Features. 

5 From the resulting Actions view, select Create Certificate Request. 

6 Request Certificate Wizard opens. 

7 Complete the Request Certificate page. Specify the name of the trial server in the Common 
name field, including the FQDN (for example: <machine_name>.example.com). 

8 Click Next. 

9 Leave all default values in Cryptographic Service Provider Properties and click Next. 

10 Click the Browse. 

11 Specify the certificate request name and folder details. 

12 Click Save.  

13 Click Open. The file name appears in the text box. 

14 Click Finish. 
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Installing a key certificate on the server machine in IIS 
1 Open your browser and go to the security certificate server URL: 

http://<Windows_2008_security_certificate_server>/<certificate _request_page>.  

2 Click Request a certificate. 

3 Click Advanced certificate request. 

4 Click Submit a certificate request by using a base-64-encoded. 

5 Copy all the text in certreq.txt file in the first text field of the saved request.  

6 Click Submit.  

7 Select Base 64 encoded. 

8 Click Download certificate.  

9 Save to c:\certnew.cer. 

10 Click Download certificate chain. 

11 Save to c:\certnew.p7b. 

12 Go to Internet Information Services Manager to complete the certificate request. 

13 Select the <machine_name> node. 

14 From the Feature View, select Server Certificate under IIS group. 

15 From the Actions view, select Open Feature. 

16 From the Actions view, select Complete Certificate Request. 

17 Browse to c:\certnew.cer and give the Friendly name as machine name, and click Next. 

18 Set the SSL port to the port number for the trial server. The default is 443.  

19 Click OK. 

20  Go to C:\ directory. Right click on c:\certnew.p7b. 

21 Select Install Certificate, and click Next.  

22 Click Next again, and click Finish. 

23 Click Yes in the Security Warning dialog box. 

24 Click OK on the confirmation dialog box. 

25 Set the Binding for Default Websites. 

26 Go to IIS Manager. 

27 Select the <machine_name> node. 

28 Open the Web Sites node.  

29 Click Edit Site > Bindings, and click Add. 

30 Select the certificate type as Https and SSL. 

31 Click View. Verify that there is no red exclamation mark for the Certificate. 
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Import the new key certificate to the local computer and the current user 
1 Go to Start > Run, and type mmc. 

2 From the Console screen, go to file > Add/Remove Snap-in. 

3 Click Available snap-ins > Certificates > Add. 

4 Select My user account, and select Finish. 

5 Click Available snap-ins > Certificates > Add. 

6 Select Computer account, select Next > Finish, and click OK. 

7 Go to Certificates > Current User. 

8 Expand Trusted Root Certificate Authorities. 

9 Right-click Certificates and select Import. 

10 Browse to the certificate you created, select it, and complete the wizard, using all defaults. 

11 Repeat Step 8 through 10 for Certificates > Local Computer. 

Note: Make sure <Windows_2008_security_certificate_server> is listed in the trusted roots 
of the certificate store for both the current user and the local computer. If it is not there, 
export it from the current user, save it to the disk, and import it to the local computer. 

 

Verify that the certificate is installed 
To verify that the key certificate is installed correctly: 

1 Open a browser window. 

2 Type: 
 https://<computer_name.domain>_name.com 

 
The Security Alert window appears.  

3 Verify that the date and name for the certificate are valid. 
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Updating the ExternalLoginURL and ExternalLoginFailureURL registry key 
entries on the InForm application server 

If you are implementing HTTPS, perform these steps. 

On each server that hosts an InForm trial, update the ExternalLoginURL and 
ExternalLoginFailureURL entries for the AuthenticationFilter registry key. 

1 In the Windows Registry Editor, navigate to the following Windows Registry key: 
HKEY_LOCAL_MACHINE\SOFTWARE\PHASEFORWARD\AuthenticationFilter 
 

2 Update the entries for ExternalLoginURL: 

a Right-click the entry and select Modify. 

The Edit String dialog box appears. 

b Specify the URL to configure for HTTPS. 

https://<servername>.<domainname>:<portnumber>/PFExternalLogin/ExternalLoginFramese
t.html 

For example: 

https://www.sample.com:443/PFExternalLogin/ExternalLoginFrameset.html 

c Enter the new value in the Value Data field and click OK.  

3 Update the entries for ExternalLoginFailureURL: 

a Right-click the entry and select Modify. 

The Edit String dialog box appears. 

b Specify the URL to configure for HTTPS. 

https://<servername>.<domainname>:<portnumber>/PFExternalLogin/ExternalLoginEscape.h
tml 

For example: 

https://www.sample.com:443/PFExternalLogin/ExternalLoginEscape.html 

c Enter the new value in the Value Data field and click OK.  

4 Exit the Windows Registry Editor. 

5 Restart IIS. 
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Enabling the HTTPS system configuration option 
You can enable the HTTPS system configuration two ways: 

• Use the InForm Admin user interface. 

• Use the MedML Installer tool to install the appropriate MedML sysconfig tag. 
 

Using the Admin user interface to enable HTTPS 
To enable HTTPS by using the InForm application Admin user interface: 

1 Log on to the InForm application. 

2 In the Navigation pane, click Admin. 

3 Select the Configuration tab. 

4 Set the Enable SSL option to on. 

5 Click Submit. 

6 Restart the trial. 

7 If you are setting up the Reporting and Analysis module, change the Reporting Service Full URL to 
start with https://. 

Note: If you are going to use Cognos 10 Business Intelligence, there is additional configuration 
that must be performed on the Cognos Gateway server. For more information, see Configuring 
Cognos 10 BI to use HTTPS (on page 109). 

 

Using MedML to enable HTTPS 
To enable HTTPS by setting the sysconfig MedML tag: 

1 Create an XML file with the following entry: 
<MEDMLDATA> 
<SYSCONFIG CONFIGNAME="SSLFlag" TYPE="0" VALUE="1" />  
<MEDMLDATA/> 
 

2 Install the configuration option with the MedML Installer tool.  

3 Restart the trial. 

4 If you are setting up the Reporting and Analysis module, change the Reporting Service Full URL to 
start with https://.  
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Updating the AuthenticationFilter DomainSuffix registry 
key 

If you are installing Cognos Reporting, you must update the DomainSuffix entry for the Oracle 
AuthenticationFilter registry key if any of the following is true on the InForm trial machine and the 
Cognos 10 BI Gateway Services machine. 

• You use proxy servers for the Cognos 10 BI Gateway Services machine and the InForm trial 
server. 

• The fully qualified domain name (FQDN) for either server does not end with a common domain 
suffix. The FQDN is registered in the Oracle AuthenticationFilter DomainSuffix entry during 
installation of the InForm server and the Cognos 10 BI Gateway Services software. If the 
FQDN for both installations ends in a common domain suffix such as .net, .com, .org, .edu, or 
.gov (with or without country name like .uk or .au), you do not need to update the DomainSuffix 
entry unless you use proxy servers. 

• If the FQDN has just two levels. (For example: <servername>.com.) 

Perform the DomainSuffix configuration on both the Cognos 10 BI Gateway Services machine and 
the InForm trial server. Both machines must have identical AuthenticationFilter entries for 
DomainSuffix. 

1 In the Windows Registry Editor, navigate to the following Windows Registry key: 
MyComputer\HKEY_LOCAL_MACHINE\SOFTWARE\Phase Forward\AuthenticationFilter 
 

2 Update the entry for DomainSuffix. 

a Right-click the entry, and select Modify. 

The Edit String dialog box appears. 

b Enter the new value in the Value Data field. Edit the entry: 

• If you use proxy servers, or if the fully qualified domain name for either server does not 
end with a common domain suffix, remove every part of the domain suffix that is not 
identical on both computers. For example, if the FQDN includes 
<servername>.<companyname>.co.uk, after the edit, the entry would be 
<companyname>.co.uk. 

c Click OK. 

3 Exit the Windows Registry Editor. 

4 Restart IIS.  

On the InForm server, restart the InForm Service. 
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Configuring a Customer Defined Database 
A CDD is an extract of clinical data from a trial database. You can use a CDD to pass data into 
customer statistical analysis tools or other external programs. You can use either the Reporting and 
Analysis module or a CDD, or both, to extract data from a trial. 

Note: CDD is trial-specific and applies to a single trial only. 

A CDD is limited to clinical data, and is typically designed to organize this data in a way that is suited 
for delivery into customer statistical analysis tools or other external programs. 

The Reporting and Analysis module uses a database similar to the CDD, with a few key differences. 
The Reporting and Analysis database structure is fixed based on the trial design, and cannot be 
adjusted as it can be with the CDD. Additionally, the Reporting and Analysis database contains status 
and derived operational metrics in addition to the clinical data. 
 

Steps to create a CDD 
1 Define CDD mappings (on page 87). 

2 Install CDD mappings (on page 88). 

3 Configure the CDD (on page 88). 

For more information, see Setting Up a Trial with InForm Architect and MedML. 
 

Define CDD mappings 
CDD mapping definitions specify how to transfer data from a trial database to a CDD. They 
indicate: 

• Where each mapped data point comes from in the source trial. 

• Where each mapped data point goes in the CDD. 

• How the data is organized in each CDD table. 

• Optional supplemental text about the design of the components of the CDD definition. 

• Optional label text that is transferred to the CDD along with data values. 

Use the InForm Architect application to generate the CDD mappings. For more information, see the 
Setting Up a Trial with InForm Architect and MedML Guide. 
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Install CDD mappings 
After the CDD mappings are generated, use the MedML Installer tool to install the mappings to 
create the CDD tables.  

For more information, see the Setting Up a Trial with InForm Architect and MedML Guide. 

An application developer provides an XML file that contains the CDD definition for the trial. After 
the trial is set up, you can install the CDD definition using the MedML Installer utility. 

Note: During a CDD data export, no transactional data should be added, deleted, or modified, as 
this may cause an inconsistency between the transactional database and the CDD. 

 

Configure the CDD 

Note: It is strongly recommended that the default tablespace for the CDD user should be 
something other than the InForm software tablespace. 

To set up and configure CDD mappings for a trial database: 

1 Ensure that the target trial is running. 

2 Create a CDD schema with the DSN name, DSN user, and DSN password using the following 
syntax: 
pfadmin setup cdd <CDDRefName> <TrialName> /DB <oracle_connection_string> 
<CDD_DSN> <UID> 
 
When prompted, enter the password for the CDD DSN user. 

For example: 
pfadmin setup cdd PFSTCDD pfst46 /DB testmachine_dev1 pfstcdd pfstcdduid  
 

3 Activate the CDD sot that it is functionality transactional: 
pfadmin config cdd <trialName> <CDD_DSN> active 
 
For example: 
pfadmin config cdd pfst46 pfstcdd active 
 

4 Enable the CDD functionality for the trial:  
pfadmin config cdd TrialName enable 
 
For example: 
pfadmin config cdd pfst46 enable 
 

For more information, see PFAdmin syntax (on page 196). 
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Setting up custom home pages 
The clinical trial designer may have created custom home pages that are visible for each user. Each 
user can have his or her own home page. Home pages (html) must be accessible to the web server. A 
folder named Custom is automatically created when you install a trial that was designed in the 
InForm Architect. The virtual directory for each trial is located in the 
<Installation_Directory>\InForm\Trials directory.  

Note: Files contained in these custom directories are unsecured. 

After installing a trial, you can copy the custom home pages into the custom folder for the trial, and 
to the virtual custom directory using the Windows Explorer or the following xcopy command: 

xcopy <drive:\path to trial custom pages\*.* ><drive:\path to trial custom 
folder\ >/e 
 

Where 

• xcopy—is the Windows command. 

• <drive:\path to trial custom pages\*.*> is the drive and path to the custom home pages created 
by the clinical trial developer. 

• <drive:\path to trial custom folder\> is the drive and path to the \Custom folder for the InForm 
trial. 

• /e is an option that indicates to copy directories and subdirectories, including empty ones. 
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Setting up randomization 
Randomization in an InForm trial enables the trial to randomly assign drug kits or devices to 
patients. 

On the development side, the application engineer: 

• Incorporates the randomization feature into a trial by using rules attached to items on a form. 

• Implements the feature as a button on a randomization form using the appropriate UUIDs 
included on the form, section, and item of the randomization form or the form responsible for 
issuing randomized IDs. 

• Creates a randomization database. 

Note: A sample Microsoft Access database is included in the sample trial. To use an Oracle 
randomization database, create an Oracle schema with a table structure that is identical to 
the sample Microsoft Access database. 

On the production side, you must configure the trial to use the randomization database. 

1 Use this pfadmin command: 
pfadmin config trial <trialname> /rnd <pathfilename.dbextension>  

 
where 

• <trialname> is the name of the trial for which you are setting up the Randomization feature. 

• /rnd is an option that does two things: creates a DSN for the randomization database; 
configures the trial to use the DSN. 

Note: You can also use /RndDSN to configure a trial to use an existing DSN.  

• <pathfilename.dbextension> is the filename of the datafile containing the Randomization 
database. 

2 Restart the InForm service to complete randomization configuration. 
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Enabling email 
1 Enable email notifications (on page 91). 

2 Install and register CDONTS (on page 91). 

Note: If your email notification is based on the example found in PFST45 or PFST46, you 
must apply the CDONTS.DLL to all InForm application servers. The epMail execution plans 
use a call to CDONTS.DLL to send email. CDONTS.DLL is no longer supported by Microsoft. 
Calls that use CDONTS.DLL will not send mail without this step. 

For more information, see the Setting Up a Trial with InForm Architect and MedML Guide. 
 

Enable email notifications 
To enable email notification: 

• Install Microsoft SMTP. Since this is a pre-installation requirement for the InForm software, 
SMTP should already be available. 

• Set the routing option for mail delivery. 

• Set the smart host or remote domain of the SMTP site to point to the email gateway for message 
transmissions. 

 

Install and register CDONTS 
1 Verify that the Microsoft SMTP server is running. 

2 Download and unzip cdonts.dll to C:\Windows\System32 folder. 

3 Register the CDONTS.DLL component on the server by running the following command from the 
command prompt: 

regsvr32 c:\Windows\system32\cdonts.dll 
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About the Cognos 10 BI software installation 
The Cognos 10 BI software installation process installs: 

• Cognos 10 BI Application Tier Components. 

• Cognos 10 BI Gateway services. 

• Cognos 10 BI Content Manager. 

You can install the components on separate servers or on the same server, or you can distribute each 
component across multiple servers. For more information, see the Cognos Installation and Configuration 
Guide, which is included in the InForm product download. 
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Install the Oracle Directory Server 
Note: The Oracle Directory Server Enterprise Edition can be installed on a Windows 2008 server 
or a Linux server. 

1 Download and install the Oracle Directory Server. 

2 Configure and deploy the Oracle Directory Server to a supported web server. 

For more information, see the Oracle website, the Oracle Directory Server Enterprise Edition 
documentation, or your Oracle database documentation. 

 

Create the PFWD organizational unit (OU) and crnsysadmin user on the Oracle 
Directory Server 

If you are using Reporting, you must create an PFWD namespace and crnsysadmin user on the 
Cognos Content Manager Server and the Cognos Report Server. For more information, see 
Creating the PFWD LDAP namespace on the Cognos 10 BI server (on page 108) 

1 On the server where the Oracle Directory Server is installed, use the Cognos Configuration 
utility to ensure that the Cognos 10 Business Intelligence Service is stopped. 

2 Launch the URL for the Oracle Directory Server and log in to the Oracle Directory Service 
Control Center. 

3 Select the Directory Server tab. In the Directory Servers list, click the server name. 

The Server Operations tab opens. 

4 Select the Entry Management tab. 

5 Select the DN from the Browse Data list, and click New Entry. 

The New Entry wizard page displays the Specify Entry Location page. 

6 Make sure that the Entry Parent DN is correct, and click wizard button next. 

The Choose Object Class page appears. 

7 Select Organizational Unit - (organizationalUnit) from the Entry Type drop-down list, and click 
wizard button next. 

The Configure Attributes page appears. 

8 In the Organizational Unit (ou) field, type PFWD (all uppercase), and click wizard button next. 

The Summary page appears. 

9 Review the information. If it is correct, click wizard button finish. 

The PFWD node is added to the Browse Data list. 

10 On the Entry Management tab, right-click ou=PFWD in the Browse Data list, and click New 
Entry. 

The New Entry wizard displays the Specify Entry Location page. 
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11 Make sure that the Entry Parent DN is correct, and click wizard button next. 

The Choose Object Class page appears. 

12 Select User - (inetOrgPerson) from the Entry Type drop-down list, and click wizard button next. 

The Configure Attributes page appears. 

13 Create a new user for the PFWD namespace as follows:  

• Full Name (cn)—crnsysadmin 

• Last Name (sn)—crnsysadmin 

• User ID (uid)—crnsysadmin 

• Password (userPassword)—<crnsysadmin password> 

• Confirm Password—<crnsysadmin password> 

14 Click wizard button next. 

The Summary page appears. 

15 Review the information. If it is correct, click wizard button finish. 

The uid=crnsysadmin node is displayed in the Browse Data list on the Entry Management tab. 
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Installing the Cognos 10 BI software 
1 Download the bi_svr_64b_10.2.2_win_ml.tar.gz file from the Oracle Download Center, 

extract the archive file, and navigate to the issetup.exe file in the \Win64h folder. 

2 Double-click issetup.exe. 

The Welcome page of the installation wizard appears. 

3 Select the language to use for the installation, and click Next. 

The License Agreement page appears. 

4 Read the license agreement, select I agree, and click Next. 

The Installation Location page appears. 

5 In the Installation Directory field: 

• Browse to or type the drive and destination folder for Cognos 10 Business Intelligence (for 
example E:\cognos\c10_64) 

• Select either Production or Non-Production as the Server Type, and click Next.  

If the Folder does not exist message appears, click Yes to create the folder. 

The Component Selection page appears. 

6 Make sure that IBM Cognos Business Intelligense Server is selected, and that all components 
except Cognos Content Database are selected, and click Next. 

The Shortcut Folder page appears. 

7 Accept the default Program folder, and click Next. 

The Installation Summary page appears. 

8 Review the installation summary, and click Next. 

The installation program installs the components that you selected. This takes several minutes. 
When the component installation is complete, the Finish page appears. 

9 On the Finish page: 

• To view the transfer log or the summary-error log, click the appropriate View button. 

• Verify that Start Cognos Configuration is not selected.  

10 Click Finish. 
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Installing Cognos hot sites 
In addition to the Cognos 10 BI software, you must install the following hot sites: 

1 Download each hot site file from the Oracle Download Center and install the interim fix updates 
in the following order: 

a up_bisrvr_winx64h_10.2.6100.1032_ml.tar.gz 

b up_bisrvr_winx64h_10.2.6100.1037_ml.tar.gz 

2 Extract each archive file into a different folder from the folder where you originally downloaded 
the Cognos 10 BI version software, and navigate to the issetup.exe file in the \Win64h folder. 

3 Double-click issetup.exe. 

The Welcome page of the upgrade wizard appears. 

4 Select the language to use for the installation, and click Next. English is the default language. 

The License Agreement page appears. 

5 Read the license agreement, select I agree, and click Next. 

The Installation Location page appears. 

6 In the Installation Directory field, browse to or type the same drive and destination folder that 
you specified for the initial installation of the Cognos 10 Business Intelligence software (for 
example C:\cognos\c10_64), and click Next.  

The Installation Summary page appears. 

7 Review the installation summary, and click Next. 

When the installation is complete, the Finish page appears. 

8 To review the transfer log or summary error log, click the appropriate View button. 

9 Click Finish. 
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Setting up the Oracle JDBC driver 
Before running the wizards that customize the Cognos 10 BI software for the InForm environment, 
you must set up the Oracle JDBC driver on any computer that has a Cognos 10 Business Intelligence 
Content Manager installed. 

1 Download the ojdbc6.jar file from the Oracle support website. 

2 Copy the ojdbc6.jar file to the <Cognos_Installation_Directory>\webapps\p2pd\WEB-
INF\lib folder. 
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Configuring the Internet Information Services (IIS) for 
Windows on the Cognos Gateway server 

If the Cognos 10 BI software is installed on its own dedicated server, you must configure IIS to work 
in this deployment scenario. 

To configure IIS on the Cognos 10 BI Gateway server: 

1 Navigate to Control Panel > Administrative Tools > Internet Information Services (IIS) Manager and 
expand the node for the local computer. 

2 Select ISAPI and CGI Restrictions. 

3 Make sure that the following options are set to Allowed: 

• All Unknown CGI Extensions 

• All Unknown ISAPI Extensions 

• ASP.NET v1.1.4322 

• ASP.NET v2.0.50727 

• WebDAV. 

• Active Server Pages. 
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Running the customization wizards 
To customize the Cognos 10 BI software for the InForm environment, you run installation and 
configuration wizards: 

• Cognos 10 BI Customizations for InForm wizard. 

• Cognos 10 BI Gateway Customizations for InForm wizard. 

• InForm Reporting Addition wizard. 

• InForm ReportingDB wizard. 
 

Running the Cognos 10 BI Customization for InForm wizard 
1 Copy the CRNConfig folder from the InForm installation image to a location that you can 

access from the server where the Cognos 10 BI Content Manager is installed and each Cognos 
10 BI Report server. 

2 On the server where the Cognos 10 BI Content Manager is installed and each Cognos 10 BI 
report server, run the CRNConfig\setup.exe program file. 

The Welcome page appears.  

3 Click Next.  

The Cognos 10 BI Installation Location page appears. 

4 Specify the folder in which the Cognos 10 BI software is installed, and click Next.  

The Setup Type page appears. 

5 Select the memory model (Small, Medium, or Large) that is most appropriate for your business, 
and click Next. 

Note: You can change this later if you select the wrong size. 

The Content Store page appears. 

6 Enter the following values. 
 

Field Description 
Database server Fully qualified domain name of the database server where the 

Cognos 10 BI Content Store schema is installed. 

Port Port number for communicating with the database server. 

SID SID for communicating with the database server. 

User Name User name of the Oracle user in the Cognos 10 BI content 
store database. You created this user when you configured the 
Cognos 10 BI content store database. 

Password, Confirm Password Password of the CBI user in the Cognos 10 BI content store 
database.  
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7 Click Next.  

The Custom Authentication Provider Configuration Information page appears. 

8 Enter the following values. 
 

Field Description 
Database server Fully qualified domain name of the user that contains the 

TRIAL_URLS table. 

Port Port number for communicating with the database server. 

SID SID for communicating with the database server. 

User Name The name of the PFCAPAdmin user.. 

Password, Confirm Password Password of the CBI user in the Cognos 10 BI content store 
database.  

 

9 Click Next.  

The LDAP Configuration Information page appears. 

10 Enter the following values. 
 

Field Description 
LDAP Server Fully qualified domain name of the server where Oracle 

Directory Server is installed. 

LDAP Port Port number used to communicate with the LDAP server. 

Administrator DN Distinguished Name of the administrator of the server. Use the 
format and values shown beneath the field. 

Note: The Administrator DN value corresponds to an LDAP 
user who has READ and SEARCH access to the Base 
Distinguished Name (BDN). The BDN specifies the top level 
or root of the directory structure, which is the starting place 
for searches. 

Password, Confirm Password Password of the administrator. 

Parent Node DN 

(Base Distinguished Name) 

Distinguished name of the Parent Node. Use the format 
shown beneath the field. Do not enter a space between after 
the comma between the parts of the domain. 

Note: The Parent Node DN is also known as the Base 
Distinguished Name (BDN). The BDN specifies the top level 
or root of the directory structure, which is the starting place 
for searches. 

Cognos Admin OU Location of the Cognos Admin organizational unit. 
 

11 Click Next.  

The CRN Web Server (gateway or IIS server) page appears. 
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12 Type the fully qualified domain name of the Cognos 10 BI Gateway server. 

13 Click Next.  

If the server has not yet been installed, the installation script asks if it should continue using the 
server name provided. If so, click OK.  

The Ready to Install the Program page appears. 

14 Click Install.  

The Setup Status page appears.  

The program copies the necessary files and creates the CRNSetup.xml file in an InForm 
subfolder under the Cognos installation (...\InForm\Config). The name and location of the file 
appear in a message window. You need the CRNSetup.xml file to run the Cognos 10 BI 
Gateway Customization for InForm wizard. 

15 The Wizard Complete page appears. 

16 Click Finish. 
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Changing or creating a new MotioCAP_informcap.properties file 
The Cognos 10 BI Customization for InForm wizard also creates the 
MotioCAP_informcap.properties file. The information in the file is used to configure the custom 
authentication provider’s connection to Oracle Directory Server (LDAP). 

Note: In most cases you do not need to change the MotioCAP_informcap.properties file. If you 
make modifications restart the Cognos Content Manager. 

 

Circumstances that 
require changes to file 

Required action 

LDAP configuration 
changes after installation. 

LDAP properties used for authenticating the admin OU: 

Enter the URL of the server where LDAP is installed. Change the 
number of the LDAP port if necessary. 

Example: ldap.url=ldap://app02.example.com:389 

Enter the Parent Node Distinguished Name. 

Example: ldap.base.dn=dc=example,dc=com 

Enter the Administrator Distinguished Name. This user name is 
used by the Custom Security Provider (CSP) to log on to LDAP.  

Example: ldap.bindUser.dn=uid=admin,ou=Administrators, 
ou=TopologyManagement,o=NetscapeRoot 

Change encrypted to unencrypted and set the password in plain 
text. The password is encrypted when Cognos Reporting starts up. 

Example: ldap.bindUser.password=unencrypted:password 

The database user and/or 
database user password 
changes after installation. 

Note: This database user is 
the owner of the trial_urls 
table. 

Note: These will be encrypted when Cognos Reporting starts up. 

db.user=encrypted:<db_username> 

db.password=encrypted:<db_user_password> 
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Running the Cognos 10 BI Gateway Customization for InForm wizard 
The Cognos Gateway Customization for InForm wizard configures the Cognos 10 BI Gateway 
services component to work with the InForm application.  

Note: You run this wizard to configure a public gateway to be used with the Reporting and 
Analysis module, or to configure a private gateway with restricted access to the Cognos 10 
Business Intelligence software. 

1 Copy the CRNGatewayConfig folder from the InForm installation image to a location that you 
can access from the Cognos Gateway Server. 

2 On the Cognos Gateway Server, run the CRNGatewayConfig\setup.exe program file. 

The Cognos 10 BI Welcome Screen appears.  

3 Click Next. 

The Cognos 10 BI Installation Location page appears. 

4 Specify the path to the location of the Cognos 10 BI software, and click Next. 

The Setup Type page appears. 

5 Do one of the following, and click Next. 

• Select Public Gateway to set up a gateway to manage communication between the InForm 
application and the Reporting and Analysis module. 

• Select Private Gateway (Admin Only) to perform administrative functions on the Cognos 10 
Business Intelligence software. 

For more information, Complete the Cognos Private Gateway configuration (on page 
106). 

Note: Access to a Private Gateway server should be restricted to a limited group of 
users who need to administer the Cognos 10 Business Intelligence software. 

The Ready to Install the Program page appears. 

6 Click Install.  

The Setup Status page appears. 

The program installs, and the World Wide Web Publishing Service restarts. 

The Wizard Complete page appears. 

7 Click Finish. 
 

Complete the Cognos Private Gateway configuration 
1 Edit the index.html and default.htm files located in the 

<Cognos_Installation_Directory>\webcontent folder on the Private Gateway server. 

• Replace all occurrences of congnos.cgi with cognosisapi.dll and save the files. 

2 Restart IIS. 
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Running the InForm Reporting Addition wizard 
The InForm Reporting and Analysis Addition wizard copies reporting-specific files that are not 
distributed to the InForm software installation. 

Perform this procedure on the InForm Application server. 

1 Copy the CRNUpdate folder from the InForm installation image to the InForm application 
server. 

2 Run the InFormCRNUpdate\setup.exe program file. 

The InForm Reporting and Analysis Addition window appears. 

3 Click Next on each window of the wizard until the Ready for Install window appears. 

4 Click Install.  

The installation starts. 

5 Click Finish when the installation is complete.  

Note: After installation of InForm Reporting and Analysis Addition on the InForm application 
server, restart the InForm service. If this is not done, an authentication error will occur when 
accessing the Reporting and Analysis module from within a trial. 

 

Running the InForm ReportingDB wizard 
The InForm ReportingDB wizard copies several scripts to a location you specify. You later use these 
scripts to create and configure the reporting database schema for the trial you are setting up.  

When you run the ReportingDB wizard, the destination location you specify must already exist.  

1 Run the \ReportingDB\setup.exe program file. 

The InForm Reporting Database Scripts window appears. 

2 Click Next. 

The Choose Destination window appears.  

3 Accept the default location, or click Change and select a different location to put the scripts.  

4 Click Next. 

The Ready for Install window appears. 

5 Click Install. 

The installation starts. 

6 When the installation is complete, click Finish. 

7 Repeat the procedure for each trial you are setting up. 
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Creating the PFWD LDAP namespace on the Cognos 10 BI 
server 

Run this procedure each time you run the InForm CRN wizard. 

1 On the server where Cognos 10 BI is installed, select Start > All Programs > Cognos 10 BI > Cognos 
Configuration. 

The Cognos Configuration window appears. 

2 In the Security tree, right-click Authentication, and select New resource > Namespace. 

The New Resource - Namespace dialog box appears. 

3 Enter the following values: 

• Name—PFWD (all uppercase) 

• Type—LDAP 

4 Click OK.  

5 Complete the parameters as follows: 

• Namespace ID—PFWD 

• Host and Port—<fullyqualifiedmachinename>: <LDAPServerPort>  

(example port number: 389) 

• Base distinguished name—Domain name for your environment. Example: If the 
network domain is example.com, ou=PFWD,dc=example,dc=com 

Note: Do not enter spaces after the commas between the parts of the domain. 

• User lookup—(uid=${userID}) 

6 Select File > Save. 

The Cognos Configuration utility validates the settings and saves the configuration. 

7 When the checks are complete (all items are marked with a green check mark), click Close. 

8 Click Close, and close the Cognos Configuration utility window. 
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Configuring Cognos 10 BI to use HTTPS in the Cognos 
Configuration utility 

1 Connect to Cognos Gateway server. 

2 Navigate to the Windows Start menu. 

3 Select All Programs > IBM Cognos 10_64 > Cognos Configuration.  

4 After the Cognos Configuration utility is completely loaded, select Portal Services and set Web 
Content UrI to HTTPS using the following format: 

https://<servername>.<domainname>:<portnumber>/COGNOS10 
 

Note: Be sure to change the port number to the port for HTTPS. 

For example: 
https://www.example.com:443/cognos10 

 
5 Select Environment and set Gateway URI entry. 

https://<servername>.<domainname>:<portnumber>/cognos10/cgi-
bin/cognosisapi.dll 

 

Note: Be sure to change the port number to the port for HTTPS. 

For example:  
https://www.example.com:443/cognos10/cgi-bin/cognosisapi.dll 

 
6 Select File > Save. 

The Cognos Configuration utility validates the settings and saves the configuration. 

7 When the checks are complete (all items are marked with a green check mark), click Close. 

8 Select Actions > Start. 

The Cognos Configuration utility registers and starts the Cognos 10 BI Service. 

9 Click Close. 
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Updating registry settings 

Updating the AuthenticationFilter DomainSuffix registry key 
If you are installing Cognos Reporting, you must update the DomainSuffix entry for the Oracle 
AuthenticationFilter registry key if any of the following is true on the InForm trial machine and the 
Cognos 10 BI Gateway Services machine. 

• You use proxy servers for the Cognos 10 BI Gateway Services machine and the InForm trial 
server. 

• The fully qualified domain name (FQDN) for either server does not end with a common domain 
suffix. The FQDN is registered in the Oracle AuthenticationFilter DomainSuffix entry during 
installation of the InForm server and the Cognos 10 BI Gateway Services software. If the 
FQDN for both installations ends in a common domain suffix such as .net, .com, .org, .edu, or 
.gov (with or without country name like .uk or .au), you do not need to update the DomainSuffix 
entry unless you use proxy servers. 

• If the FQDN has just two levels. (For example: <servername>.com.) 

Perform the DomainSuffix configuration on both the Cognos 10 BI Gateway Services machine and 
the InForm trial server. Both machines must have identical AuthenticationFilter entries for 
DomainSuffix. 

1 In the Windows Registry Editor, navigate to the following Windows Registry key: 
MyComputer\HKEY_LOCAL_MACHINE\SOFTWARE\Phase Forward\AuthenticationFilter 
 

2 Update the entry for DomainSuffix. 

a Right-click the entry, and select Modify. 

The Edit String dialog box appears. 

b Enter the new value in the Value Data field. Edit the entry: 

• If you use proxy servers, or if the fully qualified domain name for either server does not 
end with a common domain suffix, remove every part of the domain suffix that is not 
identical on both computers. For example, if the FQDN includes 
<servername>.<companyname>.co.uk, after the edit, the entry would be 
<companyname>.co.uk. 

c Click OK. 

3 Exit the Windows Registry Editor. 

4 Restart IIS.  

5 On the InForm server, restart the InForm Service. 
 



 Installation and Configuration Guide  

InForm 4.6.5 111 

Updating the ExternalLoginURL and ExternalLoginFailureURL registry key 
entries on the Cognos 10 BI servers 

On each Cognos 10 BI server, update the ExternalLoginURL and ExternalLoginFailureURL entries 
for the Oracle AuthenticationFilter registry key. 

1 In the Windows Registry Editor, navigate to the following Windows Registry key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Phase Forward\AuthenticationFilter 
 

2 Update the entries for ExternalLoginURL: 

a Right-click the entry and select Modify. 

The Edit String dialog box appears. 

b Specify the URL to configure for HTTPS. 

https://<servername>.<domainname>:<portnumber>/PFExternalLogin/ExternalLoginFramese
t.html 

For example: 

https://www.sample.com:443/PFExternalLogin/ExternalLoginFrameset.html 

c Enter the new value in the Value Data field and click OK.  

3 Update the entries for ExternalLoginFailureURL: 

a Right-click the entry and select Modify. 

The Edit String dialog box appears. 

b Specify the URL to configure for HTTPS. 

https://<servername>.<domainname>:<portnumber>/PFExternalLogin/ExternalLoginEscape.h
tml 

For example: 

https://www.sample.com:443/PFExternalLogin/ExternalLoginEscape.html 

c Enter the new value in the Value Data field and click OK.  

4 Exit the Windows Registry Editor. 

5 Restart IIS. 
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Update the domain settings for Cognos-generated cookies 
1 On the server where Cognos 10 BI is installed, select Start > All Programs > IBM Cognos 10 > 

Cognos Configuration. 

The Cognos Configuration window appears. 

2 Select Actions > Edit Global Configuration. 

The Global Configuration window appears. 

3 Select the General Tab. 

4 Edit the Cookie Settings > Domain value to match the value in the DomainSuffix value in the 
HHKEY_LOCAL_MACHINE\Software\PhaseForward\AuthenticationFilter 
DomainSuffix registry key. 

For example, if the DomainSuffix value is mycompany.com, enter .mycompany.com for the 
Domain value. 

Note: You must change the Domain settings in the Cognos Configuration utility whenever the 
AuthenticationFilter DomainSuffix registry setting is changed. 
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Enabling communication among distributed Cognos 10 BI 
software components 

If you install one or more Application Tier Components on a separate server, to insure that they can 
communicate with other Cognos 10 BI reporting components: 

• Configure cryptographic properties. 

• Specify all Content Manager URIs. 

• Specify the Dispatcher URIs. 

• Specify the Dispatcher URI for external applications. 

• In a multiserver environment, on a server where Application Tier Components are installed but 
the Content Manager component is not installed, configure that server's Notification Store 
property to point to the Content Store database. This is described in the online Help notes in the 
Cognos Configuration utility. 

For more information, see the Cognos 10 BI documentation. 
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Customizing Cognos 10 BI email settings 
The Cognos 10 BI installation sets up a feature that you can use to send links to report output using 
email. By default, the report links point to the server where the Cognos 10 Business Intelligence 
Gateway services are installed (the Gateway server).  

If your environment is configured with an F5 switch, and you must use the generic URL to the 
switch, instead of pointing to the Gateway server, you must configure the SMTP mail server, using 
the Cognos Configuration utility. 

1 Using the Cognos Configuration utility, configure the SMTP mail server. 

For more information, see the Cognos 10 BI Reporting Quick Start Installation and Configuration Guide, 
Chapter 2. 

2 Select File > Save. 

The Cognos Configuration utility validates the settings and saves the configuration. 

3 When the checks are complete (all items are marked with a green check mark), click Close. 

4 Select Actions > Start. 

The Cognos Configuration utility registers and starts the Cognos 10 BI Service. 

5 Click Close, and close the Cognos Configuration utility window. 
 



 Installation and Configuration Guide  

InForm 4.6.5 115 

Starting the Cognos 10 BI servers 
After completing the Cognos 10 BI installation and configuration steps, you can start the Cognos 10 
BI servers. If you have distributed Cognos 10 BI application tier components across multiple servers, 
see the Cognos Installation & Configuration Guide for the specific order for starting the servers. 

1 On the server where the Cognos 10 BI service is installed, select Start > All Programs > IBM Cognos 
10 > Cognos Configuration. 

The Cognos Configuration utility starts. 

2 Select Local Configuration > Data Access > Content Manager > CS. 

The CS - Database - Resources panel appears. 

3 Edit the User ID and Password field for the owner of the content store. 

4 Save the configuration. 

5 Select Actions > Start. 

6 When the server is started, close the Cognos Configuration utility. 
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Configuring settings for CSV report output 
The Reporting and Analysis module provides settings that allow you to use CSV report output files 
with applications such as the Excel spreadsheet application. Apply these settings to your 
environments: 

• Delimiter—Comma-delimited files are widely accepted for use with several applications. 

• Encoding—Using UTF-8 character encoding allows you to use your CSV output with a wide 
range of applications. 

• Terminator—Using carriage return and line feed (CRLF) terminators ensures that the report 
output is properly organized into columns and rows. 

Note: You must have server administration rights to modify these settings. 

 

Configuring the CSV settings for reports 
1 Use the Private Gateway to log into the Cognos application. 

2 Click Launch > Reporting Administration. 

The Administration page appears. 

By default, the Status tab is selected. 

3 In the pane on the left, click System. 

4 In the Scorecard section, click the server name. 

The full URL for the server appears below the server name. 

5 Click the full URL for the server. 

The available services for the server appear. 

6 Select Report Service > Set Properties. 

The Set properties - ReportService dialog box appears. 

7 Select the Settings tab. 

8 In the Category drop-down list, select Environment. 

9 In the Environment category, in the Advanced settings row, click Edit. 

The Set advanced settings dialog box appears. 

10 Select the Override the settings acquired from the parent entry checkbox. 
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11 Type the following parameters and values: 
 

Parameter Value Description 
RSVP.CSV.DELIMITER , Separates each data item in the report output with 

a comma. 

RSVP.CSV.ENCODING UTF-8 Specifies UTF-8 character encoding for report 
data. 

RSVP.CSV.TERMINATOR CRLF Separates each row of data with a carriage return 
and line feed, so that the rows appear in ordered 
columns. 

 

12 Select the checkbox next to each parameter. 

13 Click OK. 

The Set properties - ReportService page appears. 

14 Click OK. 
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Disable the indexed search option on the Reporting Server 
Because the indexed search functionality is not available in the Reporting and Analysis module, you 
should make the following adjustment to the user interface to hide the option: 

Note: If you have distributed Cognos 10 BI application tier components across multiple servers, 
perform this procedure on each presentation server. 

1 Select Launch > Reporting Administration. 

The Administration page appears. 

2 Click the Configuration tab. 

3 Click Dispatchers and Services. 

A list of the dispatchers that are registered with the Content Manager appears. 

4 Select the PresentationService entry. 

5 In the Actions column, click the Set Properties icon ( ). 

6 Click the Settings tab 

7 Select the Environment entry (Advanced settings), and click Edit. 

8 Select Override the settings acquired from the parent entry, and do the following: 

• Enter portal.disableindexsearch in the Parameter column. 

• Enter true in the Value column. 

9 Click OK. 
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Enabling Authors group permissions 
By default, the Authors group is restricted from including HTML items and user-defined SQL in 
reports. If you are licensed to develop Report Studio reports in a self-hosted environment, you can 
modify these restrictions in the Cognos Administration module: 

• Enable the Execute and Traverse permissions for the Authors group for the following Report 
Studio capabilities: 

• User Defined SQL 

• HTML Items in Report 
 

Allowing support for restricted report elements 
You may need to give a support user the ability to troubleshoot Report Studio reports that contain 
either restricted element. 

For a user to troubleshoot reports containing custom HTML or SQL, the user must: 

• Be a Support user type. 

• Be a member of the following Reporting Groups: 

• Directory Administrators 

• Ad Hoc Users 

• Sponsor Users 

• Not be a member of the Authors Reporting group. 
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Comparing configuration scenarios 
There are three major differences between installing the trial and reporting data into the same 
database and installing them into separate databases: 

 

Single database (development) Separate databases (production) 
Oracle Streams is not required. Oracle Streams is required. 

The trial schema owner owns all trial and 
reporting objects. 

Separate schema owners own trial or reporting 
objects (and each schema is in a separate 
instance). 

Running in archive log mode is not required. Running in archive log mode is required. 
 

When you install the Reporting and Analysis module into a different database from the trial, data is 
replicated using Oracle Streams. It is strongly recommended that you review the list of Oracle 
Streams Recommended References. These documents provide detail on Streams, Streams operations, 
and Streams monitoring. 
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Creating the InForm reporting database 
You can create the InForm trial and reporting databases using either of the following configurations: 

• Both databases in one instance in a development environment. For more information, see 
Creating the trial and reporting databases in the same instance (on page 123). 

• Each database in a separate instance in a production environment. For more information, see 
Creating the trial and reporting databases in separate instances (on page 129). 

 

Creating the trial and reporting databases in the same instance 
You can install the reporting schema and the InForm trial schema in the same database instance to 
support a trial development (single-user) environment. 

Note: When the trial and reporting schemas are in the same database instance/schema, there is 
no need to replicate trial data (Oracle Streams are not used) and reporting materialized views act 
directly on the trial schema PF tables. 

Multiple reporting and trial combinations may be put in the same trial and reporting database 
instance. 
 

Installing the InForm reporting database in a single database environment 
This checklist provides an overview of the steps that you need to perform in order to install the 
reporting database into the same database that is used for the InForm trial. 

1 Review the InForm reporting hardware and software requirements (on page 124) for 
installing reporting into the same database. 

2 Review the InForm reporting database architecture rules (on page 124). 

3 Extract the InForm reporting software. 

4 Prepare the trial database for InForm reporting (on page 124). 

a Add/modify parameters. 

b Create RPTINSTALL user. 

c Add tablespaces for reporting. 

5 Configure the InForm reporting installation (on page 126). 

a Configure reporting variables. 

b Check the variable settings. 

Note: When trials are started, a process is begun which recalculates the trial's form state. The 
time needed for the recalculation of the form state is proportionate to the size of your trial. For 
trials that are being upgraded to InForm 4.6, be sure the recalc process has completed before 
installing the reporting database. 
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Reviewing the hardware and software requirements for a reporting 
database in a single database environment 

There are minimal hardware requirements for a configuration in which a single database is used for 
both the trial and reporting 

Make sure that there is enough available disk space for the installation by allowing four times the size 
of the trial for reporting.  

For more information, see the hardware and software requirements, in the Release Notes. 
 

Reviewing database architecture rules for a single database environment 
Follow these rules when you install the reporting database into the same database used for the trial: 

• There can be only one reporting environment per trial schema.  

• A single database can hold multiple reporting schemas. 

• The trial and reporting schema cannot be installed in the same database as the Content Store 
database for Cognos 10 Business Intelligence. No other Oracle products, such as CIS or 
Clintrial, should already reside in or be added to the trial and reporting database. 

• The trial and reporting database must use a single-byte character set.  

Note: The Reporting and Analysis module does not support Unicode character sets or 
double-byte character sets in either the reporting or the trial database. For more 
information, see Configuring Oracle Database Software (on page 18).  

• The InForm trial and reporting database is not required to run in archive log mode. 
 

Preparing the trial database for the Reporting and Analysis module in a 
single database environment 

To prepare the InForm trial database: 

• Grant trial user privileges. 

For more information, see Granting trial user privileges (on page 125). 

• Add or modify trial database parameters. 

For more information, see Adding and modifying trial database parameters in a single 
database environment (on page 23). 

• Add tablespaces to the trial database. 

For more information, see Adding tablespaces to the trial database in a single database 
environment (on page 24) 

• Create the RPINSTALL user. 

For more information, see Creating the RPTINSTALL user for a single database 
environment for trials (on page 125). 
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Granting trial user privileges 

1 Open a Windows command prompt. 

2 Stop the InForm trial using the pfadmin command. 
pfadmin stop trial <trialname> 
 

Note: The trial must not be running while you execute this script. 

3 Login to SQL*Plus with /nolog. 

4 Connect to the trial database as a user with the privilege to grant user database privileges, for 
example SYS. 

5 Type the following at the SQL*Plus prompt: 
@grant_user_privs.sql <trial schema owner> 
 
Where the <trial schema owner> is the database user name that holds the trial schema. 

This script should run to completion without further prompts. The script produces a log called 
grant_user_privs.log. 
 

Creating the RPTINSTALL user for a single database environment for trials 

The rptinstall command creates a dba user named rptinstall.  

To create a new user with DBA privileges in the trial database: 

1 Identify the folder where the Reporting and Analysis database is located. 

2 From a Windows command prompt, set your default to this folder. 

3 Log on to the trial database with a user that has sysdba privileges. Make sure that the connection 
is made with the “as sysdba” clause. 

4 Run this command: 
create user rptinstall identified by rptinstall default tablespace 
<tablespace_name> temporary tablespace <tablespace name> 

 
This command creates a dba user called rptinstall. This account is used only for all install and 
uninstall operations. This account has many privileges, including sysdba privilege. 

The user name must be rptinstall. If it is not, the installation fails. Replace <tablespace_name> 
with a valid tablespace name from the trial database. It is recommended that the SYSTEM 
tablespace not be used for the default tablespace. 

The default tablespace does not require additional room for objects because the rptinstall user 
does not own any objects. 

5 Type the following at the SQL*Plus prompt: 
@grant_dba_privs rptinstall 

 
The rptinstall account is not used for reporting operations and can be locked when not in use. 

The rptinstall account can also be dropped after the installation is finished. However, you must 
recreate it before performing any installation or uninstallation activities. 
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Configuring the Reporting and Analysis installation for a single database 
environment 

To configure the Reporting and Analysis installation: 

• Configure the reporting variables. 

• Check the variable settings. 
 

Configuring the reporting variables for a single database environment 

You must change the configsamedb.sql file. The installation and uninstallation scripts use this file for 
user name, tablespace, and connection information. This file is located in the reporting software 
folder. 

The trial_default_ts variable is used to put all Reporting and Analysis objects into one tablespace. 
The value used for this variable is inherited by the following variables in the default configsamedb.sql 
file: 

• trial_table_ts 

• trial_index_ts 

• rep_mv_ts 

• rep_index_ts 

• rep_mvlog_ts 

To put all Reporting and Analysis objects into one tablespace, specify the value of a tablespace for 
the trial_default_ts variable and leave the five variables listed above defaulted to the trial_default_ts 
value. 

If you want to use separate tablespaces, adjust the value of the five variables accordingly. The 
trial_default_ts value is used as the value for these variables only if the default is left in place. If all 
values for these variables are changed, the trial_default_ts variable is not used during the installation 
and has no effect. 

Tablespace sizing is discussed in Adding tablespaces to the trial database in a single database 
environment (on page 24). 
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There are two sections in the configsamedb.sql script: 

• The first section is for predefined variables, which you should NEVER change. 

• The second section is for user-defined variables, most of which you need to change. 
 

User-defined variable Value Comments 
trialdb_tnsnames_alias Tnsnames alias for the trial 

database. 
Used for connection to the trial 
database. Also used as a part of 
the PUBLIC database link. 

trialdbstring @&&trialdb_tnsnames_ali
as 

Preset variable. Do not change. 

Used for connection to the trial 
database. 

trial_schema_owner InForm trial schema 
owner. 

Oracle user name of the trial 
schema owner in the trial 
database. 

trial_default_ts Existing InForm tablespace 
or a new one that has been 
created. 

See comments above for usage. 

trial_table_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to hold trial schema tables 
that are required for reporting. 
See comments above for usage. 

trial_index_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to hold trial schema indexes 
that are required for reporting. 
See comments above for usage. 

trial_temp_ts Name of the trial 
temporary tablespace. 

Temporary tablespace in the trial 
database. 

dbauser_trial_password Password for 
RPTINSTALL. 

Assigned when the rptinstall user 
is created. For more information, 
see Creating the 
RPTINSTALL user for a 
single database environment 
for trials (on page 125). 

trial_schema_owner_password Password for the InForm 
trial schema owner. 

 

rep_mv_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to store the materialized 
views. Also holds materialized 
view logs and indexes that are 
created on the materialized views. 
See comments above for usage. 

rep_index_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to store indexes that are 
created on reporting tables. See 
comments above for usage. 
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User-defined variable Value Comments 
rep_mvlog_ts Existing InForm tablespace 

or a new one that has been 
created. 

Used to store materialized view 
logs that are created on reporting 
tables. See comments above for 
usage. 

 
 

 

Checking the variable settings for a single database environment 

Oracle provides a script called configandchecksamedb.sql to check the variable settings. The 
installation calls this same script to check the environment and variables before the installation. 

Run the script manually, fix any error it finds, and run the script again. You can rerun the script as 
many times as necessary until it completes without errors. 

1 Open a Windows command prompt. 

2 Stop the InForm trial using the pfadmin command: 
pfadmin stop trial <trialname> 

 

Note: The trial must not be running while you execute this script. 

3 Identify the folder where the reporting software is located, and set your default to this folder. 

Log on to SQL*Plus with /nolog. 

4 Type the following at the SQL*Plus prompt: 
@configandchecksamedb 
 

If the script finds an error, fix the error and run the script again 

If this script passes with no errors, the variables are correct. 

Note: Do not proceed with the installation if there are errors that need to be resolved. 
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Creating the trial and reporting databases in separate instances 
You can install the reporting schema in a separate database instance from the InForm trial schema to 
support a trial production (multi-user) environment. 

Note: When the trial and reporting schemas are in separate database instances/schemas, it is 
necessary to replicate trial data (Oracle Streams are used) in reporting materialized views. 

 

Database architecture rules in a multiple database environment 
Follow these rules when installing the reporting database into the a separate database from the one 
used for the trial: 

• You must install the Reporting and Analysis environment (reporting schema) in a database that is 
different from the one that holds the trial. 

• The reporting schema Oracle user name in the reporting database must be the same name as the 
trial schema Oracle user name in the trial database. Because the users are in different databases, 
the user names may have different passwords. 

• There can be only one reporting environment per trial schema.  

• A single reporting database can hold multiple reporting schemas. The trial schemas that are 
associated with these reporting schemas might exist in the same or different trial databases. 

• The reporting schema cannot be installed in the same database as Cognos 10 Business 
Intelligence and cannot be put into the same database as the trial. No other Oracle products 
should already reside in or be added to the reporting database. 

• The reporting database must be created using a single-byte character set. The trial database must 
use a single-byte character set.  

Note: The Reporting and Analysis module does not support Unicode character sets or double-byte 
character sets in either the reporting or the trial database. For more information, see Configuring 
Oracle Database Software (on page 18). 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm application server. You can also run the scripts from the InForm reporting Oracle 
database home on a Windows Server. Running them from a different Windows Oracle client or 
from a non-Windows Oracle client or database home might work, but is not supported. 

If you are installing reporting in a development environment, see Creating the trial and reporting 
databases in the same instance (on page 123) for instructions. 
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Installing the InForm reporting database in a multiple database 
environment 

1 Review the Reporting and Analysis hardware and software requirements (on page 130) for 
installing reporting into a different database. 

2 Review Reporting and Analysis database architecture rules (on page 129). 

3 Extract the Reporting and Analysis software. 

4 Prepare the trial database for Reporting and Analysis (on page 136). 

a Add/modify parameters. 

b Add tablespaces for reporting. 

c Create RPTINSTALL user. 

d Verify ARCHIVELOG mode. 

5 Create an InForm reporting database (on page 131). 

a Configure required database parameters. 

b Create tablespaces for reporting. 

c Create RPTINSTALL user. 

d Setup communication between the trial and reporting databases. 

6 Configure the Reporting and Analysis installation. 

a Configure reporting variables. 

b Check the variable settings. 
 

Reviewing the hardware and software requirements for a reporting 
database in a multiple database environment 

The hardware requirements for the Reporting and Analysis module are the same as the requirements 
for an InForm trial production database server or development database server. 

For more information, see the hardware and software requirements in the Release Notes. 
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Creating an InForm reporting database in a multiple database environment 
You must complete the following tasks in order to create a separate InForm reporting database: 

• Configure the required database parameters. 

For more information, see Adding and modifying trial database parameters in a multiple 
database environment (on page 26). 

• Create tablespaces for reporting. 

For more information, see Adding tablespaces to the trial database in a multiple database 
environment (on page 28). 

• Create the rptinstall users. 

For more information, see Creating the RPTINSTALL user in a multiple database 
environment for reports (on page 135). 

• Set up communication between the trial and reporting databases. 

For more information, see Setting up communication between the trial and reporting 
databases in a multiple database environment (on page 141). 

• Verify Archivelog mode. 

For more information, see Verifying Archivelog mode in the trial database in a multiple 
database environment (on page 141). 

 

Configuring required reporting database parameters in a multiple database 
environment 

The database parameters listed below are required for the Reporting and Analysis installation.  
 

Parameter Value Notes 
db_block_size 16384 If the database will be used for 

reporting set this to 16384. 

db_files 250 Controls the number of operating 
system files the database will manage.  

In large installations this parameter 
may need to be set higher. 

Changes to this parameter requires 
cycling the database forcing 
application down time. 

deferred_segment_creation FALSE Required due to limitations of 
import/export. 

processes 500  

open_cursors 300 Monitor this parameter to make sure 
the value is appropriate to the number 
of users. A parameter setting that is 
too low might impact database 
performance. 
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Parameter Value Notes 
session_cached_cursors 300 Monitor this parameter to make sure 

the value is appropriate to the number 
of users. A parameter setting that is 
too low might impact database 
performance. 

global_names TRUE  

streams_pool_size 200M Set if streaming is in use to a separate 
reporting database. 200M is the 
minimum value required. 

memory_target Set to maximum of memory 
available to Oracle. 
Available memory on a 
dedicated server is all 
memory except the amount 
needed for the Operating 
System. 

Setting this parameter instructs Oracle 
to use automatic memory 
management. This is the 
recommended best practice.  

For mega trials, manually allocating 
memory may provide better 
performance. 

sga_target Only use this parameter for 
mega trials. 

Set to a portion of 
memory_target to ensure a 
minimum allocation for sga. 

Note: Do not allocate more 
than 80% of memory_target 
to sga_target. 

sga_target is only recommended to be 
used on mega trials as a minimum 
memory setting in combination with 
memory_target. 

In general it is recommended to use 
memory_target alone. 

workarea_size_policy auto  

_job_queue_interval 1 Set if streaming is in use for a separate 
reporting database. 

log_archive_dest Defaults to 
$ORACLE_HOME/dbs 
InForm recommends this be 
changed to 
$ORADATA/ARCHIVE 

The placement of archive logs is 
determined by available disk space on 
the server.  

It is recommended the default value 
for this parameter not be used to 
facilitate database maintenance. 
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Oracle recommends that you review the parameters below, which are not mandatory for the 
reporting installation. 

 

Parameter Review recommendation 
sessions For more information, see the Oracle Streams Recommended Configuration 

document on Metalink (reference below). 

undo_retention 900 (minimum value) For more information, see the Oracle Streams 
Recommended Configuration document on Metalink (reference below). 

 

For more information, see Oracle Streams Recommendations document. 
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Creating the reporting tablespaces in a multiple database environment 

Tablespaces need to be created to hold Reporting and Analysis objects.  

• STRMADMIN_TS is the only tablespace that is required for Reporting and Analysis installation.  

Use the following syntax: 
CREATE TABLESPACE <tsname> 
DATAFILE ‘blah’ SIZE (see table below) 
AUTOEXTEND ON NEXT (see table below) 
EXTENT MANAGEMENT LOCAL AUTOALLOCATE; 
 

• The SYSAUX tablespace is used to store LOGMNR objects by default in the Oracle database. No 
tablespace needs to be created for Logminer objects. 

• The UNDO tablespace size and growth will be influenced by the UNDO_RETENTION database 
parameter setting and Streams needs in addition to normal InForm reporting operations.  

• For more information about Streams, see the Oracle 10.2 Streams Recommendations document - 
Note: 418755.1. 

• For more information about the UNDO_RETENTION parameter and UNDO tablespace, see the 
Oracle Database Administrator's Guide. 

Note: If the optional tablespaces that are listed in the following table are not created, space must 
be available in existing tablespaces. 

 

 

Tablespace 
name 

Initial 
size/autoext
end size 
needed 

 

File extent 
size/file 
maximum size 

 
 

Required 

 
 

Comments 

STRMADMIN_
TS 

25M Make the initial size 
25 megabytes, set 
AUTOEXTEND 
on and set 
MAXSIZE to 
UNLIMITED. 

Yes The name STRMADMIN_TS 
is required for this tablespace. 
This tablespace is used to hold 
spillover from streams queues 
into streams_queue_tables. 
Streams queue tables reside in 
this tablespace.  

Size recommendation is taken 
from the Streams Recommended 
Configuration note mentioned 
above. 

Chosen by 
customer – see 
comments 

Three times 
the size of the 
trial  

Chosen by 
customer. The size 
of the materialized 
views grows as the 
data in the trial 
grows. 

Optional Stores the materialized views. 
Also holds materialized view 
logs and indexes that are 
created on the materialized 
views. Corresponds to the 
variable rep_mv_ts in the 
Configdiffdb.sql file. 
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Tablespace 
name 

Initial 
size/autoext
end size 
needed 

 

File extent 
size/file 
maximum size 

 
 

Required 

 
 

Comments 

Chosen by 
customer – see 
comments 

One-half the 
size of the 
trial 

Chosen by 
customer. The size 
of the indexes 
grows as the trial 
indexes grow. 

Optional Used to store indexes that are 
created on reporting tables. 
Corresponds to the variable 
rep_index_ts in the 
Configdiffdb.sql file. 

Chosen by 
customer – see 
comments 

25M Chosen by 
customer. 

Optional Used to store materialized view 
logs that are created on 
reporting tables. Corresponds 
to the variable rep_mvlog_ts in 
the Configdiffdb.sql file. 

Chosen by 
customer – see 
comments 

Size of the 
trial 

Chosen by 
customer. The size 
of the reporting 
base tables grows 
as the trial tables 
grow. 

Optional Used to store reporting tables. 
Corresponds to the variable 
rep_table_ts in the 
Configdiffdb.sql file. 

 
 

Creating the RPTINSTALL user in a multiple database environment for reports 

To create a new user with DBA privileges in the report database: 

1 Identify the folder where the Reporting and Analysis database is located. 

2 From a Windows command prompt, set your default to this folder. 

3 Log on to the report database with a user that has sysdba privileges. Make sure that the 
connection is made with the “as sysdba” clause. 

4 Run this command: 
create user rptinstall identified by rptinstall default tablespace 
<tablespace_name> temporary tablespace <tablespace name> 

 
This command creates a dba user called rptinstall. This account is used only for all install and 
uninstall operations. This account has many privileges, including sysdba privilege. 

The user name must be rptinstall. If it is not, the installation fails. Replace <tablespace_name> 
with a valid tablespace name from the trial database. It is recommended that the SYSTEM 
tablespace not be used for the default tablespace. 

The default tablespace does not require additional room for objects because the rptinstall user 
does not own any objects. 

5 Type the following at the SQL*Plus prompt: 
@grant_dba_privs rptinstall 

 
The rptinstall account is not used for reporting operations and can be locked when not in use. 

6 The rptinstall account can also be dropped after the installation is finished. However, you must 
recreate it before performing any installation or uninstallation activities. 



Chapter 10  Installing and configuring the Reporting and Analysis module in a trial  
 

136 InForm 4.6.5 

 

Preparing the trial database for Reporting and Analysis in a multiple database 
environment 

To prepare the InForm trial database: 

• Grant trial user privileges. 

For more information, see Granting trial user privileges (on page 125). 

• Create the rptinstall user. 

For more information, see Creating the rptinstall user in a multiple database environment 
for trials (on page 137). 

• Configure reporting variables. 

For more information, see Configuring reporting variables in a multiple database 
environment (on page 138). 

• Check the variable settings. 

For more information, see Checking the variable settings in a multiple database 
environment (on page 141). 

 

Granting trial user privileges 
1 Open a Windows command prompt. 

2 Stop the InForm trial using the pfadmin command. 
pfadmin stop trial <trialname> 
 

Note: The trial must not be running while you execute this script. 

3 Login to SQL*Plus with /nolog. 

4 Connect to the trial database as a user with the privilege to grant user database privileges, for 
example SYS. 

5 Type the following at the SQL*Plus prompt: 
@grant_user_privs.sql <trial schema owner> 
 
Where the <trial schema owner> is the database user name that holds the trial schema. 

This script should run to completion without further prompts. The script produces a log called 
grant_user_privs.log. 
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Creating the RPTINSTALL user in a multiple database environment for trials 
To create a new user with DBA privileges in the trial database: 

1 Identify the folder where the Reporting and Analysis database is located. 

2 From a Windows command prompt, set your default to this folder. 

3 Log on to the trial database with a user that has SYSDBA privileges. Make sure that the 
connection is made with the “AS SYSDBA” clause. 

4 Run this command: 
create user rptinstall identified by rptinstall default tablespace 
<tablespace_name> temporary tablespace <tablespace name> 

 
This command creates a dba user called rptinstall. This account is used only for all install and 
uninstall operations. This account has many privileges, including sysdba privilege. 

The user name must be rptinstall. If it is not, the installation fails. Replace <tablespace_name> 
with a valid tablespace name from the trial database. It is recommended that the SYSTEM 
tablespace not be used for the default tablespace. 

The default tablespace does not require additional room for objects because the rptinstall user 
does not own any objects. 

5 Type the following at the SQL*Plus prompt: 
@grant_dba_privs rptinstall 

 
The rptinstall account is not used for reporting operations and can be locked when not in use. 

The rptinstall account can also be dropped after the installation is finished. However, you must 
recreate it before performing any installation or uninstallation activities. 
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Configuring reporting variables in a multiple database environment 
To configure the reporting installation to store objects in separate tablespaces, change the 
CONFIGDIFFDB.SQL script. This file is used by the installation and uninstallation scripts for user 
name, password, tablespace, and database link and connection information. This file is located in the 
reporting software folder. 

There are two sections in this file: 

• The Predefined variables, which you should NEVER change. 

• The user-defined variables (see below), most of which you should change. 
 

User-defined variable Value Comments 

trialdb_tnsnames_alias Tnsnames alias for the trial 
database. 

Used for connection to the trial 
database. Also used as a part of 
the PUBLIC database link. 

trialdbstring @&&trialdb_tnsnames_alias Preset variable. Do not change. 

Used for connection to the trial 
database. 

trial_schema_owner InForm trial schema owner. Oracle user name of the trial 
schema owner in the trial 
database. 

rep_proxy_user New user. Prepend RP to the 
InForm trial schema owner. 

Oracle user name in the trial 
database that serves as a proxy 
user for reporting database 
connections. 

trial_table_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to hold trial schema tables 
that are required for reporting. See 
comments above for usage. 

trial_index_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to hold trial schema indexes 
that are required for reporting. See 
comments above for usage. 

trial_temp_ts Name of the trial temporary 
tablespace. 

Temporary tablespace in the trial 
database. 

trial_to_rep_dblink_name Global name of the reporting 
database. 

Connect to the reporting database 
and run the command Select 
global_name from 
global_name. Use the value 
returned from this command for 
this variable. Name of all database 
links in the trial database. 

trial_dblink_name_select @&&trial_to_rep_dblink_na
me 

Preset variable. Do not change. 
Used for connection to remote 
objects in the reporting database. 
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User-defined variable Value Comments 

dbauser_trial_password Password for 
RPTINSTALL. 

Assigned when the rptinstall user 
is created. For more information, 
see Creating the rptinstall user 
in a multiple database 
environment for trials (on page 
137). 

trial_schema_owner_password Password for the InForm 
trial schema owner. 

 

rep_proxy_user_password Password for the user 
created in the 
“REP_PROXY_USER” 
variable. 

Proxy user is a trial user name 
created to act as the proxy user for 
the reporting user.  

streams_admin_user_trial_pwd Password for the 
STRMADMIN user. 

STRMADMIN is a new user in the 
trial database created for Streams, 
which will be created during 
reporting setup. 

streams_proxy_user_password Password for the 
RPSTRMADMIN user. 

RPSTRMADMIN is a proxy user 
created for the STRMADMIN 
account in the reporting database. 

repdb_tnsnames_alias Tnsnames alias for the 
reporting database. 

Used for connection to the 
reporting database. Also used as a 
part of the PUBLIC database link. 

repdbstring @&&repdb_tnsnames_alias Preset variable. Do not change. 

Used for connection to the 
reporting database. 

rep_schema_owner &&trial_schema_owner Preset variable. Do not change. 

rep_table_ts Existing InForm software 
tablespace or new one that 
was created earlier (on page 
134). 

Used to store reporting tables. 

rep_mv_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to store the materialized 
views. Also holds materialized 
view logs and indexes that are 
created on the materialized views. 
See comments above for usage. 

rep_index_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to store indexes that are 
created on reporting tables. See 
comments above for usage. 
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User-defined variable Value Comments 

rep_mvlog_ts Existing InForm tablespace 
or a new one that has been 
created. 

Used to store materialized view 
logs that are created on reporting 
tables. See comments above for 
usage. 

 

rep_temp_ts Name of the reporting db 
temporary tablespace. 

Temporary tablespace in the 
report database. 

rep_to_trial_dblink_name Global name of the trial 
database. 

Connect to the trial database and 
run the command: Select 
global_name from 
global_name. Use the value 
returned from this command for 
this variable. Name of all database 
links in the reporting database. 

rep_dblink_name_select @&&rep_to_trial_dblink_na
me 

Preset variable. Do not change. 
Used for connection to remote 
objects in the trial database. 

dbauser_rep_password Password for 
RPTINSTALL. 

Assigned when the rptinstall user 
is created. For more information, 
see Creating the RPTINSTALL 
user in a multiple database 
environment for reports (on 
page 135) 

rep_schema_owner_password Password for the reporting 
schema owner. 

The reporting schema owner must 
have the same name as the trial 
schema owner. 

streams_admin_user_rep_passw
d 

Password for the strmadmin 
user in the reporting 
database instance. 

STRMADMIN is a user in the trial 
database for Streams that will be 
created during reporting setup. 
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Checking the variable settings in a multiple database environment 
Oracle provides a script named configandcheckdiffdb.sql to check the variable settings. The 
installation calls this script to check the environment and variables before the installation. 

Run the script manually, fix any error it finds, and run the script again. You can rerun the script as 
many times as necessary until it completes without errors. 

1 Open a Windows command prompt. 

2 Stop the InForm trial using the pfadmin command: 
pfadmin stop trial <trialname> 

 

Note: The trial must not be running while you execute this script. 

3 Identify the folder where the reporting software is located, and set your default to this folder. 

4 Log on to SQL*Plus with /nolog. 

5 Type the following at the SQL*Plus prompt: 
@configandcheckdiffdb 
 

If the script finds an error, fix the error and run the script again 

If this script passes with no errors, the variables are correct. 

Note: Do not proceed with the installation if there are errors that need to be resolved. 

 

Setting up communication between the trial and reporting databases in a multiple 
database environment 

The InForm trial database and reporting database communicate through database links. Entries into 
the tnsnames.ora file(s) on the trial database and reporting database servers are required. Create two 
tnsnames aliases: 

• On the reporting server to connect to the trial instance on the trial server. 

• On the trial server to connect to the reporting instance on the reporting server. 
 

Verifying Archivelog mode in the trial database in a multiple database environment 

You must run the InForm trial database in archivelog mode. This is a requirement for Oracle 
Streams. To determine if the InForm database is being run in archivelog mode: 

1 Log into a privileged Oracle account, for example, SYS, using SQL*Plus. 

2 Run the following command: 
archive log list 

 
You should see the following values: 

• The database log mode value should be Archive mode. 

• The automatic archival value should be Enabled. 

Note: For more information, see the information about managing archived Redo logs in the 
Oracle Database Administrator's Guide. 
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Installing the Reporting and Analysis module 
You can install the Reporting and Analysis module in either a single-database environment or a 
multiple database environment. 

For more information, see: 

• Installing the Reporting and Analysis module in a single database environment (on page 
142). 

• Installing the Reporting and Analysis module in a multiple database environment (on 
page 144). 

 

Installing the Reporting and Analysis module in a single database environment 
If you are installing reporting in a development environment, Oracle recommends that you install 
reporting in the same database as the trial. If you Install the Reporting and Analysis module in a 
single database environment, you must run the install_reporting_samedb script. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm application server. You can also run the scripts from the InForm reporting Oracle 
database home on a Windows Server. Running them from a different Windows Oracle client or 
from a non-Windows Oracle client or database home might work, but is not supported. 

 

Installing the Reporting and Analysis module in a single database 
Oracle provides a script called install_reporting_samedb for installing the Reporting and Analysis 
module in a single database development environment. 

1 Open a Windows command prompt. 

2 Stop the InForm trial using the pfadmin command: 
pfadmin stop trial <trialname> 

 

Note: The trial must not be running while you execute this script. 

3 Identify the folder where the reporting software is located, and set your default to this folder. 

4 Modify parameters in the configsamedb.sql to reference specific trial information. For more 
information, see Configuring the Reporting and Analysis installation for a single database 
environment (on page 126). 

5 Log on to SQL*Plus with /nolog. 

6 Type the following at the SQL*Plus prompt: 
@configandchecksamedb.sql  

 
7 Type the following at the SQL*Plus prompt: 

@install_reporting_samedb.sql 
 
No log on is required to run this script, because the script uses information provided in the 
configsamedb.sql file to log on. This script should run to completion without prompts. 
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8 After the installation is complete,remove configsamedb.sql and copy it to a secure location for 
future InForm Reporting upgrades and installations. 

You will need this file in the future if you want to uninstall or re-install the Reporting and 
Analysis module. 

9 Start the InForm trial. 

Note: The script produces a log called install_reporting_samedb.log, which contains any installation 
messages. Search the log for the word Error. No errors should be found. 

 

In case of installation failures in a single-database configuration 
Oracle provides a script called deinstall_reporting_samedb to remove all components associated with 
the Reporting and Analysis module for a single trial schema and reporting schema combination. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm application server. You can also run the scripts from the InForm reporting Oracle 
database home on a Windows Server. Running them from a different Windows Oracle client or 
from a non-Windows Oracle client or database home might work, but is not supported. 

This script uses settings in the configsamedb.sql to uninstall the schema. Use the same 
configsamedb.sql file to uninstall as the one you initially used for the installation. 

Note: If the original is not available, set the parameters in configsamedb.sql for the reporting 
schema that you want to remove. 

1 Open a Windows command prompt. 

2 Stop the InForm trial using the pfadmin command: 
pfadmin stop trial <trialname> 

 

Note: The trial must not be running while you execute this script. 

3 Identify the folder where the reporting software is located, and set your default to this folder. 

4 Verify that the configsamedb.sql parameters reference specific trial information. 

5 Log on to SQL*Plus with /nolog. 

6 Type the following at the SQL*Plus prompt: 
@deinstall_reporting_samedb 

 
This script uninstalls the InForm Reporting and Analysis environment for a single trial/reporting 
schema. It does not remove multiple reporting schemas or the underlying reporting 
infrastructure. You can re-run this script if necessary. 

Note: If the error message Reporting deinstallation aborted appears, nothing has been removed. 
This usually indicates a problem with the configsamedb.sql settings. 
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You can run the configandchecksamedb.sql script to make sure everything has been removed. If this 
script completes successfully, the uninstall succeeded. 

Note: This script checks the existence of tablespaces, but the uninstall does not remove 
tablespaces. If the script fails because it cannot find a tablespace, change the tablespace 
variables in configsamedb.sql to an existing tablespace in the database and run the script again. 

 

Installing the Reporting and Analysis module in a multiple database 
environment 

If you are installing reporting in a production environment, Oracle recommends that you install 
reporting in a different database from the trial. If you install the Reporting and Analysis module in a 
multiple database environment, you must run the install_reporting_diffdb script. 

There are two installation options available for InForm reporting into multiple databases. The 
following sections will install reporting in one step but require the trial to be down until the 
installation script has finished. The other installation option is described in Appendix B. This option 
is composed of two scripts, one that needs to be run while the trial is down and one that can be run 
with the trial running. The advantage to this approach is that the trial can be used sooner. To save 
time, this option allows the reporting schema to be created during the installation. 
 

Installing the Reporting and Analysis module in multiple databases 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm application server. You can also run the scripts from the InForm reporting Oracle 
database home on a Windows Server. Running them from a different Windows Oracle client or 
from a non-Windows Oracle client or database home might work, but is not supported. 

Oracle provides a script called install_reporting_diffdb.sql for installing the Reporting and Analysis 
module in a multiple database production environment. 

1 Open a Windows command prompt. 

2 Stop the InForm trial using the pfadmin command: 
pfadmin stop trial <trialname> 

 

Note: The trial must not be running while you execute this script. 

3 Identify the folder where the reporting software is located, and set your default to this folder. 

4 Modify the parameters in the configdiffdb.sql to reference specific trial information (see 
Configuring required reporting database parameters in a multiple database environment 
(on page 131)). 

5 Login to SQL*Plus with /nolog. 

6 Type the following at the SQL*Plus prompt: 
@configandcheckdiffdb.sql  
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7 Type the following at the SQL*Plus prompt: 
@install_reporting_diffdb.sql 

 
This script should run to completion without prompts. The script produces two logs called pre-
install_reportingschema_diffdb.log and install_reportingschema_diffdb.log, which contains any 
installation messages. Search the log for the word Error. No errors should be found. 

8 After the installation is complete, remove configdiffdb.sql and copy it to a secure location for 
future InForm Reporting upgrades and installations. 

You will need this file in the future if you want to uninstall or reinstall InForm Reporting and 
Analysis. 

9 Start the InForm trial. 

10 Oracle strongly recommends that you review Oracle Streams Recommended References.  

These documents provide information about Streams, Streams operations, and Streams 
monitoring. 

 

In case of installation failures in a multiple database environment 
In the event that an installation fails, follow these steps to remove components of the Reporting and 
Analysis module that have already been installed. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm application server. You can also run the scripts from the InForm reporting Oracle 
database home on a Windows Server. Running them from a different Windows Oracle client or 
from a non-Windows Oracle client or database home might work, but is not supported. 

1 Check the install_reporting_diffdb.log that is produced by the install_reporting_diffdb.sql script.  

A section is written to this log to let you know what needs to be performed when you uninstall 
reporting. Search the log for the string end of infrastructure setup. This is surrounded by several 
rows of asterisks (*) above and below it in the log. 

Note: If you do not find the end of infrastructure setup string, skip the next step. 

2 Run the script deinstall_reporting_diffdb.sql. This script uses the configdiffdb.sql file, so make sure 
the correct one is in place. Run this script as many times as necessary. 

a After the script is run, check for any errors by searching for the word Error. Correct any 
problems and run the script again. 

b Rerun the script until it does not find anything to remove and does not find any errors. 

You can run the configandcheckdiffdb.sql script to make sure everything has been removed. If this 
completes successfully, then the uninstall has succeeded. 

Note: This script checks the existence of tablespaces. The uninstall does not remove 
tablespaces. If the script fails to find a tablespace, adjust the tablespace variables in 
configdiffdb.sql to those that match an existing tablespace in the database and rerun it. 
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3 Run the following command in both the trial and reporting databases. Do not run this command 
until you are sure that you have completely removed the trial and reporting schemas. 

a Open a Windows command prompt. 

b Stop the InForm trial using the pfadmin command. 

Note: The trial should not be running while this is performed. 

c Identify the folder where the trial database is located. 

d Set your default to this folder. 

e Login to SQL*Plus with /nolog. 

f Connect to the reporting database as strmadmin. 

g Type the following at the SQL*Plus prompt: 
Delete from streams_setup_info 
where trial_username = '<trial_schema_owner>' 

and rep_username = '<rep_schema_owner>' 
and trial_db_global_name = '<global name of the trial database>' 
and rep_db_global_name = '<global name of the reporting database>' 
 

Note: Enclose all of these values in single quotes. 

where: 

• <trial-schema-owner>—The InForm trial owner in the trial database. 

• <rep_schema_owner>—The reporting schema owner in the reporting database that 
corresponds to the InForm trial owner. This user name is the same as the InForm trial 
owner. 

• <global name of the trial database>—Can be found using the command 'Select 
global_name from global_name;' in the trial database. 

• < global name of the reporting database>—Can be found using the command 
'Select global_name from global_name;' in the reporting database. 

h Exit SQL*Plus. 

i Identify the folder where the reporting database is located. 

j Set your default to this folder. 

k Repeat steps e to h for the reporting database. 
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Configuring an InForm trial for the Reporting and Analysis 
module 

Configuring a trial for the Reporting and Analysis module involves establishing communications 
between the InForm trial and the Cognos 10 BI server, as well as setting up the objects that are 
needed for reporting.  

In this section, you will: 

• Run the InForm Reporting Configuration utility. 

• Run the PFRINIT utility to set up objects, object access, permissions for reporting. 

• Run the REFRESHREPCLIN utility to generate a clinical reporting package for a trial, create the 
clinical data materialized views, or import changes and refresh the InForm reporting database. 

• Authorize users for the Reporting and Analysis module. 

• Specify a logo for InForm standard reports. 

Note: In order to run the PFRINIT and REFRESHREPCLIN utilities, you need an InForm user who is a 
member of the Publishers group, as well as a member of either the Sponsors Users or the Site 
Users group. This user is referred to as <InFormTrialUser>. The <InFormTrialUser> must also have 
access to each trial for which you run the PFRINIT or REFRESHREPCLIN utility. 

 

Configuring a trial for the Reporting and Analysis module using the InForm 
Reporting Configuration utility 

1 On the server where the InForm core software is installed, select Start > All Programs > Oracle 
Health Sciences > InForm 4.6.5 > InForm Reporting Configuration. 

The wizard title page appears.  

2 Click Next 

The Select Trial page appears.  

3 Use the drop-down list to choose the trial you want to configure for Cognos, and click Next.  

The Cognos parameters page appears.  
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4 Fill out the information as described in the table below, and click Next.  
 

Cognos Namespace Custom Authentication Provider (CAP) namespace. The default is 
informcap. The case of the value you enter here must be the same 
case as the entry in the Cognos Configuration utility. For example, if 
the entry in the Cognos Configuration utility is in lower case 
(informcap), the <namespace> option must also be in lower case 
(informcap). 

informcap is the namespace created by the InForm CRN wizard. The 
namespace can be shared by many studies, and it should not typically 
need to be changed.  

If you have created additional namespaces manually with the Cognos 
Configuration utility, use the name of the newly created namespace in 
this field. 

Gateway URI External public URI that communicates with the Cognos 10 BI 
Gateway Services from an end user's browser. This Cognos parameter 
is set in the Cognos 10 Business Intelligence Gateway Customization 
for InForm wizard. The parameter setting is stored in the 
cogstartup.xml file.  

Example: http://www.example.com/cognos 

Dispatcher URI Internal URI that the InForm server uses to communicate with the 
Cognos server. This Cognos parameter is set in the InForm CRN 
wizard. The parameter setting is stored in the cogstartup.xml file and 
corresponds to the Reporting internal URI value on the Admin > 
System Configuration page of the InForm application. 

Example: http://www.example.com:9300/p2pd/servlet/dispatch. 

Root Folder The top-level reporting folder for the trial. Default: 

/content/folder[@name='<trialname>'] 
 

The Reporting database parameters page appears.  

5 Fill out the information as described in the table below, and click Next.  
 

Field Description 
Reporting uses trial database Use if the trial and the Reporting database are on the same 

server. 

Reporting uses separate database Select if the Reporting database and the trial database are in 
separate servers. 

Database Connection String Reporting database connection string (TNS Name). Use if 
Reporting and the InForm trial are in different databases. 

User name (same as trial user) Reporting database trial username must be the same as the 
InForm database trial username. 

Password Reporting trial password. Use if the trial and the Reporting 
database are in different databases. 
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The Trial URL and database connection information page appears.  

6 Fill out the information as described in the table below, and click Next.  
 

Field Description 
Trial URL The URL for the InForm trial. 

Database Connection String The connection string for the for the CAP. 

User The user name for the CAP database schema owner. 

Password Password for the CAP database schema owner. 

Name of Trusted User Optional. The name of the user that is trusted for InForm 
Clinical Model Generation. By default, it is populated with 
pfreportinguser. This field can be left blank. 

 

The Verification page appears.  

7 Verify that the information on the page is correct and click Next.  

The trial is configured according to the information provided. 

The Reporting configuration is complete page appears.  

8 Click Finish. 
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Run the PFRINIT utility 
The PFRINIT utility performs the following tasks: 

• Modifies the default Cognos capabilities to fit the InForm reporting environment. 

• Creates new Cognos groups that match InForm reporting requirements. 

• Sets permissions on Public folders so that only Publishers can write to this public area. 

• Imports the InForm trial management archive and prepare for new trial setup. 

• Maps trial-specific reporting groups to the Cognos groups and roles. 

• Creates trial-specific data connection and set permissions so that it is restricted for the use of 
trial members only. 

• Copies the trial management package from the trial management archive, and rename it as a trial-
specific package. 

• Creates a trial folder that contains all the standard folders and reports that point to the trial-
specific package. Relative paths within reports are modified to reflect the new location. 

• Validates all copied reports so that all successfully validated reports are syntactically correct and 
able to run against the trial-specific packages. 

• Sets up the CRNSYSADMIN user. 

To run the PFRINIT utility:  

1 In Windows Explorer, navigate to the <cognos_installation_directory>\c10\bin folder. 

2 Using a text editor, open the PFRsetupTrial.xml file, and then make the following changes: 

• Connectionstring—Oracle connection string for the reporting database (in a single 
database configuration, use the trial database connection string). 

• DBUID—Trial user id (for example, pfstprduid).  

Note: The DBUID must be the same Oracle user name as the trial owner in the InForm 
trial database. 

3 Save and close the PFRsetupTrial.xml file. 



Chapter 11  Configuring a trial for the Reporting and Analysis module  
 

152 InForm 4.6.5 

4 Open a Windows Command prompt, and then type the following command to run the pfrinit 
utility: 

pfrinit PFWD crnsysadmin <Namespace> <InFormTrialUser> <internal 
dispatcher uri> <trialname> 

 
where 

• <Namespace>—Custom Authentication Provider (CAP) namespace. The default is 
informcap. The case of the value you enter here must be the same case as the entry in 
the Cognos Configuration utility. For example, if the entry in the Cognos Configuration 
utility is in lower case (informcap), the <namespace> option must also be informcap. 

• <InFormTrialUser>—The target trial InForm user who is a member of the Publishers 
users, as well as a member of either the Sponsors users or the Site users. 

• <internal dispatcher uri>—This is found in InForm Configuration tab and usually looks 
like http://<machine’s FQDN>:9300/p2pd/servlet/dispatch. 

• <trialname>—The name of the InForm trial. 

When prompted, enter the password you have chosen for the crnsysadmin user, and the InForm 
trial user password. 

5 When the utility completes, close the Command prompt. 
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Generating a clinical reporting package 
After you have completed all installations and configurations, you must create a clinical reporting 
package. The clinical package makes clinical data available to users of InForm Ad Hoc Reporting. 
You can: 

• Generate the initial clinical reporting package and deploy it as is. 

• Customize the initial clinical reporting package to include improved topic labels in the InForm 
Ad Hoc Reporting tree. 

 

Generating the initial clinical reporting package 
To be able to access clinical data in the InForm Ad Hoc Reporting module, you must generate a 
clinical reporting package that is unique to an InForm trial. 

To generate a clinical reporting package for a trial, run the refreshrepclin.bat file. 
 

Before running REFRESHREPCLIN.BAT 
Before you run refreshrepclin.bat, consider the following: 

• The Oracle client must be installed and configured to connect to the trial and reporting 
database(s).. 

• To run the script, you must have access to the <cognos_installation_directory>\bin folder. 

• The gcr.vbs script must be installed in the <cognos_installation_directory>\InForm\bin folder. 

• The InFormRep.cpf files must be installed in the 
<cognos_installation_directory>\inform\model\operational folder. 

• You must provide application-specific information such as server names and ports to connect to 
the reporting database, the Oracle Directory Server database, and Cognos 10 BI. 

 

Run REFRESHREPCLIN to generate a clinical reporting package for a trial 
To generate the initial default reporting package for a trial: 

1 Open a 32-bit command prompt (C\:Windows\SysWOW64\cmd.exe) on any server where a 
Cognos 10 Business Intelligence application tier component is installed.  

2 Navigate to the <cognos_installation_directory>\inform\bin folder. 

3 Set scripting to cscript to suppress popup messages: 
cscript //H:cscript 
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4 Type the following command: 
refreshrepclin.bat <ReportDB Connection> <ReportDB UserID> <Namespace> 
<cognos_installation_directory>\bin <Trial Name> 
M<cognos_installation_directory>\inform\model\operational\informrep.cpf 
<InFormTrialUser>  
 

where 

• <ReportDB Connection>—The ReportDB connection you want to use to connect to the 
database. For example, REP.WORLD. 

• <ReportDB UserID>—The ReportDB User ID. This ID is not case-sensitive. 

• <Namespace>—Custom Authentication Provider (CAP) namespace. The default is 
informcap. The case of the value you enter here must be the same case as the entry in the 
Cognos Configuration utility. For example, if the entry in the Cognos Configuration utility is 
in lower case (informcap), the <namespace> option must also be informcap. 

• <Trial Name>—The name of the target trial. For example, PFST45. 

• <Refresh Type>—Identifies the type or refresh you want to perform. To generate the initial 
package, you use the M (Model) option. This option generates and publishes the clinical 
model. Use this option when the reporting database was just installed or re-installed, and the 
trial design has not changed since.  

This is the complete list of options for <Refresh Type>: 

• D—Data Refresh. 

When to use—To update the reporting database with data that has been added in the 
trial. Use this option to capture additions to operational data, which does not require a 
study version revision. For example, use this option to add a new site to the reporting 
database. 

What it does—Incrementally refreshes the operational and clinical materialized views in 
the reporting database from the trial database. It does not generate and publish the 
reporting model. 

• F—Full Refresh. 

When to use—When new data items or new forms are added to the trial design, 
revising the study version, and you want to keep the existing data dictionary (you have 
not performed any data dictionary customizations, such as changing report column 
names). 

Note: When you use this option, only new trial design objects are added to an 
existing data dictionary. If you change existing items, these changes are not 
reflected in the data dictionary, and as a result are not reflected in the clinical 
model. To include changes to existing items, you must use select the R (Reset 
Refresh) option. 

What it does: 

Refreshes the database operational and clinical materialized views in the reporting 
database from the trial database. 

Recreates the clinical views. 

Rebuilds the reporting model. 

• G—Generate Clinical. 

When to use—To update the reporting data dictionary, for example, when you 
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customize column names by importing a CSV file.  

What it does: 

Refreshes the reporting data dictionary. 

Recreates the clinical views. 

Rebuilds the reporting model.  

• M—Model.  

When to use—When the reporting database has just been installed or re-installed, and 
the trial design has not changed since the installation. 

What it does—Generates and publishes the clinical model. 

• R—Reset Refresh.  

When to use—To import a custom data dictionary and create the clinical model using 
an updated trial design that includes changed trial design objects.  

What it does: This is the most complete refresh option. It performs the same tasks as 
the F option and additionally rebuilds the data dictionary: 

Drops the data dictionary. 

Imports the new data dictionary. 

Refreshes the database operational and clinical materialized views in the reporting 
database from the trial database. 

Recreates the clinical views. 

Rebuilds the reporting model. 

• <InFormTrialUser>—The target trial InForm user who is a member of the Publishers users, 
as well as a member of either the Sponsors users or the Site users. 

5 When prompted, enter the password for the: 

• ReportingDBUserID—The owner of the reporting database schema. 

• InFormTrialUser—The target trial InForm user who is a member of the Publishers users, as 
well as a member of either the Sponsors users or the Site users. For example, 
pfreportinguser. 

The files generated for the package are placed in a folder created by the refreshrepclin.bat script. The 
folder is created under InForm\bin and has the name <trialname>_Clinical. 

After you generate this package, you can use the Reporting and Analysis Ad Hoc Reporting module 
to view the reporting tree. After viewing the package, you can customize some of the labels in the Ad 
Hoc viewing tree. 

Note: Some of the file names that make up the clinical package have the same names as the 
files that make up the InForm Trial Management (operational) package. However, the operational 
files are placed in a folder named operational. You should not move the files between the Clinical 
and Operational directories. If you do, the file content is overwritten. 

Note: Text controls in an InForm trial can be set to accept more than 4000 characters. However, 
be aware that clinical views generated for reporting are truncated. If the text is longer than 4000 
characters, the first 3986 characters are shown and **TRUNCATED** appears at the beginning 
of the text in Ad Hoc Reporting. 
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Customizing a clinical reporting package 
You can customize the labels for clinical report topics and elements that appear in the ad hoc 
reporting tree to improve the presentation and to provide users with more meaningful descriptions in 
the ad hoc reporting tree. 

Note: Oracle recommends that only the trial designer or someone with a strong understanding of 
the trial design make changes to these column labels. 

To modify column values and update the reporting database, perform the following tasks in this 
order: 

1 Create a CSV file (on page 156) of the current clinical reporting package. 

2 Open the CSV file (on page 157) for editing. 

3 Change column values and save them in a CSV file (on page 157). 

4 Import the changes and update the reporting database (on page 161). 
 

Create a CSV file 
To export data from the reporting database so that you can modify column values, create a CSV file 
that you can use to change column values. 

Note: Although you can open the CSV file in any text editor, it is recommended that you use 
Microsoft Excel spreadsheet software to view and change column values in a spreadsheet. 

To export data from the reporting database to create a CSV file, you must run the command from a 
computer: 

• Where gcr.vbs is located. 

• Where the database client that connects to the reporting database is installed. 

• That has <servername> registered in tnsnames.ora. 

To export data and create a CSV file:  

1 Open a Windows Command prompt. 

2 Execute the following command: 
gcr.vbs export <filename> <servername> 

 
where 

• <filename>—The name of the CSV file that you want to create. The filename should include 
the full path. For example, ...\spreadsheets\datadict.csv. 

• <servername>—The name of the database server for the reporting database. For example, 
server_dev1. 

When prompted, enter: 

• The user name that is used to access the database schema. For example, pfst45uid. 

• The password that is used to access the database schema. For example, pfst45pid. 



 Installation and Configuration Guide  

InForm 4.6.5 157 

Example: 
gcr.vbs export datadict.csv server_dev1 pfst45uid 

 

Open the CSV file 
After creating the CSV file, you can open it using Microsoft Excel spreadsheet software to view the 
column information in a spreadsheet. In this spreadsheet, you can modify selected column labels, and 
then import the customized labels back into the reporting database. 
 

Modify the spreadsheet 
You can modify the spreadsheet to change the values for selected columns. The values that you enter 
replace the default values for labels in the InForm Ad Hoc Reporting tree. When you make changes 
to the spreadsheet: 

• Back up the original spreadsheet. 

• Back up the spreadsheet after you make changes and before you import it back into the reporting 
database. 

• Establish a way of tracking any changes that you make so that you have a record of those 
changes. 

This section provides information about: 

• The default values for a column. 

• Columns that you cannot change. 

• Columns that you can change. 

• Things to consider when making changes. 

Default values for a column 

Default labels for clinical report elements come from properties that are established in the trial design 
code. Trial designers specified different pieces of information to identify each form, itemset, or 
control in your trial. The InForm application retrieves the text in these properties and uses it for 
default labeling of the clinical report elements. 

The InForm application creates default labels for elements that appear in the Clinical Data by Forms 
folder as follows: 

optional prefix~ control reference~ item reference 
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The following table describes each portion of the default label. 
 

Report element label portion Description 
Optional prefix Defines the type of element. Possible prefixes include: 

• None 

• Code 

• Unit 

• Unit Code 

• Normalized 

• Date 

• Time 

• Month Yr 

• YYYY/MM/DD 

• HH24:MM:SS 

• Month 

• Year 

Control reference Text that identifies the specific control for the item. 

If the control is not a checkbox control, the InForm 
application uses text that is in these properties for the 
second part of the control reference: 

• Caption property for the control, if it exists. 

• RefName property for the control, if no caption 
exists. 

If the control is a checkbox, the InForm application uses 
text entered into these properties for this portion of the 
report element label: 

• Label property of the child control element, if it 
exists. 

• Caption property of the child control element, if no 
Label exists. 

• RefName property for the child control element, if 
no Label or Caption exists. 
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Report element label portion Description 
Item reference Text that identifies the item, as it appears in the trial. The 

InForm application uses text entered into these properties 
for this portion of the report element label: 

• Itemset Column Header property for the item, if it 
exists and is not the default. 

• Question property for the item, if no Itemset Column 
Header exists. 

 

Note: Trial designers should ensure that Itemset Column Header definitions are unique within a 
trial. If duplicate Itemset Column Header values exist, the Reporting and Analysis module 
combines the items into one row in reports. 

Columns that you cannot change 

Do not change the values in any of the columns beginning with the column labeled RID through the 
column labeled ItemOrder.  

Note: If you make changes to these columns, especially if the column is a key column, all of your 
changes might be invalidated and discarded when you import the spreadsheet back into the 
reporting database. 

Columns that you can change 

Initially, the column labels in the InForm Ad Hoc Reporting tree might be very long and contain a 
description that is not meaningful when using these reports to analyze information. Therefore, you 
can change the values for the following columns to improve the presentation and to provide users 
with a more meaningful description of some of the topics and elements in the ad hoc reporting tree: 

 

Column Name Description 
Columndesc Column description in the reporting database. 

Columnenable  If value is 0, this column is suppressed from clinical view and the 
clinical report topic. 

Use this column to filter the amount of information that you want to 
appear in ad hoc reporting tree. 

Columnfolder Folder in the Ad Hoc reporting tree in which this clinical report 
element should reside. 

Clinical report elements appear in one of the following folders: 

• Basic Data 

• Additional Data 

• Incomplete Data Reasons 

Columnlabel Label used for the report topic in the ad hoc reporting tree. 

Columnname Name of the column in the reporting database. 
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Column Name Description 
Columnvalue One of a set of values that pertain to the Clinical View 

column/Clinical report element. 

Viewdesc Description of the clinical view in the reporting database. 

Viewlabel Label used for the report element in the ad hoc reporting tree. 

Viewname Name of the clinical view in the reporting database. 
 

Considerations when making changes 

Consider the following when you change values: 

• In the following columns, you must change the values in all of the rows in the column: 

• Columnname 

• Columnlabel 

• Columndesc 

For example, if you change the label of an item that matches a gender control, you would need 
to change two rows. If you want to change the label for Demographics, you must change all the 
rows for the relevant columns and views. 

• For columnfolder, you can move an item from and to the predefined folders: Basic, Additional, 
and Not Done. You cannot rename a columnfolder or move the same item into two different 
folders. 

• In the viewname column, if you change your viewnames, you might want to remove the old 
views to manage the size of the database. You can remove old views using the refreshrepclin.bat 
file. For more information, see Importing changes and refreshing the reporting database 
(on page 161). 

• Do not use special characters such as ?, /, *, ? \, and so on, when you change the column values. 
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Importing changes and refreshing the InForm Reporting Database 
After making changes to the spreadsheet and creating a CSV file, you must import the CSV file into 
the reporting database. After importing the CSV file, you can refresh the reporting database and 
recreate the database clinical views and the reporting clinical model.  

After you complete these tasks: 

• Customizations are placed in the database and remain in the database. 

• If changes are made to the database, and you export the database again, the modifications that 
you made previously are retained. 

To import information and update the reporting database, run the refreshrepclin.bat file.  
 

Before running REFRESHREPCLIN.BAT 

Before you run refreshrepclin.bat, consider the following: 

• The Oracle client must be installed and configured to connect to the trial and reporting 
database(s).. 

• To run the script, you must have access to the <cognos_installation_directory>\bin folder. 

• The gcr.vbs script must be installed in the <cognos_installation_directory>\InForm\bin folder. 

• The InFormRep.cpf files must be installed in the 
<cognos_installation_directory>\inform\model\operational folder. 

• You must provide application-specific information such as server names and ports to connect to 
the reporting database, the Oracle Directory Server database, and Cognos 10 BI. 
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Run REFRESHREPCLIN to import changes to a clinical reporting package 

1 Open a 32-bit command prompt (C\:Windows\SysWOW64\cmd.exe) on any server where a 
Cognos 10 Business Intelligence application tier component is installed.  

2 Navigate to the <cognos_installation_directory>\inform\bin folder. 

3 Set scripting to cscript to suppress popup messages: 
cscript //H:cscript 
 

4 Type the following command: 
refreshrepclin.bat <ReportDB Connection> <ReportDB UserID> <Namespace> 
<cognos_installation_directory>\bin <Trial Name> 
M<cognos_installation_directory>\inform\model\operational\informrep.cpf 
<InFormTrialUser>  
 

where 

• <ReportDB Connection>—The ReportDB connection you want to use to connect to the 
database. For example, REP.WORLD. 

• <ReportDB UserID>—The ReportDB User ID. This ID is not case-sensitive. 

• <Namespace>—Custom Authentication Provider (CAP) namespace. The default is 
informcap. The case of the value you enter here must be the same case as the entry in the 
Cognos Configuration utility. For example, if the entry in the Cognos Configuration utility is 
in lower case (informcap), the <namespace> option must also be informcap. 

• <Trial Name>—The name of the target trial. For example, PFST45. 

• <Refresh Type>—Identifies the type or refresh you want to perform. To generate the initial 
package, you use the M (Model) option. This option generates and publishes the clinical 
model. Use this option when the reporting database was just installed or re-installed, and the 
trial design has not changed since.  

This is the complete list of options for <Refresh Type>: 

• D—Data Refresh. 

When to use—To update the reporting database with data that has been added in the 
trial. Use this option to capture additions to operational data, which does not require a 
study version revision. For example, use this option to add a new site to the reporting 
database. 

What it does—Incrementally refreshes the operational and clinical materialized views in 
the reporting database from the trial database. It does not generate and publish the 
reporting model. 

• F—Full Refresh. 

When to use—When new data items or new forms are added to the trial design, 
revising the study version, and you want to keep the existing data dictionary (you have 
not performed any data dictionary customizations, such as changing report column 
names). 

Note: When you use this option, only new trial design objects are added to an 
existing data dictionary. If you change existing items, these changes are not 
reflected in the data dictionary, and as a result are not reflected in the clinical 
model. To include changes to existing items, you must use select the R (Reset 
Refresh) option. 



 Installation and Configuration Guide  

InForm 4.6.5 163 

What it does: 

Refreshes the database operational and clinical materialized views in the reporting 
database from the trial database. 

Recreates the clinical views. 

Rebuilds the reporting model. 

• G—Generate Clinical. 

When to use—To update the reporting data dictionary, for example, when you 
customize column names by importing a CSV file.  

What it does: 

Refreshes the reporting data dictionary. 

Recreates the clinical views. 

Rebuilds the reporting model.  

• M—Model.  

When to use—When the reporting database has just been installed or re-installed, and 
the trial design has not changed since the installation. 

What it does—Generates and publishes the clinical model. 

• R—Reset Refresh.  

When to use—To import a custom data dictionary and create the clinical model using 
an updated trial design that includes changed trial design objects.  

What it does: This is the most complete refresh option. It performs the same tasks as 
the F option and additionally rebuilds the data dictionary: 

Drops the data dictionary. 

Imports the new data dictionary. 

Refreshes the database operational and clinical materialized views in the reporting 
database from the trial database. 

Recreates the clinical views. 

Rebuilds the reporting model. 

• <InFormTrialUser>—The target trial InForm user who is a member of the Publishers users, 
as well as a member of either the Sponsors users or the Site users. 
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5 When prompted, enter the password for the: 

• ReportingDBUserID—The owner of the reporting database schema. 

• InFormTrialUser—The target trial InForm user who is a member of the Publishers users, as 
well as a member of either the Sponsors users or the Site users. For example, 
pfreportinguser. 

The files generated for the package are placed in a folder created by the refreshrepclin.bat script. The 
folder is created under InForm\bin and has the name <trialname>_Clinical. 

After you generate this package, you can use the Reporting and Analysis Ad Hoc Reporting module 
to view the reporting tree. After viewing the package, you can customize some of the labels in the Ad 
Hoc viewing tree. 

Note: Some of the file names that make up the clinical package have the same names as the 
files that make up the InForm Trial Management (operational) package. However, the operational 
files are placed in a folder named operational. You should not move the files between the Clinical 
and Operational directories. If you do, the file content is overwritten. 

Note: Text controls in an InForm trial can be set to accept more than 4000 characters. However, 
be aware that clinical views generated for reporting are truncated. If the text is longer than 4000 
characters, the first 3986 characters are shown and **TRUNCATED** appears at the beginning 
of the text in Ad Hoc Reporting. 

 

Refreshing the InForm reporting database in an InForm multi-release environment 

If you are running in an environment where one Cognos and Reporting installation supports multiple 
InForm trials with different InForm 4.6 releases, run the refresh_reporting_diffdb.sql script in 
conjunction with the refreshrepclin.bat script with the M option. 

The refresh_reporting_diffdb script: 

• Sets the reporting schema refresh job schedule dates to future dates. 

• Stops the apply process. 

• Removes reporting schema owner jobs (refresh jobs) from the job queue. 

• Refreshes operational materialized views. 

• Recreates clinical objects with new trial design changes. 

• Starts the apply process. 

• Submits refresh jobs to queue. 

• Starts the refresh job. The script gives an error in case the refresh job fails to start. 
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To get trial design (metadata) changes in clinical model: 

1 Run the following at a command prompt: 
sqlplus /nolog 
@refresh_reporting_diffdb 

 
2 Run RefreshRepClin.bat with the M option. 

To see the changes with blinding and unblinding items, as well as operational and clinical data 
changes: 

1 Run the refresh job either manually or wait for the hourly refresh.  

2 Generate the clinical model by running RefreshRepClin.bat with the M option. 

Note: You do not need to run refresh_reporting_diffdb.sql to see these changes. 
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Authorizing users for the Reporting and Analysis module 

Authorization on the reporting server 
Reporting authorizations on the reporting server rely on permissions that are defined in authorization 
namespaces on the reporting server. 

All rights to create or run reports are governed by reporting authorizations in the InForm trial, which 
is referenced by the Cognos Custom Authentication Provider (CAP). 
 

The Cognos namespace 
Each reporting server references one master namespace that controls authorization for all studies. 
This namespace, the Cognos namespace, contains the Cognos objects, such as groups, roles, 
distribution lists, and contacts. During the Cognos Content Store initialization, predefined security 
entries that control access to specific Cognos features are created in this namespace. 
 

Default reporting groups 
As part of the initial Reporting and Analysis setup, the pfrinit utility imports the 
PFRsetupTrial_<lang>.xml file, which loads the following predefined reporting groups into the 
Cognos namespace for an InForm trial. 

In the following table, some groups are described as custom groups added by the InForm 
application. By default, these groups have no corresponding group or role in the Cognos namespace. 
The groups are added to the Cognos namespace by the pfrinit utility. 

 

InForm reporting group Cognos namespace 
group or role 

Provides these permissions 

Ad Hoc Users Query Users Can run the Ad Hoc Reporting utility. Users 
also have the same rights as members of the 
Cognos 10 BI Consumers namespace role. 

Authors Authors • In Report Studio—Authors can create, 
edit, or run reports that use clinical or 
operational model packages. 

Authors cannot create, edit, or run 
reports that contain custom HTML 
and/or custom SQL.  

• In Cognos Connection—Authors can 
run reports that use clinical or 
operational model packages. 

Authors cannot run reports that contain 
custom HTML and/or custom SQL. 
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InForm reporting group Cognos namespace 
group or role 

Provides these permissions 

No equivalent group Consumers Can run reports in the Public folders. These 
reports can be Standard Reports or custom 
reports that users create. 

Every user that has the InForm Reports 
rights group right is by default a member of 
the Consumers group. This group is visible 
only as a Cognos namespace role. 

Directory Administrators Directory Administrators • Can view Groups and Roles, but not 
Cognos Capabilities. 

Cannot make changes to Cognos 
Capabilities or Cognos Groups and 
Roles. 

• Can accept only InForm Support user 
types. 

Sponsor or Site users can no longer be 
added to this group. 

Publishers Publishers Can create, change, schedule, or delete all 
content, including reports (Ad Hoc or 
Report Studio) to a Public folder. When 
users in the Publishers group run a report in 
a Public folder, their prompt selections are 
saved with the report. 

Report Administrators Report Administrators Can administer permissions for all public 
content including folders and reports. 

Server Administrators Server Administrators Can administer servers, dispatchers, and 
jobs. 

Can accept only InForm Support user types. 

Sponsor or Site users can no longer be 
added to this group. 

Site Users Site Users Access to all Standard Reports except for by 
User reports. Users are automatically 
assigned to this group based on their user 
type. 

Custom group added by the InForm 
application.  

Sponsor Users Sponsor Users Access to all InForm standard reports. Users 
are automatically assigned to this group 
based on their user type. 

Custom group added by the InForm 
application. 
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InForm reporting group Cognos namespace 
group or role 

Provides these permissions 

No equivalent group System Administrator The superuser role in Cognos. This user has 
full control of every setting for every trial 
that can be set in a given Cognos server. 
There is no equivalent InForm reporting 
group. At initial setup, all users have this 
right. 

You should identify a small group of highly 
trusted users and directly assign them to the 
Cognos namespace System Administrator 
role. Then, remove the Everyone group 
from this role. 

User Admin Info Data 
Users 

User Admin Info Data 
Users 

Access to user data including password 
related data. 

Custom group added by the InForm 
application.  

User Info Data Users User Info Data Users Access to user data except password related 
data.  

Custom group added by the InForm 
application.  
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Specifying a logo for InForm Standard Reports 
You can specify a company logo to appear in your InForm Standard Reports. 

To specify a logo file: 

1 Create a file called logo.gif. 

2 Copy logo.gif to the following location on the Cognos Gateway Web Server: 
<cognos_install_folder>\webcontent\<trialname>  

 
For example: d:\c10\webcontent\Depression Study\logo.gif. 

If you do not want a logo to appear in the InForm Standard Reports, you must place a blank image 
in the location that is specified above. If you do not include the blank graphic file, a missing graphic 
icon appears on your InForm Standard Reports. 
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About performance tuning 
Perform the performance tuning steps as needed, in any order. 
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Controlling the load behavior 
Trials with a very large number of patients can take a long time to start up, because all patients are 
loaded into memory cache. To confirm whether this problem is occurring, check the InForm 
Performance Monitor utility. 

To start the InForm Performance Monitor utility:  

• Select Start > Programs > Oracle Health Sciences > InForm 4.6.5 > InForm Performance Monitor. 

You will see that there are many SQL statements that contain the text  

select * from DCV_PatientCRF where PatientID=xxxx 
 

Note: You must start the InForm Performance Monitor utility before you start the trial to see trial 
startup activities. 

You can modify registry settings to help alter the load behavior to make the trial startup more 
efficient. The settings are located in the following location: 

HKEY_LOCAL_MACHINE/SOFTWARE/PHASEFORWARD/InForm/PFMngrTrial/PatientCacheLoadi
ngMode 
 

The following registry settings control load behavior: 

• sync—Patient cache is loaded in bulk instead of one patient at a time. 

Use this setting if it is important to load all patients before the trial becomes available. 

This option takes the most time at trial startup. 

• ondemand—Trial starts immediately and the patient data is loaded into cache only when an 
InForm user tries to access data for that patient. 

This option provides the fastest trial startup, but results in slow performance the first time a 
patient is accessed. 

Patients that are not accessed are not cached at all, which means they do not consume memory 
or require other server resources to load them. 

• async—Trial starts immediately and the patient cache continues to load in the background. 

When an InForm user tries to access data for a patient that is not yet loaded, the patient is loaded 
on demand. 

Performance might be slow the first time the patient is accessed. 
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Updating statistics in a production environment 
Oracle recommends that you analyze all tables and indexes for better performance. The trial setup 
process creates statistics for your trial. As you add patient data to the trial, it is important to refresh 
these statistics periodically. In a production environment, refreshing once per day during the 
maintenance window is usually sufficient. 

• To update the statistics, run the updatec.sql script (located in the 
InForm_installation_directory\bin\dbora folder) using the following syntax: 

sqlplus pfdbadmin@<connect_string> @updatec.sql <trialUID> 
 

When prompted, enter the password for the pfdbadmin user. 

Note: Do not use the dbms_utility.analyze_schema with the COMPUTE or the FOR TABLES option 
on any production servers. The recommended procedure is to analyze each table and index with 
the ESTIMATE option (35 percent is adequate). 
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Configuring an ODBC connection 
To configure ODBC connection pooling by changing the Timeout value to provide a longer 
connection time: 

1 Select Start > Programs > Administrative Tools > Data Sources.  

The ODBC Data Source Administrator window appears. 

2 Select the Connection Pooling tab. 

3 Double-click Oracle in <ORACLE_HOME> 

where <ORACLE_HOME> is your Oracle Client Home.  

The Set Connection Pooling Attributes dialog box appears. 

4 Make sure that the Pool connections to this driver radio button is selected and that the value is 
moderately long (about 450 seconds*). If it is too short, the connection will constantly be 
refreshing itself; if it is too long, the connection will consume too many resources. 

The recommended Pooling Timeout = 1.5 x MSDTC Timeout Value 

5 Click OK, and then OK again to close the ODBC Data Source Administrator. 
 



Chapter 12  Performance tuning  
 

176 InForm 4.6.5 

Resizing virtual memory 
The InForm software uses virtual memory (disk space simulated as memory) aggressively. Oracle 
recommends that you create a large paging file in a location that is different from the default location 
(C:); particularly on a drive with lots of disk space. 

To resize virtual memory: 

1 Select Control Panel > System. 

2 In the System Properties dialog box, click the Advanced tab. 

3 Click Performance > Settings. 

4 In the Performance Options dialog box, click the Advanced tab. 

5 Click Change. 

6 Highlight a drive in which to place the virtual memory in the Drive (Volume Label) section. 

7 Type a value in the Initial Size (MB) field (the sum of physical RAM plus 11 is recommended, or 
you can use the Recommended size). 

8 Type a value in the Maximum Size (MB) field (the minimum * 1.5 or 2). 

9 Click Set. 

10 Click OK until all the dialog boxes close. 
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Removing preferential treatment from foreground 
applications 

To provide more resources for background applications: 

1 Select Control Panel > System. 

2 In the System Properties dialog box, click the Advanced tab. 

3 Click Performance > Settings. 

4 In the Performance Options dialog box, click the Advanced tab. 

5 Select Background applications. 

6 Click OK until all dialog boxes close. 
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Optimizing Windows for network applications 
To optimize Windows for network applications: 

1 Click Start > Control Panel > Network Connections > Local Area Connection. 

2 Click Properties.  

3 On the General tab, select File and Print Sharing for Microsoft Networks, and then click Properties. 

4 To tune the Server service to reduce paging activity, click Maximize Throughput for Network 
Applications.  

5 Click OK, and then Close. 
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Monitoring the Windows Event Logs 
The InForm application logs events to the Application Event log. For optimum performance, make 
sure to manually clear the log periodically, or wrap events. 

To monitor event logs: 

To access the log, in the Event Viewer window select Log > Log Settings.  

You can: 

• Overwrite events as needed. 

• Overwrite events older than n days. 

• Clear the log manually. 

Oracle recommends that you overwrite events as needed. 

Note: The Application Event log holds a record of all InForm log on attempts. Be aware of this 
when you choose a setting for event logs, because you may not want to lose any of the InForm log 
on information.  

For production servers, Oracle recommends that you save event logs periodically. 
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Moving locations for MS DTC logs 
The MS DTC logs are generated by default in the %SYSTEMROOT%\SYSTEM32\DTClog folder. 
Oracle recommends that you place the logs on a different disk, and increase the log file size. 

To move locations for MS DTC logs: 

1 In Windows Explorer, create a new folder for the DTC logs. 

2 At a Windows command prompt, stop the MS DTC service. 

3 Open Microsoft Component Services by selecting Start > Programs > Administrative Tools > 
Component Services. 

a Expand Component Services. 

b Expand Computers. 

c Right-click My Computer and select Properties. 

d Select the MS DTC tab. 

e In the Log Information group box, change the Capacity to 16 MB or higher. 

4 Click Reset log. 

5 To reset the existing log file, in the dialog box, click Yes. 

6 In the dialog box, type a new drive location. 

7 Click Reset. 

8 Click OK. 

9 Start the MS DTC service. 

10 Delete the original MS DTC folder through Windows Explorer. 
 



 Installation and Configuration Guide  

InForm 4.6.5 181 

Clearing and enlarging MS DTC logs 
If you experienced an MS DTC log problem, for example if you received the following error 
message, you can reset the log size: 

The MS DTC log file is full and cannot accept new log records. 
To reset the log size: 

1 At a command prompt, use the pfadmin command to stop the InForm application. 

2 At a command prompt, stop the MS DTC service. 

3 To open the Microsoft Component Services, select Start > Programs > Administrative Tools > 
Component Services. 

4 Expand My Computer. 

5 Right-click My Computer, and select Properties. 

6 Select the MS DTC tab. 

7 In the Capacity section, increase the capacity of the log file to 100 MB. 

8 Click Reset log. 

9 Click OK. 

10 Right-click My Computer, and select Start MS DTC. 

11 Close the Component Services. 

12 Click YES to save the settings. 
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Overview 
This appendix lists the scripts that are used during the installation and configuration of the Reporting 
and Analysis module. 

For installation instructions, see the chapter Configuring reporting variables in a multiple 
database environment (on page 138). 
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Prerequisites 
Before any of the scripts in this Appendix can be run, the following conditions apply: 

• Oracle software requirements must be met. For more information, see the hardware and 
software requirements. in the Release Notes. 

• Reporting must be in a separate database from the trial database. For more information, see 
Creating the trial and reporting databases in separate instances (on page 129). 

• Reporting architecture requirements are met. For more information, see InForm reporting 
database architecture rules (on page 124). 

• The reporting database must exist with the appropriate parameters and tablespaces. For more 
information, see Preparing the trial database for Reporting and Analysis in a multiple 
database environment (on page 136). 

• The configdiffdb.sql file variables must be configured. For more information, see 
Export/import variables (on page 188). 
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Scripts 
• preinstall_reportingschema_diffdb.sql 

Creates the reporting infrastructure, users, privileges, and trial objects necessary to support 
reporting. 

This script: 

• Must be run with the trial down. Oracle recommends running this script with all trials down 
in a maintenance window to avoid conflicts and errors. 

• Only needs to be run once per trial and reporting installation. It must be rerun if reporting is 
completely uninstalled (that is, the deinstall_reporting_diffdb.sql script was run. 

• To check the environment prior to running this script, run the configandcheckdiffdb.sql 
script. 

• This script uses the configdiffdb.sql and the configaddsdiffdb.sql files; the correct ones must 
be in place. 

• configandcheckdiffdb.sql 

Checks the environment and variable settings. This script is run by the installation program; it 
can also be run manually. 

• configandcheckreportingschemadiffdb.sql 

Checks the environment before running the install_reportingschema_diffdb.sql script. This can 
run at any time and can be rerun as necessary. 

• install_reportingschema_diffb.sql 

Installs a reporting schema without bringing the trial down. 

Before running this script:  

• Run the preinstall_reportingschema-diffdb.sql script. (Required.) 

• Disable all Streams processes (capture, propagation and apply) 

• Disallow access to the reporting database. Reporting database users should not be allowed to 
access the reporting schema while this script is running. 

• To check the environment, run the configandcheckreportingschemadiffdb.sql script 
(Optional.) 
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• deinstall_reportingschema_diffdb.sql 

Uninstalls a reporting schema without bringing the trial down. All Streams processes (capture, 
propagation and apply) must be disabled prior to running this script. 

remove_streams_setup_info_diffdb.sql 

Deletes the STREAMS_SETUP_INFO row in the trial and reporting databases. 

When you install the Reporting and Analysis module, a table called STREAMS_SETUP_INFO 
is created in both the trial and reporting databases. The STRMADMIN user owns this table in 
both databases. This table has one row per trial and reporting schema. When you remove a trial 
and reporting schema, you must delete the row in the STREAMS_SETUP_INFO table for the 
trial and the reporting schema. 

Do not run remove_streams_setup_info_diffdb.sql until you are sure that: 

• You have completely removed the trial and reporting schemas. 

• The configdiffdb.sql file is correctly set up for the trial and its reporting environment. 

Run this script with SQL*Plus with /nolog. 

You must be connected as STRMADMIN. 

configaddsdiffdb.sql 

Configures optional variables, all of which depend on user requirements. No changes to the 
variables in this file are required; any changes are optional. 

add_table_diffdb.sql 

Adds tables to the list of tables streamed to the Reporting database after Reporting has been 
completely installed. 

For information about specifying table names, see streams_table_adds_postinstall and 
streams_table_drop_postinstall variables (on page 190). 

drop_table_diffdb.sql 

Drops tables from the list of tables streamed to the Reporting database after Reporting has been 
completely installed. 

For information about specifying table names, see streams_table_adds_postinstall and 
streams_table_drop_postinstall variables (on page 190). 

• create_cap_table.sql 

Creates the TRIAL_URLS table for the PFCAPAdmin user. 
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configaddsdiffdb.sql 
Configaddsdiffdb.sql file contains variables for managing streams processes and adding tables for 
replication.  

Any changes to variable values are optional. The installation is unaffected if default values are used. 

There should be one copy of this file per trial and reporting schema. If values in this file have been 
changed, then make a copy of the file after the installation for later use.  

 
 

Export/import variables 
 

Variable name Description and Comments 
Exp_var Name of the export executable. Default is "exp".  

The executable name can be preceded by a full hardcoded 
folder path (for example, C:\oracle\product\11.2.0\db_1\bin\) 
or a variable (for example, $ORACLE_HOME\bin\). 

Imp_var Name of the import executable. Default is "imp".  

The executable name can be preceded by a full hardcoded 
folder path (for example, C:\oracle\product\11.2.0\db_1\bin\) 
or a variable (for example. $ORACLE_HOME\bin\). 

export_parfile  Filename for the export parameter file.  

Format is the trial schema name concatenated to the trial 
database tnsnames alias concatenated to expparams.par. 

See Note. 

import_parfile Filename for the import parameter file.  

Format is the trial schema name concatenated to the trial 
database tnsnames alias concatenated to impparams.par. 

See Note. 

expimp_dumpfile  Filename for the export data file.  

Format is the trial schema name concatenated to the trial 
database tnsnames alias concatenated to datafile.dmp. 

See Note. 
 

Note: Files created by export_parfile, import_parfile, and expimp_dumpfile are not removed after 
the installation is complete. The files are overwritten each time a reporting installation is run for 
the same trial schema, so there will be only one copy of each file per trial schema. 
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streams_table_adds variable 

Description  
The streams_table_adds variable is used to specify additional tables for replication. Table names you 
specify must exist in the trial schema in the trial database.  

Values 
The default value for this variable is null (no value). To add tables to this variable, surround table 
names with single quotes, put a comma after each table name (including the last one) and do not use 
spaces between the table names.  

Examples 
streams_table_adds = 'PF_TABLEONE,' 
streams_table_adds = 'PF_TABLEONE,PF_TABLETWO,PF_TABLETHREE,' 
 

Considerations 
• The configandcheckdiffdb.sql and configandcheckreportingschemadiffdb.sql scripts verify 

the following: 

• The table(s) added to this variable exist in the trial schema. An error is generated if they do 
not.  

• The tables do not have primary keys. 

• The table does not have an unconditional supplemental log 
(configandcheckreportingschemadiffdb.sql only). 

• Table names added to this variable should not be removed unless they are being removed from 
replication. 

• Tables added prior to running the preinstall_reportingschema_diffdb.sql or 
install_reportingschema_diffdb.sql script will have a supplemental log automatically added to 
them. 

• Tables added after running the preinstall_reportingschema_diffdb.sql and prior to running 
the install_reportingschema_diffdb.sql script need to have a supplemental log added to them 
manually, using the command below: 

• Run this command after logging into the trial database as the trial schema owner 
alter table <table_name> add supplemental log data (all) columns; 

 

• Table rules added to the capture, propagation, and apply processes are generic and specify that 
the entire table and all rows in the table be replicated to reporting.  
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streams_table_adds_postinstall and streams_table_drop_postinstall variables 

Description 
• streams_table_adds_postinstall is used by the add_table_diffdb.sql script when adding tables 

after Reporting is installed. 

• streams_table_drop_postinstall is used by the drop_table_diffdb.sql script when dropping tables 
after Reporting has been installed. 

Values 
For each variable, specify the values shown in the table. 

• TABLEONE and TABLETWO represent names of tables to be added or dropped. 

• To specify one table, use a single quote before and after the table name. 

• To specify more than one table name: 

• Use a single quote before the first table name, and a single quote after the last table name in 
the series. (Do not use any other single quotes in the table names.) 

• Use a comma between the table names. Do not use a space. 

• Do not use a comma after the last table name in the series. 
 

Number of tables Setting in configaddsdiffdb.sql 
1 table streams_table_adds_postinstall = 'TABLEONE' 

streams_table_drop_postinstall = 'TABLEONE' 

2 or more tables streams_table_adds_postinstall = 'TABLEONE,TABLETWO' 

streams_table_drop_postinstall = 'TABLEONE,TABLETWO' 
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capture_chkpnt_ret_time variable 

Description 
The capture_chkpnt_ret_time variable is used to set the number of days for which capture checkpoints 
are retained. This variable value is passed to the dbms_capture_adm.create_capture procedure when 
the capture process is created. 

Values 
The default is 60 (This is the same as the default Oracle provides with the 
dbms_capture_adm.create_capture procedure). This parameter cannot be null. 

Note: A large of number of days specified for this parameter can cause a large number of capture 
checkpoints to be retained and cause the SYSAUX tablespace in the trial database to grow 
significantly. This setting along with the capture parameter _checkpoint_frequency influence the 
amount of checkpoints retained. 

Values in the form of decimals (such as. 0.50 or .50) are considered to be parts of a day – 0.50 would 
cause checkpoints to be purged every 12 hours. Decimals can be combined with whole numbers (e.g. 
1.25 – this would be 30 hours or 1.25 days). 

This parameter does not accept the dbms_capture_adm.infinite setting (never purge checkpoints). 
However, the parameter can be set to a very high number of days (e.g. 365000000), effectively 
causing checkpoints not to be purged. 

Considerations 
• The preinstall_reporting_diffdb.sql and install_reporting_diffdb.sql scripts always use the 

value for this variable when creating the capture process. 

• The install_reportingschema_diffdb.sql script does not use the value of this variable unless 
the streams_capture_reset variable is set to “Y” (the capture process will be dropped and 
recreated).  

• The configandcheckdiffdb.sql and configandcheckreportingschemadiffdb.sql scripts verify 
that this variable is not null and generate an error if it is null. 

• If the checkpoint_retention_time for a capture process is changed after the process has been 
created, you should change the value of this parameter as well so the next time the capture 
process is created the value of checkpoint_retention_time retains the desired value. 

For more information, see the Oracle database document PL/SQL Packages Types and Reference 
(dbms_streams_adm,create_capture procedure) and the Oracle database Streams document Concepts and 
Administration Guide for more information on checkpoint_retention_time. 
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Streams reset variables 
 

Variable name  Description 
streams_capture_reset Drops and recreates the Streams capture process in the trial 

database 

streams_propagation_reset Drops and recreates the Streams propagation process in the trial 
database. 

streams_apply_reset Drops and recreates the Streams apply process in the reporting 
database. 

streams_trial_queue_reset Drops and recreates the Streams queue and queue table in the trial 
database 

streams_rep_queue_reset Drops and recreates the Streams queue and queue table in the 
reporting database. 

 

These variables are used by the install_reportingschema_diffdb.sql script, which is used primarily 
to create a new reporting schema. 

Values 
Values cannot be null. All Streams reset variables must have the same value. Setting mixed values 
could cause the installation to fail. 

• "N" (default) causes the script to do nothing. No Streams processes or objects are dropped and 
recreated. 

• "Y" causes the streams processes to be dropped and recreated. 

Considerations 
• These variables are used by the install_reportingschema_diffdb.sql script only. They are not 

used by the preinstall_reportingschema_diffdb.sql script.  

• Setting values to "Y" can be useful in the following situation: 

If preinstall_reportingschema_diffdb.sql has been run separately and the capture process it 
created has existed for some time, that capture process might need access to an archive log that 
is no longer on disk. The archive log must be restored. To avoid the need to restore archive logs, 
the capture (and other streams processes) can be dropped and recreated using these variables.  

Dropping and recreating the capture process does not necessarily remove the need for older 
archive logs, so it is recommended that the capture_build variable also be set to “Y” in this 
circumstance so that a new Logminer data dictionary is created and used by the capture process.  

• If you are running the install_reporting_diffdb.sql script, it is recommended that the Streams 
reset variables be set to "N".  

Setting the values to "Y" caused the installation program to do more work and take longer to 
complete, because the following occurs when install_reporting_diffdb.sql calls both the 
preinstall_reportingschema_diffdb.sql and the install_reportingschema_diffdb.sql scripts. 

• preinstall_reportingschema_diffdb.sql creates Streams processes and objects. 
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• install_reportingschema_diffdb.sql script drops the Streams processes and objects and 
recreates them. 

Although this does not cause problems, it causes the installation to do more work and take 
longer to complete. 

• The configandcheckdiffdb.sql and configandcheckreportingschemadiffdb.sql scripts verify 
the variable values, and generate an error if any variable has a value other than "N" or "Y". 

 

capture_build variable 

Description 
This variable is used to extract a copy of the data dictionary to the redo logs.  

The Oracle database dbms_capture_adm.build procedure is invoked to extract a copy of the data 
dictionary to the redo logs. This procedure returns a scn that is used as the "first scn" for the capture 
process. As a result, the capture process uses a new Logminer data dictionary. 

Values 
Value cannot be null. 

• "N" (default) causes the script to do nothing. No extract is done. 

• "Y" causes an extract to be done.  

Considerations 
• The install_reporting_diffdb.sql and preinstall_reportingschema_diffdb.sql scripts always 

use the value of this variable. 

• The install_reportingschema_diffdb.sql script uses the value of capture_build only if the 
streams_capture_reset variable is set to "Y" (the capture process will be dropped and recreated). 

• The configandcheckdiffdb.sql and configandcheckreportingschemadiffdb.sql scripts verify 
the variable value and generate an error if the variable has a value other than "N" or "Y". 
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capture_first_scn and capture_start_scn variables 

 

Variable Description 
capture_first_scn Sets the first scn for the capture process 

capture_start_scn Sets the start scn for the capture process. 
 

Values 
• Default is 1. This value is interpreted as a null value by the installation scripts. Do not set the 

value to null directly. 

• Values for both variables must be greater than or equal to 1. 

• Value for capture_start_scn must be greater than or equal to the value for capture_first_scn 

• Values for both variables can also be set valid scn numbers from the trial database, subject to 
some restrictions described in Value assignments. The values for both variables cannot be set to 
a scn that is greater than the current scn number for the database. 

Value assignments are based on the following hierarchy: 

• capture_first_scn value assignment: 

• If no capture processes exist in the trial database, assign a null (Oracle requirement). 

• If the value of the capture_build variable is set to “Y”, use the scn number returned from the 
dbms_capture_adm.build procedure. 

• If the value is 1 from the configaddsdiffdb.sql file, assign a null. 

• Otherwise, use the scn value assigned (cannot be greater than the current database scn) from 
the confgaddsdiffdb.sql file. 

• capture_start_scn value assignment: 

• If no capture processes exist in the trial database, assign a null (Oracle requirement). 

• If capture processes exist in the trial database but no capture checkpoints have been taken, 
assign a null (Oracle requirement). 

• If the value is 1 from the configaddsdiffdb.sql file, assign a null. 

• Otherwise, use the scn value assigned (cannot be greater than the current database scn) from 
the condigaddsdiffdb.sql file. 

Considerations 
• The install_reporting_diffdb.sql and preinstall_reportingschema_diffdb.sql scripts always 

use the value of these variables.  

• The install_reportingschema_diffdb.sql script does not use the values of these variables 
unless the streams_capture_reset variable is set to “Y” (the capture process will be dropped and 
recreated).  

• The configandcheckdiffdb.sql and configandcheckreportingschemadiffdb.sql scripts verify 
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that all of the following conditions are met: 

• Both variables are not null. 

• Both variables are set to a value of 1 or greater, 

• Value of both variables is not greater than the current scn for the trial database. 

• The value of capture_start_scn is greater than or equal to the value of capture_first_scn.  

An error is generated if these conditions are not met. 

• The capture_first_scn can be changed so that a particular existing Logminer dictionary can be 
used.  

• The capture_start_scn can be changed to set the starting scn for the capture process.  

For more information on setting “first scn” and “start scn” for the capture process, see the Oracle 
Streams Concepts and Administration Guide, Chapter 2. 
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PFAdmin syntax 

About PFAdmin 
The PFAdmin utility is used to set up the InForm software server environment. The parameters are 
stored in the registry. Therefore, you need local administrator privileges to run the utility. 

The PFAdmin utility has the following command options: 

pfadmin [ CHECKREG | CONFIG | HELP | INSTALL | KILLSERVER | PING | REMOVE | 
SETSERVER | SETUP | START | STOP | SYNC | UNINSTALL | VIEW |RULESCANVIEW | 
RULESCANPROCESS | UPGRADEENV]] 
 

Note: Before using PFAdmin, make sure that Default Authentication Level in Default Properties is 
set to Connect. 

 

PFAdmin commands 

Note: Any arguments containing commas, equal signs, or spaces must be enclosed within double 
quotes. 

 

Command Purpose and Syntax 

CHECKREG [/Del] [/DelAll] Displays the current InForm Server COM and MTS components 
in the NT registry.  

WARNING: Be careful to remove the server(s) or uninstall the 
service before using either of the delete options: 

• [/Del]—Removes obsolete settings. 

• [/DelAll]—Removes the settings of all servers. 
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Command Purpose and Syntax 

CONFIG Service  
 [/AdminDB DBServer | 
 [/AdminDSN DsnName | 
[/LDAPMngr LDAPServer:Port 
AdminDN ] 
 [/PfUser ] | 
 [/SysDBA  

Configures an existing service. 

• [/AdminDB DBServer [SQL]]—Sets the ODBC DSN for the 
InFormAdmin database. Make sure that DBServer, (and 
user_ID, and password you enter when prompted) are the same 
ones that were used to create the InFormAdmin database. 

• [/AdminDSN DsnName ]—Creates the ODBC DSN InForm 
software with the default database server, using the specified 
user name and password. 

• [/LDAPMngr LDAPServer:Port "AdminDN" ]—Save 
Administrator Distinguish Name and password for a 
particular LDAP server. Use this command after installing 
Oracle Directory Server to pass the LDAP administrator 
credentials to the Reporting and Analysis module. 

• [/PfUser ]—Creates the PfUser_computername account during 
the InForm software installation. The account is for Microsoft 
MTS packages used by InForm servers. In general, you do not 
need to configure the account. If you change the password 
through NT User Manager, you must reconfigure the InForm 
Service with the new password. 

• [/SysDBA ]—Sets the InForm Service DBA user name and 
password. You can use this command to change the 
pfdbadmin password as needed. 

If you want to change the InForm Service DBA name, modify 
the provided SQL script InFormPrepORA.sql with the new 
user name and password, then run the script as SYS. After 
running the script, use this command option to configure the 
InForm Service to use the new InForm Service DBA. 

CONFIG Server ServerName 
 [Automatic|Manual] 

Configures the startup mode for an existing server as either 
Automatic or Manual. 

CONFIG Trial TrialName 
 [Automatic | Manual] | 
 [/TriDSN DSN] | 
 [/RndDSN DSN] | 
 [/Rnd [MDBFilePath ]] | 
 [/Host ServerName] | 
 

Configures an existing trial. 

• [Automatic | Manual]—Configures the trial startup mode. 

• [/TriDSN DSN —Configures the trial ODBC DSN. 

• [/RndDSN DSN]—Configures the trial randomization source 
dataset name. 

• [/Rnd [MDBFilePath]]—Creates a trial randomization source 
dataset name to use the given Microsoft Access database file. 

• [/Host ServerName]—Moves the trial from current host server 
to another server in the InForm Service. 
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Command Purpose and Syntax 

CONFIG CDD TrialName 
 [Enable | Disable] | 
 [DSN [Active | Inactive]] | 
 [DSN ] 

Configures an existing CDD: 

• [Enable | Disable]—Enables or disables the CDD for a 
particular trial. 

• [DSN [Active | Inactive]]—Makes a CDD DSN active or 
inactive for a particular trial. 

• [DSN ]—Configures an existing CDD DSN with the User ID 
and password specified. 

CONFIG WEBSERVICE 
AuthService 

Specifies the port number for the InForm application to use to 
validate users in the Reporting and Analysis module. 

HELP Lists all the options of the pfdamin command. 

INSTALL Creates PfUser_computername and other settings, and installs the 
MTS library package InFormTrial.  

The InForm service does not have to be running for the 
command to work. 

KILLSERVER ServerName Stops server MTS packages without stopping trials on the server. 

PING MachineName  
 1 | 2 | 3:ServerName | 
4:ServerName | 5:ServerName 
[Port#] 

Pings the InForm Service or a particular server. The ping levels 
are: 

• 1—Ping the InForm Service. 

• 2—Ping the InForm Service and all InForm server(s). 

• 3—Ping the specified server. 

• 4—Ping and get information about the specified server. 

• 5—Ping the specified server and dump the user session to a 
server-side file. 

• [Port#]—Allows you to specify the port number the echo 
server is listening on, if you changed it.  
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Command Purpose and Syntax 

REMOVE 
 [Server ServerName] | 
 [Trial TrialName [/DSN]] | 
 [CDD TrialName [/All | DSN] 
 [SYNC TrialName 
[DestinationComputer]] 

Removes an existing server, trial, or CDD. 

• [Server ServerName]—Removes an InForm server from the 
InForm Service. Trials should be either reconfigured to other 
servers or removed before this command is run. 

• [Trial TrialName [/DSN]]—Deletes the named trial from the 
InForm Service. The Web virtual directories and folders for 
the trial are physically removed. Use the /DSN option to 
remove the trial-related DSNs. 

• [CDD TrialName [/All | DSN]—Removes either all CDD 
DSNs in the specified trial or the given CDD by DSN. 

• [SYNC TrialName [DestinationComputer]]—Removes the 
connection from the trial to the remote trial instance on 
destination computer. 

Note: Before using the PFADMIN REMOVE command, verify 
that IIS is running. 

[RULESCANVIEW |  
RULESCANPEOCESS]  
TrialName 

• RULESCANVIEW—Scans existing rules and execution 
plans, and outputs a list of rules that violate the allowed rule 
objects list 

• RULESCANPEOCESS—This command executes the same 
validation process that occurs during trial start. It marks rules 
as valid or invalid. 
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Command Purpose and Syntax 

SETSERVER 
[Site TrialName ComputerName] 
| 
[MedMLInstaller TrialName 
ComputerName] | 
[REPORTING TrialName 
ReportingUrl] | 
[REPORTINGAN TrialName 
AuthenticationNamespace] | 
[REPORTINGUR TrialName 
UserRoot] | 
SYSTEMPW TrialName 

  

Changes the MedML and Site servers and sets the Reporting 
configuration settings 

• [Site TrialName ComputerName] 

• [MedMLInstaller TrialName ComputerName] 

• [REPORTING TrialName ReportingUrl]—Set Cognos 8 URL 
for trial. 

• [REPORTINGAN TrialName AuthenticationNamespace]—Set 
Cognos 8 AuthenticationNamespace for trial.  

• SYSTEMPW—Activate and set or change the password for 
the InForm system user. 

Note: Before using SETSERVER MedMLInstaller, put the trial in 
design mode. To do this, use the pfadmin start trial /design 
command. 

Note: The SETSERVER command requires that you set the 
Default Authentication Level property of the InForm server to 
Connect: 

To set this property: 

• Select Administrative Tools > Component Services > My 
Computer - Properties. 

• Set the Default Properties - Default distributed communication 
properties - Default Authentication Level value to Connect. 

SETUP Server ServerName 
[Automatic] 

Creates a new InForm server in the InForm Service. 

• [Automatic]—The server is automatically started with the 
InForm Service. Manual startup is the default. 

SETUP Trial TrialName 
ServerName 
 [/DB OracleConnStr] |  
 [/DSN TriDSN [Automatic]] 

Creates a trial on the given InForm server with the option to 
either create a new or use an existing ODBC DSN. The server has 
to be created. The trial startup mode is Manual by default. The 
mode can be configured in automatic with the option Automatic. 
A trial with the automatic startup mode is started automatically 
when the InForm server that hosts the trial is started. 

• [/DB OracleConnStr ]—Creates an ODBC DSN TrialName 
with the given ServerName. 

• [/DSN TriDSN [Automatic]]—Configures the created trial 
TrialName to use the given trial dataset name TriDSN The trial 
must be present in the ODBC DSN.  

Note: Before using the /DSN command, verify that IIS is 
running. 
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Command Purpose and Syntax 

SETUP CDD RefName 
TrialName  
 /DB OracleConnStr DSN  
 [/TBSP OraTBSP] [Active] 
[NoSchema] 

Sets up a new CDD DSN associated with the given CDD 
refname. 

• [/TBSP OraTBSP]—Defines the Oracle tablespace for the 
CDD schema. 

• [Active]—Specifies that the DSN is transactional. 

• [NoSchema]—Indicates that no new CDD schema should be 
created during setup. The existing database is not touched. By 
default, the user is dropped and the Oracle database 
destroyed. Then, a new schema is created and populated based 
on the RefName that defines the schema. 

Note: To execute this command successfully, the trial must be 
started. 

SETUP CDD RefName 
TrialName  
 /DSN DSN  
 [/TBSP OraTBSP] [Active] 
[NoSchema] 

Sets up an existing DSN associated with the given CDD 
RefName. 

• [/TBSP OraTBSP]—Defines the Oracle tablespace for the 
CDD schema. 

• [Active]—Makes the DSN transactional. 

• [NoSchema]—Indicates that no new CDD schema should be 
created during setup. The existing database is not touched. By 
default, the user is dropped and the Oracle database 
destroyed. Then, a new schema is created and populated based 
on the RefName that defines the schema. 

Note: To execute this command successfully, the trial must be 
started. 

START  
 [Server ServerName] | 
 [Trial TrialName] 

Starts an existing InForm server or trial. 

• [Server ServerName]—Starts an existing InForm server by 
server name. 

• [Trial TrialName]—Starts an existing trial by trial name. 

START 
 [Trial TrialName [/Design]] 

Starts the trial in design mode. This means you can install trial 
components that are not completely designed (strict checking is 
not in force). By default, the trial starts in production mode. 

STOP  
 [Server ServerName [/Trials]] | 
 [Trial TrialName [/Anyway]] 

Stops an existing InForm server or trial. 

• [Server ServerName [/Trials]]—Stops an existing InForm server 
by server name. By default, a running server can be stopped if 
there is no trial running and no other application connected to 
it. The Trials keyword stops all running trials, and then stops 
the server. 

• [Trial TrialName [/Anyway]]—Stops the named trial. The 
Anyway keyword stops a trial regardless of any connections or 
HTTP requests. 
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Command Purpose and Syntax 

SYNC Path Path specifies the location of the XML files to be transferred to 
another server using file-based transfer. This command results in 
inbound synchronization. 

UNINSTALL Removes all InForm servers and trials, and then removes the 
InForm service settings PfUser_computername and the MTS library 
package.  

Note: The InForm service must be running for the command to 
work. 

UPGRADEENV TrialName Upgrade InForm environment settings for the pfUSR account. 

VIEW  
 [Service] | 
 [Server ServerName] | 
 [Trial TrialName] | 
 [CDD TrialName] 

Displays a monitoring list of all servers in the InForm service, all 
trials in servers, or all RefNames for CDD DSNs configured for a 
trial. 

• [Service]—Lists all the servers and trials in the InForm 
service. 

• [Server ServerName]—Lists each server by server name and 
trials hosted on that server. 

• [Trial TrialName]—Lists a trial by its name. 

• [CDD TrialName]—Lists the RefNames for each CDD DSN 
configured for the specified trial. 

 

Command line prompts 
Depending on the options you specify, you are prompted for the following parameters: 

For pfadmin setup or pfadmin config commands: 

• uid—InForm trial database user. 

• pid—InForm trial database user password. 

For pfadmin setserver commands: 

• pid—InForm trial database user password. 

Use alphabetic or alphanumeric characters for the UID and PID, and begin them with a letter; do 
not use all numeric characters. 
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Install issues 

Oracle MTS configuration is invalid 
If the Oracle registry settings are not correct, you may get the following InForm core installer errors 
during the installation process: 

• Oracle MTS configuration is invalid. 

• Registry Settings: INVALID. 

• XA Views: INVALID. 

Possible solutions: 

• If the installation wizard is still open: 

1 Click Back to display the Database Configuration window. 

2 Select the Prep Oracle checkbox. 

3 Click Next to proceed.  

This runs the informprepora.vbs and mtsora102.vbs scripts. 

• If the installation window has been closed, run mtsora102.vbs from the command line. The 
mtsora102.vbs file is in the InstallSupport folder of the InForm installation image. 

 

XA Views: INVALID 
If you have tried the solution that is recommended in Oracle MTS configuration is invalid and still get 
this error, or if you run mtsora102.vbs from the command line and get a warning, the xaview.sql file 
may not be installed. 

Note: This can happen for some Oracle client-only installations (multi-tier setup). 

Possible solution: 

1 Copy the xaview.sql file from another machine (running the same Oracle version) to your Oracle 
rdbms\admin directory. 

2 Log in as SYS on a machine with xaview.sql. 

3 Run xaview.sql against your InForm core instance. 

4 Run mtsora102.vbs from the command line. 
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Database connectivity 
If you get a warning about database connectivity, make sure that: 

• The connect string value is correct. 

• The pfdbadmin password is valid. 

If you get a message that the pfdbadmin user does not exist, create the user by doing one of the 
following: 

• Select the Prep Oracle checkbox in the InForm installation wizard. 

• Run the informprepora.vbs script located in the InstallSupport folder of the InForm installation 
image. 

 

Password error on InForm service start up 
The InForm installation wizard cannot ensure that the password entered on the Account 
Configuration Window for the Local Machine User (pfUSR) meets the password requirements set 
for the machine. If you enter a password that does not conform to the Windows password 
requirements, an error will prevent the InForm service from starting. 

1 To change the pfUser password enter the following command at a DOS prompt: 

pfadmin install 

2 When prompted for the pfUSR password, enter a password that meets the password 
requirements. 

3 Run the following command to start the InForm service: 

new start pfservice 

Use the pfadmin view service command to verify that the InForm service has started. 
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Uninstall issues 

Errors when removing a reporting schema 
If you run the deinstall_reporting_diffdb.sql script to remove a reporting schema, and you receive 
the message Reporting deinstallation aborted, the uninstall fails and no reporting objects are 
removed. 

The probable cause is a problem with the settings in the configdiffdb.sql file. 

Check the configdiffdb.sql file to make sure that the settings are correct for the reporting schema 
that you want to remove. In particular, the uninstall scripts check for the existence of a tablespace. If 
the configdiffdb.sql file contains variables that refer to nonexistent tablespaces, update the file and 
rerun the uninstall script. 
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